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What’s new in version 3.3.1?

The following new features are available in DTRACK3 version v3.3.1:

• New ’Controller and Camera Update’ dialog

What’s new in version 3.3.0?

The following new features are available in DTRACK3 version v3.3.0:

• Support of AT7-80

• DTRACK3 for Windows changed from 32-bit to 64-bit application

• New targets added to the target library (Large Hand Targets, HMD Varjo XR-4)

• Support of external ART software ART-ToolTrackingInterface

What’s new in version 3.2.2?

The following new features are available in DTRACK3 version v3.2.2:

• Daily automatic backup of configurations and settings

• Manuals available in DTRACK3 application

What’s new in version 3.2.0?

The following new features are available in DTRACK3 version v3.2.0:

• Support of up to 80 cameras

• Changed licensing scheme for bodies

• Updated body administration and simpler use of Target Library for Standard Bodies
and Flysticks

What’s new in version 3.1.3?

The following new features are available in DTRACK3 version v3.1.3:

• Increased number of output channels

• All available HMD targets in target library

• Simplified camera licensing for Cascaded Systems

• Output of system status data via ethernet



What’s new in version 3.1.2?

The following new features are available in DTRACK3 version v3.1.2:

• Support of SMARTTRACK3/M

• Approx. 30% increased tracking range for ARTTRACK6/M

What’s new in version 3.1.1?

The following new features are available in DTRACK3 version v3.1.1:

• Support of camera ARTTRACK6/M for Active Markers

• Support of Flystick2+ with feedback capabilities

• Easier configuration of stateless firewalls (UDP sending port 50107)

• Early warning for expiring licenses

• Check of DTRACK3-valid license code before upgrading from DTrack2

What’s new in version 3.1.0?

The following new features are available in DTRACK3 version v3.1.0:

• Support of camera ARTTRACK6/M

• Tracking with reference target

• Change of licensing DTRACK3 upgrades

• Output of 6DOF and 3DOF covariances via ethernet

• Adjustment of camera threshold and exposure time

• Time synchronisation using PTP (IEEE1588-2008)

• Optional login with password to DTRACK3 frontend

What’s new in version 3.0.2?

The following new features are available in DTRACK3 version v3.0.2:

• Support of ART Controller/M

• Adjustment of DTRACK3 for high resolution monitors

What’s new in version 3.0.1?

The following new features are available in DTRACK3 version v3.0.1:

• New ’Service’ dialog



What’s new in version 3.0.0?

The following new features are available in DTRACK3 version v3.0.0:

• Support of SMARTTRACK3 including Cascaded System capability

• Support of up to 70 targets

• Improved target catching algorithm

• New menu structure

• Dark user interface scheme

• Extended licensing models (refer to table 7.2 on page 65)

• Re-positioning of room coordinate system without wand calibration
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0Terms and definitions

term definition

3DOF three degrees of freedom (i.e. only position)
6DOF six degrees of freedom (i.e. position and orientation)
5DOF five degrees of freedom (i.e. one degree less in orientation)
base imaginary connecting line between two cameras (e.g. the two

integrated cameras inside the SMARTTRACK2/3/M )
ART Controller controller for rackmounting, calculates tracking data and gener-

ates the data output stream (compatible to ARTTRACK2 , ART-
TRACK3 , ARTTRACK5 , ARTTRACK5/C , ARTTRACK6/M ,
AT7-80 , TRACKPACK/E )

ART Controller/M compact size controller, calculates tracking data and generates
the data output stream (compatible to ARTTRACK2 , ART-
TRACK3 , ARTTRACK5 , ARTTRACK5/C , ARTTRACK6/M ,
AT7-80 , TRACKPACK/E )

ARTTRACK Controller (discontin-
ued)

calculates tracking data and generates the data output stream
(compatible to ARTTRACK1 , ARTTRACK2 , ARTTRACK3 )

ARTTRACK2 (discontinued) infrared camera
ARTTRACK3 (discontinued) infrared camera
ARTTRACK5 infrared camera
ARTTRACK5/C infrared camera dedicated for multi-sided projections
ARTTRACK6/M infrared camera dedicated for compact environments or multi-

sided projections
ARTTRACK6/M for Active Markers flashless camera dedicated for use with active targets in com-

pact environments or multi-sided projections
AT7-80 infrared camera dedicated for long range environments
body calibration teach the system the geometry of a rigid body
body, rigid body rigid arrangement of multiple markers intended for 6DOF track-

ing (see also "target")
calibration angle belongs to the room calibration set and defines origin and orien-

tation of the room coordinate system
ceiling suspension equipment to mount an infrared camera or SMART-

TRACK2/3/M to the ceiling
DTRACK3

backend software software running on the ART Controller , ART Controller/M or
SMARTTRACK2/3/M doing all necessary calculations

frontend software graphical user interface running on customer’s computer to
control the ART Controller , ART Controller/M or SMART-
TRACK2/3/M

Field of View (FoV) is the area of interest captured on the camera’s image
finger thimble a fixture for the finger tip to hold the active marker(s) (not avail-

able for SMARTTRACK2/3/M )
Fingertracking (discontinued) tracks the orientation of the hand and the position of the fingers

(not available for SMARTTRACK2/3/M )
Fingertracking2 tracks the orientation of the hand and the position of the fingers

(not available for SMARTTRACK2/3/M )
Fingertracking2 Tactile tracks the orientation of the hand and the position of the fingers

and provides Tactile Feedback
Flystick2/2+/3 wireless interaction device for virtual reality (VR) applications
Flystick feedback vibrational or acoustic signal that can be triggered in a capable

Flystick
hand geometry describes the dimensions of your hand and fingers (not available

for SMARTTRACK2/3/M )
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term definition

hybrid tracking sensor fusion of optical and inertial data into one consolidated
output

inertial sensor an inertial measurement unit simultaneously measures 9 phys-
ical properties, i.e. angular rates, linear accelerations (unused)
and magnetic field components (unused) along all 3 axes. This
is achieved using solid state gyroscopes for measurement of roll,
pitch and yaw and optical tracking for drift correction.

infrared optical tracking position measurement of bodies (subjects or objects) based
upon infrared light and optical measurement procedures

license code (license key) software key to unlock certain capabilities of the tracking system
or SMARTTRACK2/3/M

marker object either made of retro reflective material or LED for position
tracking (3DOF)

Measurement Tool a pointing device which allows to measure the position of the
tool’s tip with high accuracy

measurement volume defines the volume where optical tracking is possible
modulated flash infrared signal which is used for wireless synchronization
motion capture track movements of a human body
mutual blinding at least one camera (also from SMARTTRACK2/3/M ) sees dis-

turbing reflections caused by the infrared flashes of another cam-
era (or SMARTTRACK3 )

prediction predicts output for the specified time in the future to compensate
tracking and rendering latency

Radio Transceiver exchange data with Flystick2/2+/3 (integrated in SMART-
TRACK2 )

RadioTransceiver2/3 uses USB port to exchange data with Flystick2/2+/3 or Finger-
tracking2 Tactile

room calibration teach the system the position of each camera and define origin
and orientation of the room coordinate system

room calibration set consists of angle tool and wand
SMARTTRACK3 fully integrated stand-alone infrared optical tracking system with

two cameras and integrated controller, calculates tracking data
and generates the data output stream

SMARTTRACK3/M compact version of SMARTTRACK3
syncgroup cameras being in one syncgroup receive the sync signal at the

same time. Syncgroups are distinguished by a short time delay
between their sync signals in order to avoid mutual blinding. (not
available for SMARTTRACK2 )

Synccard unit integrated in SMARTTRACK2/3/M which serves for syn-
chronizing the cameras

Synccard2 board integrated in the ARTTRACK Controller (discontinued)
which serves for synchronizing the cameras

Synccard3 board integrated in the ART Controller or ART Con-
troller/M which serves for synchronizing the cameras

SynccardTP board integrated in the TRACKPACK Controller (discontinued)
which serves for synchronizing the cameras

Tactile Feedback system for finger-based interactions in immersive virtual reality
applications (wires touch the inside of the finger tips and provide
an impression when they are shortened)

target rigid arrangement of multiple markers intended for 6DOF track-
ing (see also "rigid body")

tracking position measurement of bodies that move in a defined space
TRACKPACK (discontinued) infrared camera
TRACKPACK/C (discontinued) infrared camera dedicated for multi-sided projections
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0term definition

TRACKPACK/E infrared camera
TRACKPACK Controller (discontin-
ued)

calculates tracking data and generates the data output stream
(compatible to TRACKPACK and TRACKPACK/C )

virtual point cloud used for calculating the relative position of cameras or SMART-
TRACK2/3/M that cover the measurement volume

wand precalibrated stick carrying two markers. The wand belongs to
the room calibration set and is used to generate a virtual point
cloud and to scale the measurement volume
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1 Safety

1.1 Symbols and their meaning

You can find the following symbols and signs on the equipment or in the manual:

i Useful and important notes.

Z Important notes, which may lead to system malfunction or to the
loss of warranty by non-observance.

Important safety warning to assure user’s and operational safety.
These warnings have to be observed, otherwise there is a po-
tential risk for health and safety and damaging of the equipment
resulting in loss of warranty and liability.

Safety warning for infrared radiation.
These warnings have to be observed, otherwise the user’s eyes
and sight are exposed to a potential hazard.

Table 1.1: Symbols and their meaning

1.2 Warnings

All warnings in this manual have to be observed for safe operation of
the equipment.

Tous les avertissements dans ce manuel doivent être respectés pour
garantir un fonctionnement sécurisé de l’équipement.

ART explicitly denies any warranty and liability if the product is not
operated according to this manual or any other authorised documen-
tation (e.g. quick-guides) or not according to the specifications of the
equipment.

1.2.1 Installation

The housing may NOT be damaged.

16
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1.2 Warnings

Do not install or use any equipment when it shows signs of damage
(e.g. smoke, sparks, fire, smells, etc) or if parts of it show damaging.

Do not install or use any equipment when the power cord is damaged.

Insert batteries in the indicated polarity !

Insérer les piles dans le sens de polarité indiqué !

Some equipment employs connectors of proprietary design. Do not try
to connect these to any other computer ports (e.g. COM port or LAN)
!!!

Verify that voltage and frequency of your electrical grid comply with the
appliance ratings of the equipment. The rating plates are found on the
equipment’s housing. (ARTTRACK1 on the lower side of the housing;
ARTTRACK2 / ARTTRACK3 and SMARTTRACK2/3/M on external power
supply, all controllers on the rear side of the housing).

Vérifiez que la tension et la fréquence de votre réseau électrique cor-
respondent aux spécifications de l’appareil. Les plaques signalé-
tiques se trouvent sur le boîtier de l’équipement. (ARTTRACK1 sur
le côté inférieur du boîtier ; ARTTRACK2 / ARTTRACK3 et SMART-
TRACK2/3/M sur l’alimentation externe, tous les contrôleurs à l’arrière
du boîtier).

The equipment may only be powered from power sockets connected
to earth/ground. If the grounding wire is defective the requirement
of the safety and the electromagnetic compatibility (EMC) cannot be
guaranteed. To check the function of the grounding wire ask your local
electrician.
L’équipement ne peut être alimenté que par des prises de courant re-
liées à la terre/au sol. Si le fil de mise à la terre est défectueux, les
exigences de sécurité et de compatibilité électromagnétique (CEM) ne
peuvent être garanties. Pour vérifier le fonctionnement du fil de mise
à la terre, demandez à un électricien local.

The power switch on the equipment does not separate the device from
mains. The equipment must be disconnected from mains.

1.2.2 Mounting

Z
Do not touch the front pane of the cameras. The acrylic pane and the
lens have highly sensitive surfaces. Be careful to avoid permanent
damages (e.g. scratches).

17



1 Safety

Z
Shock and severe vibrations can permanently damage the internal cal-
ibration of the cameras. De-calibrated cameras have to be sent in for
maintenance.

Z The power cord and plug should be accessible freely. The power
socket should be close to the equipment.

Z Install the cables that the line of sight of the cameras or SMART-
TRACK2/3/M is not obstructed.

Grab the cameras only on the housing. Risk of Electrostatic Discharge
(ESD) !

Tenez les caméras uniquement par le boîtier. Risque de décharge élec-
trostatique (ESD) !

Do not drop the equipment.

Be sure that the cameras are firmly mounted using strong wall plugs
/ anchors and screws when mounting to walls or ceilings. Loosely
mounted cameras may pose a serious hazard to health and safety.

Never unfasten screws that are not designed for mounting. All liability
and warranty is void.

Use only accessories for mounting (screws, ceiling suspension) sup-
plied by ART .

The ventilation holes of the equipment (particularly of SMART-
TRACK2 , ARTTRACK2 , ART Controller and ART Controller/M ) must
not be covered. Ensure unblocked airflow at all times. The minimum
distance between equipment and surrounding objects has to be larger
than 3 cm.

Install a strain relief to all cables to avoid damage to the equipment.

Install the cables trip-proof (e.g. cable ducts or fixings). Inappropriate
cabling may pose a serious hazard to health and safety.

Installez les câbles de manière à les protéger contre les risques (par
exemple, en utilisant des canalisations ou des fixations pour câbles).
Un câblage inapproprié peut représenter un grave danger pour la santé
et la sécurité.

1.2.3 Operation

Unplug the equipment from mains immediately in any case of damage
! Please contact ART service
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1.2 Warnings

Removable batteries must be removed before shipping equipment.

Batteries should be removed when equipment is not used for a longer
period of time - Risk of damage !

Do not use non-rechargable batteries in rechargable equipment (e.g.
Flystick2 ) - Risk of explosion !

Ne pas utiliser de piles non rechargeables dans des équipements
rechargeables (par exemple, Flystick2 ) - Risque d’explosion !

Do not crush or puncture batteries and avoid impact that might result
in damage, leakage or short-circuiting.

Use only original components and accessories from ART or authorized
by ART . Using unauthorized components or accessories may damage
the equipment, may cause malfunctioning and may compromise oper-
ational safety.
Utilisez uniquement des composants et accessoires d’origine de
ART ou autorisés par ART . L’utilisation de composants ou acces-
soires non autorisés peut endommager l’équipement, provoquer des
dysfonctionnements et compromettre la sécurité opérationnelle.

In case connectivity is provided using third party equipment please
ensure compliance to all applicable standards regarding connectivity
and power supply (see chapter A on page 199). Non-compliance may
result in loss of conformity ! All warranty and liability is void.

Only peripheral devices which meet the safety requirements of UL
60950-1 (U.S. only) and EN / UL / IEC 62368-1 (EU, U.S., etc.) for SELV
may be attached on Ethernet-, BNC- and the DC-circuit of the equip-
ment.
Do not change or modify the equipment in any way (e.g. mechanically,
electrically). Non-compliance may result in loss of conformity ! All
warranty and liability is void.

Do not spill fluids over the equipment!

Do not insert objects into the equipment (e.g. ventilation openings) !

Do not expose the equipment to high levels of humidity or condensing
environments.

Ne pas exposer l’équipement à des niveaux élevés d’humidité ou à des
environnements où la condensation est possible.
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1 Safety

The equipment must not be operated in environments with intensive
formation of dust.

L’équipement ne doit pas être utilisé dans des environnements avec
une formation intense de poussière.

The equipment must not be operated in environments with elevated
temperatures above 40◦ C (100◦ F).

L’équipement ne doit pas être utilisé dans des environnements avec
des températures élevées supérieures à 40◦ C (100◦ F).

Do not use the equipment outdoors (i.e. outside of buildings or poten-
tially moist / wet locations) !

Ne pas utiliser l’équipement à l’extérieur (c’est-à-dire en dehors des
bâtiments ou dans des endroits potentiellement humides / mouillés) !

The cameras and SMARTTRACK2/3/M emit infrared light. Keep a
distance of min. 20 cm when operating near cameras or SMART-
TRACK2/3/M . All cameras and SMARTTRACK2/3/M are assigned to the
Exempt Group according to IEC62471-1 and therefore pose no risk or
hazard to the human eye or skin at this distance.

Les caméras et les SMARTTRACK2/3/M émettent de la lumière in-
frarouge. Gardez une distance minimale de 20 cm lorsque vous tra-
vaillez à proximité des caméras ou des SMARTTRACK2/3/M . Toutes
les caméras et les SMARTTRACK2/3/M sont classés dans le Groupe
Exempt selon la norme IEC62471-1 et ne présentent donc aucun risque
ou danger pour les yeux ou la peau humaine à cette distance.

1.2.4 Maintenance

Z
Only the housing of the cameras may be cleaned, do not touch lenses
or other optical components. Before cleaning shut down the system
and disconnect the power cords.

Do not use any solvents, water or chemicals to clean the cameras!

Do not try to repair anything by yourself!

All warranty and liability is void when the equipment is opened.
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1.2 Warnings

Danger High Voltage inside the equipment (e.g. ART Controller )! Do
not open the equipment ! Risk of electric shock - even if the equipment
is disconnected. Please contact ART service.
Danger Haute Tension à l’intérieur de l’équipement ! Ne pas ouvrir
l’équipement ! Risque de choc électrique - même si l’équipement est
déconnecté. Veuillez contacter service ART .

In order to replace mains fuses (e.g. ART Controller ) always unplug
the power cord first. Risk of electric shock !

Pour remplacer les fusibles secteur (par exemple, ART Controller ),
débrancher toujours d’abord le cordon d’alimentation. Risque de choc
électrique !

Risk of explosion if removable batteries are replaced by an incorrect
type!

Risque d’explosion si les batteries amovibles sont remplacées par un
type incorrect!

1.2.5 Disposal & Recycling

Waste Electronic and Electrical Equipment (WEEE) should never be
disposed of along with household waste.

Batteries should never be disposed of along with household waste.

Batteries or rechargeable batteries that are not permanently installed
must be removed beforehand and disposed of separately.

To prevent fires due to short-circuits, tape battery terminals and/or
place lithium-ion batteries in separate plastic bags.

Do not crush or puncture used batteries and avoid impact that might
result in damage, leakage or short-circuiting.
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2 General Information

2.1 Cleaning of the equipment

i Use a dry, lint-free and antistatic cloth or tissue (e.g. lens-cleaning
tissue for optical equipment).

Z
Only the housing of the cameras may be cleaned, do not touch lenses
or other optical components. Before cleaning shut down the system
and disconnect the power cords.

Do not use any solvents, water or chemicals to clean the cameras!

2.2 Maintenance and service

Routine maintenance of the equipment is recommended every three years. If you experi-
ence any problems please do not hesitate to contact our support.

Do not try to repair anything by yourself!

Danger High Voltage inside the equipment (e.g. ART Controller ) ! Do
not open the equipment ! Risk of electric shock - even if the equipment
is disconnected. Please contact ART service.
Danger Haute Tension à l’intérieur de l’équipement ! Ne pas ouvrir
l’équipement ! Risque de choc électrique - même si l’équipement est
déconnecté. Veuillez contacter service ART .

All warranty and liability is void when the equipment is opened.

2.3 Disposal and recycling of equipment

Waste Electronic and Electrical Equipment (WEEE) may contain a complex mixture of
materials and hazardous substances. If not managed properly and thus exposed, these
can cause serious damage to the environment, wildlife, and human health. In addition,
modern electronics contain rare and expensive resources, which can be recycled and
re-used to contribute to the circular economy. By ensuring that you dispose of WEEE
properly, you are helping to improve sustainable production and consumption, to increase
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2.3 Disposal and recycling of equipment

resource efficiency and to preserve our natural resources and protect human health.

The symbol (crossed-out wheelie bin symbol according to Waste Electronic and Electrical
Equipment (WEEE) Directive 2012/19/EU, see figure 2.1 (a) or (b) on page 23) indicates
that the product should not be discarded as unsorted municipal waste but must be sent
to separate collection facilities for recovery and recycling.

(a) equipment placed on
the market prior to 2005

(b) equipment placed on
the market after 2005

Figure 2.1: WEEE label

When your delivery address is outside of Germany, dispose of WEEE at your local waste
facilities or recycling centers available by public waste management authorities only. Please
consider that local regulations on the disposal of and recycling of electronic and electrical
equipment may apply. Contact your local authority directly for more information.

For deliveries inside Germany only:

• End-users of WEEE are obliged to return the equipment or have it collected within
the framework set up by ART .

• You are responsible for deleting personal or confidential data from the equipment to
be disposed of. You can do this by resetting the device to its factory settings. Please
refer to DTRACK3 User’s Guide→ Connecting to the controller → Configuring your
controller’s network address without network access for more details. ART is not
liable for any data on your device. Before resetting your device, you should always
back up any sensitive data.

• For further details regarding the WEEE directive, including how ART ensures the
safe disposal of your electrical and electronic equipment, please refer to our website
at https://ar-tracking.com/de/art-geraete-ruecknahmekonzept

Waste Electronic and Electrical Equipment (WEEE) should never be
disposed of along with household waste.
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2 General Information

2.4 Disposal and recycling of batteries

Batteries are made from important resources, including lead, cadmium, zinc, lithium and
mercury. Many of the components of these batteries and rechargeable batteries could be
recycled, avoiding the exposure of hazardous substances to the environment. In addition,
by recycling your used batteries using the collection and recycling schemes available you
are contributing to protecting Earth’s natural resources by providing valuable materials to
products and production processes.

The symbol (crossed-out wheeled bin symbol according to Battery Directive 2006/66/EC,
see figure 2.1 (b) on page 23) indicates that you are legally obliged to dispose of batteries
or rechargeable batteries separately from unsorted municipal waste, i.e. that they must
be disposed of separately from household waste. If batteries or rechargeable batteries
contain Mercury (Hg), Cadmium (Cd) or Lead (Pb), they are marked with the chemical
symbols of the metals (Hg, Cd, Pb) for which the limit value is exceeded.

• Pb = battery contains more than 0.004 mass percent Lead

• Cd = battery contains more than 0.002 mass percent Cadmium

• Hg = battery contains more than 0.0005 mass percent Mercury

When your delivery address is outside of Germany, dispose of used batteries at dedicated
battery collection points or recycling centers available by public waste management au-
thorities only. Please consider that local regulations on the disposal of and recycling of
batteries may apply. Contact your local authority directly for more information.

For deliveries inside Germany only:

• End-users of batteries are obliged to recycle used batteries via dedicated battery
collection points or recycling centers set up by public waste management authorities
or via retailers directly. Addresses of suitable collection points and recycling facilities
in your area can be obtained from your city or by contacting your local authorities.

• For further details regarding the Battery Directive, please refer to our website at
https://ar-tracking.com/de/art-geraete-ruecknahmekonzept

Batteries should never be disposed of along with household waste.

Batteries or rechargeable batteries that are not permanently installed
must be removed beforehand and disposed of separately.

To prevent fires due to short-circuits, tape battery terminals and/or
place lithium-ion batteries in separate plastic bags.

Do not crush or puncture used batteries and avoid impact that might
result in damage, leakage or short-circuiting.
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2.5 Warranty

2.5 Warranty

General Please refer to the terms & conditions on our website at
https://ar-tracking.com/en/terms-agb

Hardware ART warrants the hardware to be free from defects in material and workman-
ship, design and manufacturing for the warranty period set forth in our terms & conditions
(see website) after the time of delivery. The time of delivery is defined as the day when
the end-user takes possession of the equipment. If ART or any third party authorized by
ART installs the system, the time of delivery is the time of the first installation.
If a defect arises during this warranty period, provided the instructions for returning the
hardware are followed, ART will, to the extent permitted by law, initially either (i) repair
or (ii) replace the hardware or any defective parts. All replaced parts and hardware shall
become property of ART . This limited warranty applies only to hardware components that
have been under ordinary and intended use and service being in their original, unmodi-
fied state and thus have not been subject to damage from external causes, alteration or
unauthorized repair.

Software Software supplied is delivered on a tested "As Is" basis. ART explicitly does
not warrant that the software is error (bug) free. If the user detects bugs and notifies
ART , ART will provide a workaround or bug fix as soon as possible after successfully
reproducing the error.

Warranty restrictions All warranty and liability is void, if the equipment

• is not operated according to this manual or any other authorized documentation (e.g.
quick-guides),

• has not been used according to the specifications of the equipment,

• shows damages or signs of improper use,

• has been opened by the user or other non-authorized personnel (non-members of
ART and third parties not authorized by ART ),

• has been modified or tampered with by the user or other non-authorized personnel
(non-members of ART and third parties not authorized by ART ).

2.6 Liability

General Please refer to the terms & conditions on our website at
https://ar-tracking.com/en/terms-agb

In no event shall ART be liable for any incidental, indirect or consequential damages
whatsoever (including, without limitation, damages for loss of business profits, business
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2 General Information

interruption, loss of business information, or any other pecuniary loss) arising out of the
use of or inability to use the software or hardware.

Measurement results ART products are not authorized for use under any circumstance
where human life might be at risk due to malfunction, measurement errors or interrupted
operation of the system without written approval of a managing director of ART .
It is the user’s sole responsibility to check the results of the measurement data and to
protect any downstream system against malfunction, measurement errors or interrupted
operation of the system. Under no circumstances shall ART be held liable for any inciden-
tal, indirect or consequential damages whatsoever (including, without limitation, damages
for loss of business profits, business interruption, loss of business information, or any
other pecuniary loss) arising out of malfunction, measurement errors or interrupted oper-
ation of the system.

ART explicitly denies any warranty and liability if the product is not
operated according to this manual or any other authorized documen-
tation (e.g. quick-guides) or not according to the specifications of the
equipment.
Do not change or modify the equipment in any way (e.g. mechanically,
electrically). Non-compliance may result in loss of conformity ! All
warranty and liability is void.
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3 Introduction to tracking
The ART tracking systems are infrared (IR) optical tracking systems, whereas the SMART-
TRACK2/3/M are fully integrated stand-alone tracking systems, designed to be used in
small volumes (approx. 2m3). In this user manual we are going to perceive "tracking"
as measurement of positional and rotational information (i.e. orientation) of objects or
individuals that move in a defined space.

Concept of optical tracking The cameras send out synchronized IR flashes which
are reflected back into the lens by retro-reflective material covering the markers of the
target. The reflected IR light is detected by the tracking cameras (integrated in SMART-
TRACK2/3/M ) which create a greyscale image based on the received IR radiation.
In the next step these images are preprocessed by the cameras to calculate the marker
positions (2DOF) on the camera sensor with high accuracy using pattern recognition al-
gorithms. Then this 2DOF data is sent to a control unit to calculate 3DOF or 6DOF
information.

The simultaneous measurement of spatial position (X, Y, Z) and orientation (three inde-
pendent angles) is called ’six degrees of freedom’ (6DOF) tracking. If only the spatial
position (X, Y, Z) is to be measured it is called ’three degrees of freedom’ (3DOF) track-
ing.
Single markers are sufficient if only 3DOF coordinates are needed, but single markers
cannot be distinguished in principle. An ID is assigned to a tracked 3DOF marker as long
as it can be followed, but after loosing the tracking (e.g. due to occlusions) one would not
be able to re-identify the marker and thus a new ID will be assigned. For 6DOF tracking,
however, a unique target is mandatory. Targets are rigid arrangements of markers (=rigid
bodies) and thus can be identified by their relative marker position. Figure 3.1 on page 28
shows the concept of infrared optical tracking with a two-camera system and a standard
target.

The base for this calculation is that the cameras’ field of views are overlapping. In a
two-step teaching process, the position and orientation of the cameras is made known to
the system (the ’room calibration’), after which the system is taught to identify the unique
arrangements of markers as targets (the ’body calibration’). Then the paths of the optical
rays from the cameras to the markers are calculated to deliver the ray intersections in
three-dimensional coordinates. These intersections are the positions of the markers.
Based upon this, one is able to calculate 6DOF data and, finally, knows position and ori-
entation of the target and therefore the object or individual to be tracked.

The SMARTTRACK2/3/M make use of the same principle.
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3 Introduction to tracking

Note: In pure optical tracking systems tracking is only possible as long as

• objects or individuals to be tracked are equipped with single markers or targets

• the target is not occluded by any other objects in the cameras’ line of sight, which
could even be the object itself

• the target is positioned inside the tracking range of the cameras

• at least four markers of a target are visible to at least two cameras (this step enables
tracking).

Figure 3.1: Concept of optical tracking (stereo vision)

i
The SMARTTRACK2/3/M have a limited field-of-view and range! It is
designed to be used in small volumes. Please refer to the ART Hard-
ware Installation Guide for more information on the tracking volume of
the SMARTTRACK2/3/M .

Marker types Passive markers are covered with retro reflective material - they act as
light reflectors. Active light emitters (i.e. based on infrared LEDs) are called active mark-
ers. Please refer to the ART Hardware Installation Guide for more information on mark-
ers & targets.

Hybrid tracking In addition to tracking by a pure optical system it is possible to uti-
lize data from inertial measurement units (IMU). These devices usually consist of several
components such as gyroscopes, accelerometers and magnetometers. The underlying
principle is the combination of solid-state microelectromechanical systems with integrated
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circuits and analog or digital outputs to achieve 6DOF rotational information.

Some of the most important advantages of hybrid tracking are:

• tracking data from IMUs offers low noise-levels while running at very high frequen-
cies in combination with low latencies

• IMUs deliver tracking data (i.e. rotational information) even when the optical target
is not inside the tracking volume or if the target cannot be tracked due to viewing
limitations or occlusions

• drifting of IMUs (i.e. mostly from the 3-axis gyroscope) is compensated by fusing the
inertial data with position measurements calculated from the optical tracking system

A hybrid target is basically an optical target additionally equipped with an IMU, which itself
is connected to the controller or SMARTTRACK2/3/M .
There the tracking data from both worlds (i.e. hybrid) is combined, which also leads to
the term ’sensor fusion’. By nature the IMU contains an independent coordinate system
which needs to be aligned to the optical tracking system axes. This additional teaching
process is called hand-eye calibration or ’hybrid body calibration’ in DTRACK3 .

Tracking with DTRACK3 All ART systems are based on a controller (stand-alone or
integrated controller in SMARTTRACK2/3/M ) which operates cameras, interaction de-
vices (optional) and targets respectively. The software DTRACK3 consists of frontend
and backend software.
The backend software runs on the controller - all necessary calculations (3DOF, 6DOF
data, etc.) are performed there. The data and control commands are interchanged via
ethernet (TCP/IP connection) between the controller and the DTRACK3 frontend soft-
ware on the remote PC. DTRACK3 frontend offers a GUI for easy handling that enables
the user to control the tracking system at a distance. The benefit is that the system be-
comes more flexible, i.e. different users can control the tracking system at any one time
(but not simultaneously!) from different working places.
Data output to the application or graphics workstation is also done via ethernet (UDP/IP
connection).

Furthermore, DTRACK3 provides the possibility to control the functions in the backend
via ethernet (i.e. without the DTRACK3 frontend software). This is also done by estab-
lishing a TCP/IP connection with the controller and exchanging short command strings
(refer to the DTRACK3 Programmer’s Guide ).
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4 Installing the DTRACK3 software

The software DTRACK3 is intended to access any ART controller via ethernet and runs
on a remote PC (Windows or Linux). DTRACK3 itself is delivered via USB pen-drive.
The latest version can be downloaded from our Download Center at
http://www.ar-tracking.com/downloads/

The SMARTTRACK2/3/M are integrated tracking systems. Thus for the sake of readabil-
ity the SMARTTRACK2/3/M are referred to as ’Controller’ in the following sections.

4.1 Installation under Microsoft Windows

Please refer to chapter A.1 on page 199 for more information on supported operating
systems (64-bit only).
Run the installation executable "DTRACK3_v3.X.Y_win64_install.exe" (64-bit package
available only) and the installation wizard of DTRACK3 starts.

Click Next to continue and to start the installation
process for DTRACK3 software. Administrator
privileges are not necessary.

Now, please choose the destination folder in
which you want to install DTRACK3 .
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4.1 Installation under Microsoft Windows

Please read the license terms carefully and
press I Agree if you agree indeed. A new win-
dow shows the installation progress.

The installation of the DTRACK3 software is
shown using a progress bar.

After DTRACK3 has been installed on your com-
puter click Next .
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4 Installing the DTRACK3 software

Press Finish to complete the DTRACK3 setup
wizard. Now, you can use DTRACK3 .

i
Information regarding requirements to run DTRACK3 (operating sys-
tem, etc.) are opened automatically after the installation is complete.
Please read the information carefully.

i Newer versions of DTRACK3 may be installed parallel to the last / cur-
rent version.

Z Recommendation: Do not overwrite previous installations of
DTRACK3 so you can easily revert to the last version.

4.2 Installation under Linux

The software (64-bit package available only) is packed in an archive.
(DTRACK3_v3.X.Y_linux64.tar.gz) You do not need to have administrator rights to extract
all files to a user-defined folder. In a shell, change to the user-defined folder and type in
the command tar xzf DTRACK3_v3.X.Y_linux64.tar.gz in order to extract the files. For
ease of use, you may create a shortcut on the desktop.

DTRACK3 can be started with the command ./DTRACK3.

i
Information regarding requirements to run DTRACK3 (operating sys-
tem, dependencies, libraries, etc.) are listed in the file ’readme.txt’
extracted in the user-defined folder. Please read the information care-
fully.

4.3 Software update

The latest DTRACK3 software is always available from our Download Center at
https://ar-tracking.com/en/downloadcenter
For the installation of the frontend update, please proceed as mentioned before in chap-
ters 4.1 on page 30 and 4.2 on page 32. After installing DTRACK3 on the host PC the
controller may be updated after establishing a connection with the new frontend. Please
refer to chapter 12.3 on page 174.
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4.4 Automatic configuration backups

Z All patch releases and updates (e.g. v3.2.0→ v3.2.1→ v3.2.2→...) may
be installed without restrictions.

Z
DTRACK3 may only be upgraded to the next minor version (e.g. v3.2.X
→ v3.3.0) having a valid ’DTRACK3 Upgrade’ license. Please double-
check your license status first (see chapter 7.2 on page 64 for more
information).

4.4 Automatic configuration backups

Upon starting the DTRACK3 frontend the current configurations and settings on the
ART Controller or SMARTTRACK2/3/M are saved automatically on the host PC once a
day. In the rare event of a defective controller unit this backup can be restored onto a re-
placement device. If the controller unit is still under warranty, licenses may be transferred
onto the replacement unit free-of-charge. The location of the backup on the host PC is
C:\Users\user\.ART\DTRACK3\v3.X.Y\backup\ with user being the name of the currently
used account on Windows and v3.X.Y being dependent on the version of DTRACK3 .
Please refer to 7.3.3 on page 70 how to restore a complete backup.

i Only the 2 most current backups are stored, older versions are deleted
periodically.

4.4.1 Deactivation of automatic backups

Automatic backups are active by default. In order to deactivate this feature (e.g. due
to confidential data stored in the configurations) first close the DTRACK3 frontend. Then
open and edit the configuration file current-preferences.xml found in the following folder:
C:\Users\user\.ART\DTRACK3\v3.X.Y\config\ with user being the name of the currently
used account on Windows and v3.X.Y being dependent on the version of DTRACK3 .

Frontend configuration file Following, a description of the file (e.g. C:\Users\JohnDoe\
.ART\DTRACK3\v3.3.0\config\current-preferences.xml) format:

<?xml version="1.0" encoding="UTF-8"?>

<DTRACK>

<LAST_TRACKBOX HOSTNAME="controller-hostname" IP="10.10.1.1" MODEL="21" MAC="AA:BB:CC:DD:EE:FF"/>

<TRACKBOX_SELECTION>

<FIX_HOSTNAME_OR_IP></FIX_HOSTNAME_OR_IP>

<FIX_SUBNET>(all subnets)</FIX_SUBNET>

<NET_RANGE>scan</NET_RANGE>

<!-- possible values for NET_RANGE: scan, specific_atc -->

<CASCADED_SYSTEM>false</CASCADED_SYSTEM>

</TRACKBOX_SELECTION>

<LAST_FRONTEND_UPDATE UPDATE_DATE="2023-09-29T18:28:50"/>

<CAMERA_SETTINGS>

<SHOW_DYNAMIC_REFLEX_SUPPRESSION>false</SHOW_DYNAMIC_REFLEX_SUPPRESSION>

</CAMERA_SETTINGS>

<MENUE>

<SHOW_SERVICE>false</SHOW_SERVICE>
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4 Installing the DTRACK3 software

<IS_DARK_THEME>true</IS_DARK_THEME>

</MENUE>

<MISC>

<AUTO_BACKUP>true</AUTO_BACKUP>

</MISC>

</DTRACK>

In order to deactivate the automatic backup feature change the corresponding entry and
save the changes.

before:

<MISC>

<AUTO_BACKUP>true</AUTO_BACKUP>

</MISC>

after:

<MISC>

<AUTO_BACKUP>false</AUTO_BACKUP>

</MISC>

Z DTRACK3 frontend has to be closed before editing the frontend con-
figuration file.

Z
Please note that these settings are only applicable for the user account
currently used for log-in in Windows. Changes will not affect other
user accounts on the remote PC.

Z The deactivation of automatic backups is applicable for all controllers
accessed by the current user account in Windows.
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5 Connecting to the controller

5.1 Start DTRACK3 frontend software

When you start up DTRACK3 on the remote PC you will see the following welcome splash
screen (see figure 5.1 on page 35) . Using the mouse or shortkeys (2 = down, 4 = left,
6 = right, 8 = up) you can move around the splash screen window, e.g. to a secondary
screen. The position of the window is then saved and will be used at the next start-up.

Figure 5.1: Welcome screen of DTRACK3

DTRACK3 will always try to connect to the last known or default controller. On the lower
left hand corner of the splash screen the current status of connection is shown (refer to
table 5.1 on page 36).
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5 Connecting to the controller

status message Description

testing ’IP-address’ DTRACK3 is trying to access the last known
controller using the IP address shown

testing ’IP-address’ ... OK controller is powered-up and is accessible by
LAN

Controller: ’hostname’ Serial
DTRACK3 version

DTRACK3 is able to connect to the last known
controller

no connection to controller ’host-
name’, accessed by IP address

last known controller is being accessed by an-
other client

testing ’IP-address’ ... unsuc-
cessful
resolving ’hostname’ ... unsuc-
cessful
no connection to controller ’host-
name’

DTRACK3 is unable to access the last known
controller (e.g. not powered up / in standby, no
DHCP service available)

Table 5.1: Splash Screen - Description of status messages

If DTRACK3 is run for the first time the window Controller Selection will be opened auto-
matically. Please refer to chapter 5.1.2 on page 37. If the controller is powered up and
you would like to connect to the controller shown at this point, just press Connect . The
main window will open (refer to 6.1 on page 47).

In case you would like to choose a different controller, press Other Controller . Please
refer to chapter 5.1.2 on page 37.

If the last known controller has been powered down into standby mode, you may wake up
your controller using Wake on LAN. Please refer to chapter 5.2 on page 39.

In any other case (i.e. testing ’IP-address’ ... unsuccessful, resolving ’hostname’ ... un-
successful and Wake on LAN ... unsuccessful), please refer to chapter 13 on page 181.

i
If the access to the controller has been restricted, you will be prompted
to enter the password before the main window will open. In case you
have lost the password, please refer to chapter 5.3.1 on page 43 to
reset the password feature.

5.1.1 DTRACK3 command line parameters

The following parameters (refer to table 5.2 on page 37) may be added to the com-
mand line (i.e. DTRACK3 icon → properties → shortcut → target) when starting the
DTRACK3 frontend.
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5.1 Start DTRACK3 frontend software

Command line parameter Description

-directstart Connect with the last used controller (can be
combined with -measure)

-help Shows a window with these command line pa-
rameters and additional examples

-host <name or IP> Connect with given controller (by hostname or IP
number) (can be combined with -measure)

-measure After connecting, start measurement
-wakeup Wake up the last connected controller (can

be combined with -directstart and -measure)
(not available for SMARTTRACK3 & SMART-
TRACK3/M )

-wakeup <MAC> Wake up controller with given MAC address (can
be combined with -host and -measure) (not avail-
able for SMARTTRACK3 & SMARTTRACK3/M )

Table 5.2: Command line parameters

i
If the access to the controller has been restricted, you will be prompted
to enter the password before the main window will open. In case you
have lost the password, please refer to chapter 5.3.1 on page 43 to
reset the password feature.

5.1.2 Controller selection

Whenever you would like to select a different controller than the default one, press the
button Other Controller on the welcome splash screen. A separate window Controller
Selection will be opened to specify a default controller, see figure 5.2 on page 38.

This is done automatically on the first run of DTRACK3 .

Specific Controller In case of LANs without a DHCP server or via direct connection
to your remote PC (please refer to the ART Hardware Installation Guide ) tick the cor-
responding radio button (Specific Controller ) and specify the IP-address or host-name of
your controller directly by entering it in the field hostname or IP address. To connect press
Connect .
In order to find out the IP address of your controller please refer to chapter 5.3.2 on page
43.

Scan LAN In case of LANs with DHCP-service you may scan your network for available
controllers. Simply tick the radio button Scan followed by pressing the button Update list .
You can also specify the subnet by using the adjacent drop-down menu subnet address.

All available controllers in your network will be listed in the table below. Controllers set in
grey are used by other remote PCs in your network (→ accessed by IP address listed at
welcome splash screen), whereas available controllers for connection are set in black.
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5 Connecting to the controller

(a) specific controller

(b) scan the network

Figure 5.2: Controller Selection

You can easily identify your controller by comparing the serial number (e.g. ART Con-
troller 301422021 or SMARTTRACK3 s3-00432 listed in column Serial) with the corre-
sponding one printed on the label of the device (rear of the ART Controller or ART Con-
troller/M and SMARTTRACK3 & SMARTTRACK3/M , please refer to ART Hardware
Installation Guide ). You can also sort the list by host-name Name or IP-addresses IP.
Select the appropriate entry of your controller and press Connect .

If nothing is listed, please refer to chapter 13 on page 181.

i
If the Controller is not connected to a LAN or no DHCP server is run-
ning, it will use its fall-back IP address (IP 192.168.0.1, subnet mask
255.255.255.0)

i
If the access to the controller has been restricted, you will be prompted
to enter the password before the main window will open. In case you
have lost the password, please refer to chapter 5.3.1 on page 43 to
reset the password feature.
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5.2 Wake On LAN

Z Please make sure that the controller is connected to the local network
and that it is powered up !

Z
In case of LANs protected by firewalls all necessary ports for
DTRACK3 network communication have to be unblocked. Please re-
fer to section A.1 on page 199.

5.1.3 Setting a static IP address

Please refer to chapter 8.7 on page 103 to set your controller to a static IP address using
the DTRACK3 frontend.

In case you need to specify a static IP address without using the frontend (e.g. installa-
tion on network without DHCP service available) please refer to chapter 5.3 on page 40
instead.

5.2 Wake On LAN

The controller is capable of Wake On LAN (WOL) when it has been powered down to
standby mode by the user (DTRACK3 → Controller standby ).
This function is not available for SMARTTRACK3 & SMARTTRACK3/M .
There are two options for waking up the controller remotely:

1. you may use DTRACK3 or

2. use a separate tool (Windows: WOL program; Linux: console-based command).

Option 1 - WOL via DTRACK3 Start the DTRACK3 frontend software. It will search
for the controller and the ’Connect ’ button will be replaced by ’Wake On LAN ’ after a few
seconds (see figure 5.3 on page 39).

Figure 5.3: Welcome screen of DTRACK3 with Wake On LAN option

Press the ’Wake On LAN ’ button and DTRACK3 will try to wake up the controller - this
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may take up to two minutes as the controller has to boot up (see figure 5.4 on page 40).

Figure 5.4: Wake On LAN progress bar

If Wake On LAN is successful DTRACK3 will automatically establish the connection with
this controller and start the frontend software.

Z
Please make sure that the controller is still connected to the local net-
work and that is in standby-mode! DTRACK3 cannot wake up the con-
troller if no physical connection between remote PC and controller is
established or if the controller is powered off!

Option 2 - WOL via separate tool You will need the ’hostname’ of the controller as
well as its MAC address. To get this information, either refer to 5.3.2 on page 43 or en-
ter DTRACK3 and go to Hardware → Network . Copy the ’hostname’ and MAC address
(’ethernet-MAC LAN ’).

If you are using Windows you will need a separate WOL program to use this feature.
Please refer to the manual of the WOL program you are using to find out how to configure
the WOL function.

When using Linux you only need to switch to the console and type in the following com-
mand and your controller restarts:

for Linux openSUSE:

$ wol <MAC address of your Controller>

e.g.: $ wol 00:1D:92:3A:58:5F

for Ubuntu:

$ wakeonlan <MAC address of your Controller>

e.g.: $ wakeonlan 00:1D:92:3A:58:5F

5.3 Configuring your controller’s network address
without network access

You can also configure some settings of the controller without the DTRACK3 frontend
software. You will need a standard USB pen drive (FAT32 formatted).

This way you may
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5.3 Configuring your controller’s network address without network access

• configure the controller to be a DHCP client,

• set a static IP address ,

• reset the password feature for access to the controller and

• carry out a factory reset.

Z
Carrying out a factory reset will result in the loss of all your settings
including your license codes (will be written to USB pen drive during
factory reset) ! Backup your configurations or export your systems
configuration log file beforehand (please refer to 7.3.2 and 12.4.1 on
page 69).

Proceed as follows:

• Plug-in the USB pen drive in any available USB port of the controller. Controller
should be powered up.

• If necessary start up the controller

• Wait some time for the controller to write two files onto the USB pen drive (approx.
20-30 seconds, signalled by two (2) consecutive beeps)

• Unplug the USB pen drive

• Now plug-in the USB pen drive in a computer and view or edit the setup file (see 5.3
on page 41) with any editor

• After changing the setup file please plug-in the USB pen drive in the controller again
afterwards

• Wait some time for the controller to read the setup file (approx. 20-30 seconds,
signalled by three (3) consecutive beeps)

• Unplug the USB pen drive

• Reboot the controller for the changes to take effect

Now, your controller is configured according to your requirements.

Z
Please note that these settings are not part of your personal configu-
ration. Changes will affect all users of your controller! Your controller
may become unreachable with wrong IP settings!

Z
You can find your current license codes in the file
’ART_Controller_XXXX_licenses.txt’ (will be written to USB pen
drive during factory reset)

The setup file Following, a description of the file (e.g. ART_Controller_00117_setup.txt)
format:
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# ART Controller Setup:

# ethernet settings:

# - uncomment just one of the lines starting with 'SETNET'

# ethernet settings: DHCP

# - uncomment the following line to activate DHCP

#SETNET="dhcp"

# ethernet settings: fix IP address and subnet mask

# - uncomment the following line to set a fix IP address and subnet mask

#SETNET="ip 192.168.0.1 255.255.255.0"

# ethernet and routing settings: fix IP address, subnet mask and corresponding gateway

# - only use if destination for tracking data or DTRACK3 frontend is in a different network than ATC

# - note: gateway must be an IP number in same network/netmask as ATC!

# - uncomment the following line to set a fix IP address, subnet mask and gateway IP address

#SETNET="ip 192.168.0.1 255.255.255.0 192.168.0.253"

# name settings: host name

# - uncomment the following line to set the host name

#SETHOSTNAME="atc"

# name settings: domain name

# - uncomment the following line to set the domain name

#SETDOMAINNAME="art.site"

# name settings: domain name server

# - uncomment one of the following lines to set (or clear) a domain name server

#SETNAMESERVER="192.168.0.254" # set DNS (IP or hostname)

#SETNAMESERVER="-" # clear DNS

# reset of frontend password:

# - uncomment the following line to reset a frontend password

#RESETFRONTENDPASSWORD="yes"

# factory reset of all other settings:

# - CAUTION: use with care, all your settings will be lost!

# - uncomment the following line to reset all other Controller settings

# - additionally your ethernet settings will be set to DHCP if no fix IP is set above

# - CAUTION: also all license settings will be reset!

# - export 'system informations' (DTRACK3->Help->Service) to save your license codes;

# or see 'ART_Controller_X_licenses.txt' (will be written to USB stick during factory reset)

# - re-enter all license codes after factory reset under DTRACK3->Licenses

#RESETSETTINGS="yes"

If you would like to run a command you have to remove the ’#’ sign and save the changes.
Example (set a static IP address, e.g.: 123.123.0.1):

before:
#SETNET="ip 192.168.0.1 255.255.255.0"

after:
SETNET="ip 123.123.0.1 255.255.255.0"
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5.3 Configuring your controller’s network address without network access

5.3.1 Password reset and delete without DTRACK3 frontend

In case you have lost the password for access to your controller via the DTRACK3 fron-
tend you can delete the password and reset the feature. You will need a standard USB
pen drive (FAT32 formatted).
Proceed as in the previous section (please refer to chapter 5.3 on page 40) described and
change the setup file (see 5.3 on page 41).
To reset the password feature, remove the ’#’ sign in the setup file and save the changes:

before:

#RESETFRONTENDPASSWORD= "yes"

after:

RESETFRONTENDPASSWORD= "yes"

Have the controller read the changed file and reboot afterwards.

5.3.2 Information retrieval without DTRACK3 frontend

It is possible to retrieve some settings of the controller without the DTRACK3 frontend
software. You will need a standard USB pen drive (FAT32 formatted).

Proceed as follows:

• Plug-in the USB pen drive in any available USB port of the controller. Controller
must be powered up

• If necessary start up the controller first and plug in the USB pen drive after complete
boot-up

• Wait some time for the controller to write two files onto the USB pen drive (approx.
20-30 seconds, signalled by two (2) consecutive beeps)

• Unplug the USB pen drive

• Now plug the USB pen drive in a computer and view the information file (see below)
with any editor

The information file This file contains the current settings of the controller, e.g. the
host-name, serial number and current IP address. Following, a description of the file
format (e.g. ART_Controller_0007_info.txt or ART_Controller_301422021_info.txt):

ART Controller Information:

Name : smarttrack-0007 (or atc-301422021)

Serial Number : 0007 or 301422021

Ethernet (LAN) : dhcp

Ethernet IP (LAN) : 10.10.99.196 255.255.0.0

Ethernet MAC (LAN): 00:03:1d:0b:0f:36
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Gateway (LAN) : 10.10.0.3

Domain Name : xyz.site

Domain Name Server: 10.10.0.1
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6 Menu Overview

Please refer to the corresponding sections for each of the menus.

DTRACK3 Shortcut page 62

Password Set a password for access control via the
DTRACK3 frontend

Licenses License overview → Adding licenses (e.g. higher
amount of cameras, Measurement Tool or Cascaded
Systems)

Configurations Select, create new and save different configurations,
lock the current configuration and backup & restore all
settings

Start/Stop M Start/Stop measurement
Controller standby Force the controller to go into standby mode (shutdown

available for SMARTTRACK3 & SMARTTRACK3/M )
Controller reboot Reboot the controller (not available for SMART-

TRACK2 )
Quit Q Quit DTRACK3

Hardware Shortcut page 73

Search hardware F2 Search for newly added hardware (not available for
SMARTTRACK2 )

Cascaded System Configure a Cascaded System with available con-
trollers (not available for SMARTTRACK2 )

Cameras F7 Camera settings (e.g. flash intensities, sync group as-
signment)

Synccard Shift + F7 Synccard settings (e.g. tracking frequency, external
synchronisation)

Radio Transceiver Settings for ART RadioTransceiver2/3 and devices
within your setup

Inertial Sensor Settings for inertial sensors and hybrid tracking
Network Configure the IP settings of your controller
Time Configure the date/time or NTP / PTP settings of your

controller

Tracking Shortcut page 107

Room calibration F5 Room calibration
Room adjustment Shift + F5 Adjust / transform the room coordinate system
Single markers Activate 3DOF calculation, adjust 5DOF central axis
Body administration F8 Configure your bodies and start calibration process for

all targets and interaction devices
Custom Body Calibration F6 Custom body calibration
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Body adjustment Shift + F6 Adjust / transform the body coordinate system
Flystick Configure your Flystick2/2+/3
Fingertracking F4 Configure your Fingertracking (incl. tactile feedback)

device and start calibration process (i.e. hand geome-
try) (not available for SMARTTRACK2/3/M )

Measurement Tool Configure your Measurement Tool
Measurement Tool tip cali-
bration

Start tip calibration process for the Measurement Tool

Output F9 Set output channels and configure the data to be trans-
mitted

View Shortcut page 169

Set to default Reset the shown displays to default
Monitor 2DOF Graphical display of markers recognized by the cam-

eras
Data F10 Display measurement results (6DOF and / or 3DOF)
Flystick Display Flystick2/2+/3 measurement data
Fingertracking Display Fingertracking measurement data (not avail-

able for SMARTTRACK2/3/M )
Measurement Tool Display Measurement Tool data
Events Display event messages generated by DTRACK3

Tools Shortcut page 171

Measure points Provides simple measurement acquisition for use with
the Measurement Tool

Help Shortcut page 173

What’s this? Shift + F1 Help
What’s new? Overview of the new features
Controller and Camera Up-
date

Start the assistant for updating Controller and cameras

Service and Guides Service-ID, link to ART website and DTRACK3 guides,
export system configuration log

DTRACK3 F1 Software version of frontend & backend
About Qt Qt toolkit version

Table 6.1: DTRACK3 menu structure overview
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6.1 GUI overview

6.1 GUI overview

The graphical user interface of DTRACK3 can be divided into the following parts (see
figure 6.1 on page 47):

• the menu bar with access to all settings (please refer to chapter 6 on page 45)

• the toolbar with graphical elements regarding the status of the tracking system
(please refer to chapter 6.2 on page 48)

• the docking displays with graphical information, measurement results and event in-
formation (see chapter 6.3 on page 50).

Figure 6.1: Graphical user interface of DTRACK3 - default layout
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Figure 6.2: DTRACK3 Toolbar

6.2 Toolbar

By default, the toolbar (see figure 6.2 on page 48) consists of the following elements (from
left to right):

Toolbar element Description

Start/Stop button Starts and stops the measurement
Camera Status Shows the number of markers seen (2DOF) / used for tracking

targets (6DOF) by each camera
Sync Status Displays the current tracking frequency
Tracking Status Shows the number of tracked targets (6DOF) / single markers

(3DOF)
Radio Transceiver Status Displays the currently selected channel of the ART Radio-

Transceiver2/3 (greyed out, if not installed)
Inertial Sensor Status Displays the currently selected channel of the inertial dongles

(wireless only) and the status of the sensor’s warm up process
(hidden, if not installed)

Table 6.2: Toolbar elements of DTRACK3

To change or activate elements right-click anywhere on the toolbar. Drag & drop the ele-
ments for re-arrangement by left-clicking.

Start / Stop button Press this button to start the measurement. To stop tracking press
it once again.

Camera Status The Camera Status field shows two values for each camera (c01, c02,
...). The first one summarizes the amount of markers that are seen by each camera,
wheras the second one only shows the subset which are used for 6DOF tracking.

In the case depicted (see figure 6.3 on page 49), one target equipped with 6 markers
is tracked inside the measurement volume by all 4 cameras c01 to c04. As a result the
second value equals 6 for all cameras.
At the same time cameras c01 to c04 track 4 single 3DOF markers, while camera c04
sees one more additional marker (presumably a reflection) leading to a total of 10 and 11
markers respectively. This additional marker cannot be tracked because it is not seen by
at least one more camera.
One should note that this is a very simple example as multiple targets may be tracked by
only a subset of cameras (min. 2) while additional 3DOF markers and reflections do not
have to be seen by all cameras at the same time. Compare the Tracking Status for more
information about tracked targets and single 3DOF markers (see figure 6.5 on page 49).

48



C
ha

pt
er

6

6.2 Toolbar

Figure 6.3: DTRACK3 Camera Status (toolbar element)

Sync Status The Sync status field shows the current tracking frequency in Hz set in
Hardware → Synccard (Note: Hardware → Inertial Sensor → Tracking Frequency when
using Hybrid Bodies). The background is changing its colour in case the effective fre-
quency is decreasing due to processing overload (see figure 6.4 on page 49):

(a) black / grey: max. 5
frames per minute lost

(b) yellow: 5 - 10 frames per
minute lost

(c) orange: 10 - 15 frames per
minute lost

(d) red: > 15 frames per minute
lost

Figure 6.4: DTRACK3 3 Sync Status (toolbar element) - Visualization of the decrease in
effective synchronization frequency

• black / grey: max. 5 frames per minute lost (i.e. 3600 frames per minute are trans-
mitted, not shown)

• yellow: 5 - 10 frames per minute lost

• orange: 10 - 15 frames per minute lost

• red: > 15 frames per minute lost

Tracking Status In Tracking status the amount of tracked 6DOF targets and single
3DOF markers is shown (see figure 6.5 on page 49). The value on the left, next to the
icon depicting a target, summarizes all activated and tracked targets (Tracking → Body
Administration or mtool , Flystick etc.) inside the measurement volume, in this case only
1. All single 3DOF markers which are not used for 6DOF tracking are shown on the right
next to the icon of a marker, in this case 4 markers.

Figure 6.5: DTRACK3 Tracking status (toolbar element)

Radio Transceiver Status The Radio Transceiver Status shows the currently selected
channel (see figure 6.6 on page 50) of the ART radio set in Hardware→Radio Transceiver ,
in this case ’Channel 18’. The toolbar element is greyed out if no RadioTransceiver2/3 are
installed.
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Figure 6.6: DTRACK3 Radio transceiver status (toolbar element)

Inertial Sensor Status The Inertial Sensor Status displays the currently selected chan-
nel (see figure 6.7 on page 50) of the inertial dongles (wireless only) set in Hardware →
Inertial Sensor . It also depicts the status of the sensor’s warm-up process in the adja-
cent progress bar, in this case approx 50%. The toolbar element is just visible if inertial
sensors are installed.

Figure 6.7: DTRACK3 Inertial Sensor status (toolbar element)

6.3 Docking Displays

By default the first three of the following docking displays are activated (see table 6.3 on
page 50).

Docking Display Description

Monitor 2DOF Graphical display of all markers seen / tracked by the cam-
eras. Colour and shape represent the circularity and size of
the markers respectively.

Data Display Displays measurement results (6DOF and / or 3DOF)
Event Display Displays DTRACK3 events (e.g. "no valid room calibration")
Flystick Shows the measurement results (6DOF) of the Fly-

stick2/2+/3 and the operation of buttons and joystick
Fingertracking Shows the measurement results of the hands (not available

for SMARTTRACK2/3/M )
Measurement Tool Shows the measurement results of the Measurement Tool and

its reference body, if assigned

Table 6.3: Available docking displays in DTRACK3

To change or activate the docking displays right-click anywhere on the Toolbar or use
the menu View (refer to chapter 10 on page 169). Drag & drop the display windows for
re-arrangement by left-clicking.

6.3.1 Monitor 2DOF display

The Monitor 2DOF display is a 2-dimensional graphical display just like a monitor for each
camera equivalent to its field of view (see figure 6.8 on page 51). Essentially the Moni-
tor 2DOF display shows a black window with a schematic display of positions, sizes and
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Figure 6.8: DTRACK3 Monitor 2DOF display (docking display)

shapes of all recognized markers / flashes or other IR sources that can be seen inside
the field of view of the cameras. It is particularly useful for the adjustment (especially
orientation) of the cameras or SMARTTRACK2/3/M (please refer to the ART Hardware
Installation Guide ).

Additional Monitor 2DOF display functions In the Monitor 2DOF display additional
functions are assigned to mouse interactions.

• left mouse button
Drag & drop the camera monitors to move and arrange the position within the Mon-
itor 2DOF view .

• middle mouse button
Click to hide all camera monitors but the one you selected. Click again and all
camera monitors will be displayed.

• right mouse button
Click on a camera monitor to open a context menu for the corresponding camera;
see figure 6.10 on page 53 and table 6.4 on page 54 for more details.

Cameras per tab (not available for SMARTTRACK2 ) In case several ARTTRACK cam-
eras or SMARTTRACK3 & SMARTTRACK3/M are being used in one system, it may
prove helpful to adjust the number of cameras simultaneously shown in the Monitor 2DOF
display in order to achieve a clear arrangement (see figure 6.8 on page 51).

Move the slider ’cameras per tab’ (in the upper right corner) to the left to decrease the
amount of cameras. Tabs containing the remaining cameras will be added below the
Monitor 2DOF display .

Monitor 2DOF most active tab The special tab ’Monitor 2DOF most active’ contains
only those cameras in which the markers / targets are seen most of the time.
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Example: Consider a four camera system with cameras c01 through c04 where you
have set the number of ’cameras per tab’ to two. Now if you move a target in front of
cameras c02 and c03 most of the time, only these two cameras will be shown in the ’most
active cameras’ tab.

Adding/removing cameras (not available for SMARTTRACK2/3/M ) It is possible to
add or remove cameras without restarting the ART Controller or ART Controller/M .
Please refer to chapter 8.1 on page 73 how to dynamically analyse your system for
changes in configuration.

i

When cameras are added to an already calibrated tracking system
these cameras will not contribute for calculation and measurement un-
til you perform a room (re-)calibration (see chapter 9.1.5 on page 111).
Therefore as as reminder the Monitor 2DOF display of the correspond-
ing cameras will show the message (re-)calibration required! in red
color.

i

The ART Controller or ART Controller/M will detect all cameras that
have been removed from an already calibrated tracking system (e.g.
due to a disconnected cable) and mark those as missing until a room
(re-)calibration has been performed. The Monitor 2DOF display of the
corresponding cameras will be disabled (crossed out) and in case of
larger systems their corresponding displays will be moved to a new
camera tab.

Z
DTRACK3 is able to operate when cameras have been added or re-
moved; for best performance it is highly recommended to perform a
recalibration

6.3.1.1 Monitor 2DOF display elements

Each marker is either displayed as a circle or as a cross. This indicates the projected size
of the marker on the camera sensor and depends strongly on the distance to the camera,
see figure 6.9 on page 53.
A simple color code represents the quality (i.e. circularity) of the markers:

green markers ... very good tracking quality
yellow markers ... good tracking quality
red markers ... bad circularity, unreasonable size of marker and / or low intensi-

ties; may result in poor tracking quality
circles ... big marker (e.g. close to camera)
cross ... small marker

Recommendation Increase the flash intensity until all markers become yellow or green
(Hardware → Cameras → ’flash intensity ’. Additionally pay attention to the intensity bar
on the top right corner of each camera monitor, see figure 6.9 on page 53. This indicates
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Figure 6.9: DTRACK3 Monitor 2DOF display elements

the intensity of the brightest pixel in the field of view (refer to figure 6.1 on page 47), in
this case 4 of 10.

i
As a rule of thumb: For measurement applications with high accuracy
requirements the markers should be displayed in green with intensities
of min. 4 bars; for VR applications yellow markers with intensities
down to 2 bars are still sufficient.

i Note: ARTTRACK1 cameras have the bar display integrated into the
camera on their front side.

6.3.1.2 Monitor 2DOF display context menu

Figure 6.10: Monitor 2DOF display context menu (e.g. camera c02)

By right-clicking on the Monitor 2DOF display of the corresponding camera monitor the
following context menu opens:

53



6 Menu Overview

Function Shortcut

Grid G Shows a grid in the camera monitor.
Cross C Shows a cross in the camera monitor.
Fullscreen F Resizes Monitor 2DOF display to full

screen and back.
One Camera Only show the view of the selected

camera.
Display upside down Rotate the orientation of the camera

monitor by 180◦. ’UD’ is displayed in
the camera monitor.

Display blinking Activates / deactivates blinking of 2-
digit LED matrix and status LEDs
on the camera for easy identification
(ARTTRACK5 only).

Static Reflex Suppression
Active Enable static reflex suppression func-

tionality for this camera. ’SR’ is dis-
played in the camera monitor.

Delete all reflex supression areas Deletes the defined reflection areas for
the selected camera only.

Start scan for all enabled cameras Initiates a scan for static reflections.
Enabled only if Active is ticked.

Edit reflex suppression areas E Enter the edit mode in order to manu-
ally select areas to suppress unwanted
reflections.

Delete all reflex suppression areas for
all enabled cameras

Deletes the defined reflection areas for
all enabled cameras at once.

Table 6.4: Context menu of the Monitor 2DOF view

Display upside down The checkbox display upside down rotates the orientation of the
corresponding camera monitor in the Monitor 2DOF display by 180◦.

i
Display upside down proves to be useful when mounting the cameras
upside down. Note: This setting is for display purposes only. It does
not influence the tracking system nor the room calibration.

6.3.2 Static reflex suppression

Automatic and manual reflection suppression First the feature has to be enabled
either globally for all cameras or individually for each camera. Open Hardware → Cam-
eras and mark the checkboxes for each camera you would like to activate the reflection
suppression feature or select global static reflex suppression to activate the feature for all
cameras at once. Please refer to chapter 8.3 on page 76 for details.
Alternatively right-click the Monitor 2DOF display on the respective camera monitor and
enable the feature directly for each camera by selecting the option ’Active’, see figure 6.10
on page 53.

Hereafter there are two ways to carry out a reflection suppression:

1. run an automatic scan

54



C
ha

pt
er

6

6.3 Docking Displays

Open the context menu of the Monitor 2DOF display and start the scan by left-
clicking Start Scan for all enabled cameras (see figure 6.10 on page 53). A scan
function will detect and suppress reflections automatically. Cancel the scan at any
point by clicking Cancel , otherwise wait for completion and accept the detected
areas by clicking OK . The areas will be stored in the controller and can be edited
manually afterwards.

2. set the suppression areas manually
You can define the areas manually where reflections need to be suppressed. Open
the context menu of the Monitor 2DOF display and enter the edit mode by selecting
’Edit reflex suppression areas’, see below. You may also use the shortcut (’E ’) listed
in table 6.4 on page 54).

Z Be sure to remove all targets from the measurement volume before
starting the scan.

Z
Be aware that reflection suppression leads to decreased field of view
/ effective measurement volume by blocking the area in which the re-
flection originated.

(a) Reflex suppression edit mode (b) Reflex suppression edit mode help

Figure 6.11: Reflex suppression Edit mode

Edit reflection suppression areas Within the edit mode (see figure 6.11(a) on page
55) you may:

• create new areas by left mouse button click, hold & drag a rectangle shaped box,
then release mouse button,

• delete areas by right mouse button click inside an area followed by pressing the
button delete,
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• clear regions by shift + left mouse button click, hold & drag a rectangle shaped box
to create a clearing area, then release the mouse button

• move areas by left mouse button click, drag & drop an existing area.

Leave the edit mode by opening the context menu (right-click the Monitor 2DOF display )
of the respective camera monitor, then de-select ’Edit reflex suppression areas’. Reflec-
tion suppression areas are enabled as soon as you and accept the changes. The areas
will be stored in the controller and can be edited each time you enter this mode.

Configuring reflection suppression If you want to disable the reflection suppression
feature for one camera only, open the context menu of the respective camera monitor and
deactivate the option ’Active’.

To permanently delete the reflection suppression areas for one camera, right-click on the
respective camera monitor and select ’Delete all reflex suppression areas’ and accept the
changes.

You can also delete the reflection suppression areas for all cameras at once by selecting
’Delete all reflex suppression areas for all enabled cameras’.

6.3.3 Data Display

Figure 6.12: Data Display (docking display)

The Data Display is split into two parts, 6DOF and 3DOF measurement results respec-
tively.

6.3.3.1 6DOF measurement results

On the left hand side (see figure 6.12 on page 56), the Data Display shows the following
measurement results :
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1. the body ID

2. the assigned name

3. the status of an assigned reference body

4. filtering status of 6DOF measurement results (’active’ or ’ ’)

5. position (X, Y, Z ) and orientation (rx, ry, rz) relative to the room coordinate system

6. additional information for inertial sensors (sensor ID, battery level, temperature

Body ID The bodies are sorted by increasing body ID.
A simple colour code indicates the tracking status of the body:

green ... body is being tracked; tracking data is displayed
yellow ... body is being tracked only by the means of the inertial sensors

(rotational data is displayed only!)
red ... body is not being tracked; instead of tracking data zeros are dis-

played
white / black ... body is not activated; columns are filled with -
white / black ... body is not calibrated; columns are left blank

Reference body The ’name’ of a standard 6DOF body assigned as reference will be
highlighted.

reference ... body is assigned as reference; ’reference’ is displayed when no
specific name has been assigned

Z
When a reference body has been assigned, all 6DOF bodies and 3DOF
single markers can only be tracked when the reference body is being
tracked as well.

Filtering of 6DOF measurement results Next to the body ID the filtering status is
shown (i.e. ’active’ or ’ ’). Right-click the field active in the column filter of the correspond-
ing target and press the button filter to open the filter settings menu. For more information
about filtering options please refer to chapter 9.4.6 on page 129.

Position and orientation The position (X, Y, Z ) in mm and the orientation (rx, ry, rz)
in deg ◦is given relative to the room coordinate system unless a reference body has been
assigned. The rotation angles (rx, ry and rz) are rotations around the X, Y and Z axis
respectively. The mathematical definition can be found in the DTRACK3 Programmer’s
Guide .

Additional information for inertial sensors In the Data Display additional information
is provided for inertial sensors:
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• sensor ID

• battery level

• temperature in ◦C

i
The temperature values between single inertial sensors may vary. The
operating temperature is reached as soon as there are no more tem-
perature changes inside the sensors indicated by a green status bar. It
is not dependent on the absolute temperature value.

6.3.3.2 3DOF measurement results

On the right hand side, the Data Display shows the 3DOF measurement results. All
tracked single 3DOF markers that have not been assigned to a calibrated 6DOF body
(i.e. markers of targets not yet calibrated) are shown here.

i
Positional information of single 3DOF markers are shown in the data
display only when activated in Tracking → Single Markers → calcula-
tion of 3DOF markers.

6.3.4 Flystick display

Figure 6.13: Flystick Display (docking display)

Flystick measurement results The Flystick display shows the following measurement
results:

1. the Flystick ID

2. the status of buttons b1...bx , if applicable

3. the status of the trigger jt (Flystick2+ only)

4. the status of the joystick jx, jy

5. filtering status of 6DOF measurement results (’active’ or ’ ’)

6. position (X, Y, Z ) and orientation (rx, ry, rz) of the Flystick2/2+/3

A simple colour code indicates the status of the Flystick :
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green ... Flystick2/2+/3 is being tracked; tracking data is displayed
red ... Flystick2/2+/3 is not being tracked (e.g. Flystick has not been as-

signed to ART radio transceiver); instead of tracking data dashes
are displayed

blue ... button is being pressed
white / black ... Flystick2/2+/3 is not calibrated; columns are left blank

6.3.5 Fingertracking display

Figure 6.14: Fingertracking Display (docking display)

Fingertracking measurement results The Fingertracking display (not available for
SMARTTRACK2/3/M ) shows the following measurement results of all hands including
each finger (i.e. thumb, index, middle, ...):

1. the hand ID

2. the assigned name of the hand geometry name (e.g. left or right)

3. position (X, Y, Z ) and orientation (rx, ry, rz) of the hand and fingers relative to the
selected coordinate system

The coordinate system of the measurement data may be switched by using the radio
buttons hand and room. You can distinguish between the hands either by the hand ID or
by the assigned name of the hand geometry.
A simple colour code indicates the status of the Fingertracking :

green ... Fingertracking device is being tracked; tracking data is dis-
played

yellow ... Hand-target is being tracked (i.e. fingers are calibrated, but out-
side cameras field of view); last known tracking data is displayed

red ... Fingertracking device is not being tracked (e.g. only back of the
hand is calibrated); last known tracking data is displayed

white / black ... Fingertracking device is not calibrated; columns are left blank
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Figure 6.15: Measurement Tool Display (docking display)

6.3.6 Measurement Tool display

The Measurement Tool display is split into two parts (see figure 6.15 on page 60):

Measurement Tool measurement results

1. the Measurement Tool ID

2. the assigned reference ID of the corresponding reference body

3. status of buttons b1...b3, if applicable

4. position (X, Y, Z ) and orientation (rx, ry, rz) of the Measurement Tool ’s tip

Measurement Tool reference measurement results

1. the Measurement Tool reference body ID

2. position (X, Y, Z ) and orientation (rx, ry, rz) of the reference body

A simple colour code indicates the status of the Measurement Tool and the reference
body, respectively:

green ... tool is being tracked; tracking data is displayed
red ... tool is not being tracked (e.g. tip calibration is missing); instead

of tracking data dashes are displayed
blue ... measurement is being performed and / or button is being pressed

white / black ... tool is not calibrated; columns are left blank

Z A Measurement Tool with an assigned reference body can only be
tracked when the reference body is tracked as well.

6.3.7 Event display

The Event display presents the status of the tracking system (see figure 6.16 on page
61). It offers feedback of the operational state regarding errors or warnings. Furthermore,
it informs the user about successful room or body calibrations. Each entry is associated
with a timestamp and date.
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Figure 6.16: Event Display (docking display)
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7 Menu DTRACK3 - Basic
Configuration

DTRACK3 Shortcut

Password
Licenses
Configurations
Start/Stop M
Controller standby
Controller reboot (not available for SMARTTRACK2 )
Quit Q

Table 7.1: Menu DTRACK3

7.1 Password

In order to restrict the access to the currently connected controller you may enable pass-
word protection of the frontend.

Enable password protection Open the corresponding dialog via DTRACK3 → Pass-
word and tick the checkbox Enable password protection. Please refer to figure 7.1 on
page 63. Next enter your selected password in the entry fields ’New password ’ and ’Re-
peat password ’ respectively. If both entrys are matching the fields will turn green and a
corresponding message will appear. Press OK and a warning message will appear next.
If you are sure press OK to accept the password for protection. Otherwise press Cancel
to return to the dialog.

Z
Please note that these settings are not part of your personal configu-
ration. Changes will affect all users of your controller! Your controller
may become unreachable when the password is lost!

Z
The password protection only restricts the access via the
DTRACK3 frontend. Other control options such as the SDK or
the CLI (command line interface tool) still provide full access to all
functions and features !

Disable password protection In the dialog untick the checkbox Enable password pro-
tection and press OK . A warning message will appear next. If you are sure press OK to
remove the password protection. In the last step you will be prompted to enter the current

62



C
ha

pt
er

7

7.1 Password

Figure 7.1: Enable Access control

password. Enter the password and press OK once again. Please refer to figure 7.2 on
page 63. The password protection feature is disabled and the previously set password is
deleted.

If the entered password is incorrect a corresponding message will appear. You may then
try again and enter the correct password.

Figure 7.2: Authorize Access control

Change the currently set password In the dialog enter your new password in the en-
try fields ’New password ’ and ’Repeat password ’ respectively, then press OK . A warning
message will appear next. If you are sure press OK to change the password. Otherwise
press Cancel to return to the dialog. In the last step you will be prompted to enter the
current password. Enter the password and press OK once again. Please refer to figure
7.2 on page 63. The password will be changed and the dialog is closed.

If the entered password is incorrect a corresponding message will appear. You may then
try again and enter the correct password.

i In case you have lost the password, please refer to chapter 5.3.1 on
page 43 to reset the password feature.
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7.2 Licenses

The capability of the tracking system is defined by licenses which can be managed here,
see figure 7.3 on page 64. You can upgrade to any functionality by simply entering a
license code. Ask your ART representative for pricing.

(a) Licenses overview (b) Hardware information

Figure 7.3: Managing the licenses

i
Some features designed for advanced and experienced users are op-
tional and therefore hidden by default. In order to access these fea-
tures a license code is necessary. Please ask your ART representative
for more details.

7.2.1 Entering a license code

Example: If you would like to add a license, go ahead as follows:

• Select any feature by left-clicking.

• Click on Hardware Info to open the Hardware Information dialog.

• Contact your ART representative and communicate your version of DTRACK3 to-
gether with the serial number of the Synccard2/3 or alternatively the MAC address
of the Ethernet port (=Identification) in order to receive a valid license code.

• Exit the window Hardware Information and enter a valid license code in the field new
license code.

• Click on Add license.
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• Exit the window Licenses

7.2.2 License model

Starting with DTRACK3 a new license model has been established:

System Feature Values Status

Cascaded Systems supported / not supported / ex-
piry at date / expired since date

Inertial Sensors max. I
sensors

I = 1, 2, 4, 16 supported / not supported / ex-
piry at date / expired since date

max. C cameras C = 2, 4, 8, 16, 32, 50,
80

supported / expiry at date / ex-
pired since date

max. C cameras (master) 1 C = 2, 4, 8, 16, 32, 50,
80

supported / expiry at date / ex-
pired since date

max. C cameras (slave-
hostname) 1

C = 2, 4, 8, 16, 32, 50,
80

supported / expiry at date / ex-
pired since date

max. B bodies B = 4, 10, 30, 50, 70 supported / expiry at date / ex-
pired since date

Measurement Tool supported / not supported / ex-
piry at date / expired since date

Output of Covariance Data
2

supported / not supported / ex-
piry at date / expired since date

Room Adjustment based
on Reference Points

supported / not supported / ex-
piry at date / expired since date

Setting of Camera Thresh-
old and Exposure 2

supported / not supported / ex-
piry at date / expired since date

Maintenance Feature Values Status

DTRACK3 Upgrade until releases v3.X and patches
/ until date and patches

Service Level Standard / Extended /
Professional / Service
Contract

supported / expiry at date / ex-
pired since date

Warranty Level Standard / Priority / War-
ranty Contract

supported / expiry at date / ex-
pired since date

1 available for cascaded systems only. The number of cameras are listed separately for
master and slave(s) controllers.

2 hidden, by default except for AT7-80 . An optional license code is necessary to unlock
these features. Please ask your ART representative for more details.

Table 7.2: Licenses overview

Licenses are divided in the categories ’System Feature’ and ’Maintenance Feature’. ’Sys-
tem Feature’ licenses enable functionalities of DTRACK3 , while ’Maintenance Feature’
licenses are mainly for informational use. All licenses without expiration date are shown
as (’supported ’).

Example Max. 8 cameras enables the simultaneous connection of up to 8 ART cam-
eras. Service Level corresponds to the status of contract for service and maintenance, if
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applicable. The minimum level without contract is ’Standard ’. For higher levels the date
is shown when the contract will be about to expire. For further information please consult
your service agreement.

i
The maximum number of Standard bodies that may be tracked simul-
taneously does not include interaction devices (Fingertracking , Fly-
stick2/2+/3 , Measurement Tool ).

i The total number of cameras cannot exceed 80 for any combination of
cameras or SMARTTRACK3 & SMARTTRACK3/M systems respectively.

i
The licensing scheme for the number of cameras in a cascaded sys-
tem is automatically derived from all licenses available in both master
and slave(s) controllers, e.g. 8 ARTTRACK5 on master + 4 TRACK-
PACK/E cameras on slave = license showing 12 cameras. Note:
SMARTTRACK3 & SMARTTRACK3/M count as two cameras each.

Z
The maximum amount of Standard bodies that can be activated and
tracked simultaneously depends on your license key (e.g. license for
10 bodies = up to 70 accessible slots for configuration of calibrated
bodies, but only 10 slots may be activated at the same time). When
exceeding the limit a warning message and dialog will appear.

Z The master controller needs to have a dedicated ’Cascaded Systems’
license.

7.2.2.1 License Expiration

When issued each license may be acquired for a limited period of time (’supported, ex-
piry at ’). At that point the feature or functionality will stop working and the license status
will change to (’expired since’). An additional warning message will appear 14 days in ad-
vance of expiration at every startup of the DTRACK3 frontend (see figure 7.4 on page 66).

Figure 7.4: Expiry Warning for limited licenses

You may extend your licenses at any time. For further information please contact your
ART representative.

Z When the license for your cameras expires you will not be able to start
a measurement at all !
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7.2.2.2 Update & Upgrade Licenses

License DTRACK3 Upgrade defines which updates of the DTRACK3 software are pos-
sible. It corresponds either to a version number or the release date of a future release
of DTRACK3 . Updates of patch versions (increasing the third digit of a version number,
e.g. v3.2.0→ v3.2.1→ v3.2.2→ ..., may be performed without restrictions at any time.

Z All patch releases and updates (e.g. v3.2.0→ v3.2.1→ v3.2.2→...) may
be installed without restrictions.

Z
DTRACK3 may only be upgraded to the next minor version (e.g.
v3.2.X → v3.3.0) having a valid ’DTRACK3 Upgrade’ license. Ask your
ART representative for more information.

7.3 Configurations

It is possible to create and manage personalised configurations, e.g. with different tar-
gets or flash intensity settings (see also figure 7.5 on page 67). Go to DTRACK3 →
Configurations to open the corresponding dialog.

7.3.1 Managing configurations

Any existing configuration may be activated and loaded by selecting the corresponding
entry and clicking Apply .
All unlocked configurations except the ’standard ’ one can be deleted. Select the entry to
be deleted and click Delete. Quit the dialogue at any time by pressing Exit .

Figure 7.5: Manage configurations

Z
A warning message will appear when the maximum storage space for
configurations is running low. Please delete obsolete or unneccessary
configurations at your earliest convenience.
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7.3.1.1 Editing configurations

Unless the configuration is locked, it may be changed using the button Edit . You can
assign a meaningful description (’description’) and enter your user name (’owner ’), see
also figure 7.6 on page 68. Accept the changes with OK .

Figure 7.6: Edit configurations

7.3.1.2 Creating a new configuration

Press New to create a new configuration using the corresponding window (see figure 7.7
on page 68). You can assign a meaningful description (’description’) and enter your user
name (’owner ’).

Figure 7.7: Creating a new configuration

Your personal configuration can be created in two ways:

1. ’clone current configuration’
all existing calibrations (room and body calibration), settings and values are inherited
from the currently active configuration.

2. ’create with default values’
default values will be applied (i.e. the system will start from scratch as manufac-
tured). The system will not have a valid room calibration or any body calibrations.

Just press Create and the configuration is saved on the controller.
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7.3 Configurations

Figure 7.8: Locking a configuration

7.3.1.3 Locking configurations

It is possible to protect the settings of any configuration with a password by pressing
the button Lock . You will be asked to enter and confirm a new password to lock your
configuration (see figure 7.8 on page 69).
A locked configuration cannot be changed later on with Edit .

i Locking the configuration does not provide access-control! Only
changes in settings / calibrations are disabled.

Z In case you forget the password please call ART for assistance

7.3.2 Backup Configurations

It is possible to export and re-import single configurations or to backup and restore all
settings at once.

(a) Select the configurations to save (b) Select the folder on remote PC

Figure 7.9: Backup configurations

Press the button Backup to open the corresponding Save configurations window for se-
lecting the configuration(s) to export (see figure 7.9(a) on page 69). Either (de-)select
individual configurations by left-clicking or click select all and clear respectively. Tick the
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Figure 7.10: Backup configurations - Confirmation Window

checkbox all settings and configurations (backup) to save a complete backup of your sys-
tem’s settings. Press ’Save’ to select a destination directory on a remote PC (see figure
7.9(b) on page 69). A confirmation window will inform you of the successful export (see
figure 7.10 on page 70).

7.3.3 Restore Configurations

’Restore’ loads previously exported configuration files or complete backups from a remote
PC. First select the folder on the remote PC where you have stored the configuration files
(see figure 7.11(a) on page 70), then select the configurations to import (see figure 7.11(b)
on page 70). The imported configuration will be activated automatically. It is also possible
to import multiple configurations at the same time. A confirmation window will inform you
of the successful import (see figure 7.12 on page 71).

(a) Select folder on remote PC (b) Select configurations to load

Figure 7.11: Restore configurations

i
Accidentally deleted configurations may be restored presuming an ex-
port had been carried out beforehand. In the unfortunate event of
repairs this data can also be restored to a replacement controller.
Note: A room (re-)calibration might be necessary especially in case
the amount of cameras or the camera models should have changed.

Z Backup your data by exporting configurations on a regular basis !
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7.4 Start/Stop

Figure 7.12: Restore configurations - Confirmation Window

Z
When exporting single or multiple configurations please assign mean-
ingful filenames (e.g. exporting date ’Standard 07122012’). Configura-
tions using the standard filename (e.g. "Standard") will be overwritten!

7.4 Start/Stop

Start or stop the measurement by pressing the button Start / Stop or by using the keyboard
shortcut ’M’.

7.5 Controller standby

Force the controller to go into standby mode with this command. A confirmation window
will show up (see figure 7.13 on page 71). You can restart the controller manually or by
using Wake On LAN. Please refer to chapter 5.2 on page 39 for more details.

Figure 7.13: Shut down DTRACK3 - Confirmation Window

7.6 Controller reboot

Reboot the controller with this command. This function is not available for SMART-
TRACK2 . A confirmation window will show up (see figure 7.14 on page 72).

7.7 Quit

Quit DTRACK3 frontend software. In case the system is still in measurement mode, a
confirmation window will show up (see figure 7.15 on page 72). You may leave the active
measurement running or stop the measurement together with the frontend at this point.
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Figure 7.14: Reboot DTRACK3 - Confirmation Window

Figure 7.15: Quit DTRACK3 - Confirmation Window
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8 Menu Hardware - Hardware
configuration

Settings Shortcut

Search hardware F2 (not available for SMARTTRACK2 )
Cascaded System (not available for SMARTTRACK2 )
Cameras F7
Synccard Shift+F7
Radio transceiver
Inertial Sensor
Network
Time

Table 8.1: Menu Hardware

8.1 Search hardware

Without the need for restarting the controller you can dynamically analyse your system for
changes in configuration (e.g. added or removed cameras, ART RadioTransceiver2/3 )
This function is not available for SMARTTRACK2 . Therefore proceed as follows:

• connect a new camera to the controller

• wait until the camera has finished booting

• within DTRACK3 press the button Hardware→ Search hardware or use the shortcut
’F2’ to perform a search for new hardware

• check if the camera has been recognized successfully (e.g. by opening Hardware
→ Camera or use the shortcut ’F7 ’)

• start the measurement, the message (re-)calibration required! inside the Monitor
2DOF display of the corresponding camera (see chapter 6.3.1 on page 50 for de-
tails)

• perform a room re-calibration 9.1.5 on page 111, added cameras are automatically
marked as ’moved ’ in the room re-calibration dialog.

i
When cameras are added to an already calibrated tracking system
these cameras will not contribute for calculation and measurement un-
til you perform a room (re-)calibration (see chapter 9.1.5 on page 111).
As a reminder the Monitor 2DOF display of the corresponding camera
monitor(s) will show the message (re-)calibration required! .
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i

The ART Controller or ART Controller/M will detect all cameras that
have been removed from an already calibrated tracking system (e.g.
due to a disconnected cable) and mark those as missing until a room
(re-)calibration has been performed. The Monitor 2DOF display of the
corresponding cameras will be disabled (crossed out) and in case of
larger systems their corresponding displays will be moved to a new
camera tab.

Z
DTRACK3 is able to operate when cameras have been added or re-
moved; for best performance it is highly recommended to perform a
recalibration.

8.2 Cascaded System Settings

i We recommend creating a new configuration for all cascaded systems:
DTRACK3 → Configurations → ’New ’

Go to Hardware → Cascaded System to enter the configuration dialog for the cascaded
systems (see figure 8.1 on page 74). This function is not available for SMARTTRACK2 .
There you may select single tracking systems to build a cascade. On the right-hand side
of the dialog all ’Available’ controllers are listed (i.e. which can become a slave in the
cascaded system).

Figure 8.1: Cascaded System Settings

When you have set up your cascaded system using a direct link (via ’Cascaded Network
Port ’ or Synccard3 or internal camera network) between master and slave controller the
list will be filled automatically.

When using a connection via LAN, you can tick the checkbox ’scan LAN ’ and DTRACK3 will
search automatically whether controllers are available for cascading. The button ’Update’
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8.2 Cascaded System Settings

refreshes the list.
Mark the desired controller by left-clicking and press ’Select ’ to assign this controller to
the cascaded system. It will then appear on the left-hand side of the dialog in the list of
the ’Selected ’ controllers. Repeat these steps if you want to add more slave controllers
to the cascade.
To remove controllers from the cascaded system simply select the corresponding con-
trollers in the list of the ’Selected ’ controllers by left-clicking and press button ’Deselect ’.

You can also enter a ’slave hostname or IP address’ directly in case you have set a spe-
cific static IP address. Please refer to chapter 5.3 on page 40 for more information.

The checkbox ’wake on LAN ’ enables synchronized start-up of the master and all slave
controllers (not available for SMARTTRACK3 & SMARTTRACK3/M ). Starting of the cas-
cade will take 3-4 minutes as the master has to boot up first and then wake up the slave(s).

The changes will be accepted by the system by pressing ’OK ’. Settings (e.g. flash in-
tensity, sync groups) of all cameras inside the cascade can now be edited through the
Hardware → Cameras dialog. Proceed with configuration of your setup. The next time
you start the measurement all cameras inside the cascade can be accessed through the
Monitor 2DOF display .

i In case of using the ART Synccard3 or internal camera network all
slave controllers will acquire their IP addresses automatically.

i
By default all controllers are set up to support DHCP. When building
cascades via LAN the controllers will acquire an IP address automati-
cally given that a DHCP server is running.

Z
If any slave controller is not connected via an ethernet cable or
no DHCP server is running, it will use a fall-back IP address (IP
192.168.0.1, subnet mask 255.255.255.0) and you will not able to con-
nect to your slave controllers !

Z
If the cascade is connected via the ’Cascaded network port ’ of the
ART Controller or ART Controller/M , all slave controllers must be set
to a specific static IP address in the subnet 172.29.xxx.xxx with subnet
mask 255.255.0.0. Do not use IP addresses in the range from 172.29.0.1
to 172.29.0.20 ! Please refer to chapter 5.3 on page 40.

Z
Shutdown of master and slave controller(s) is always synchronized.
Tick the option ’wake on LAN ’ to also start-up the slave controller(s)
automatically.

Z
Before starting a measurement, please double-check whether a BNC
connection for synchronisation has been established between master
ART Controller ’OUT1’ or ART Controller/M ’OUT ’ and slave(s) ’EXT.In’.

Z
Do not use the PoE injector nor the BNC synchronisation when
connecting SMARTTRACK3 & SMARTTRACK3/M slaves to ART Con-
trollers.
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8.3 Camera Settings

This dialog (see figure 8.2 on page 76) shows a comprehensive list of all cameras cur-
rently connected to the system as well as all cameras that have been removed since the
last valid room calibration. It allows changes of all camera specific settings (e.g. flash
intensity, static reflex suppression, syncgroup assignment, etc.) either for all cameras at
once (globally) or for each camera separately by left-clicking and selecting the appropri-
ate entry.
Here you can also toggle modulated flash in order to synchronize and trigger an active
target.

8.3.1 All Cameras tab

By default the window opens up showing the tab All Cameras.

Figure 8.2: Camera Settings - All Cameras Tab

All detected cameras are shown in the table (8.2 on page 77) with their corresponding
settings (from left to right):
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8.3 Camera Settings

Column Description

Camera Shows the assigned camera ID c01 to ... (compare LED ma-
trix display on AT7-80 & ARTTRACK5 )

Model Shows the type of camera
Serial Shows ART internal serial number of each camera (suffix L /

R for SMARTTRACK3 & SMARTTRACK3/M left & right cam-
eras)

Flash intensity Change the currently set flash intensity (individually)
Modulated flash (De-)activates the synchronisation signal and trigger for active

targets (individually)
Static reflex suppr. (De-)activates the static reflex suppression for this camera (in-

dividually)
Sync group Select the syncgroup (’Channel 1’ - ’Channel 3’ for ART-

TRACK6/M , ARTTRACK5 , ARTTRACK5/C & TRACK-
PACK/E individually)

Camera mode Select the camera mode (available modes depend on model,
set individually)

Room cal Shows the status of room calibration (i.e. ’no’ for newly added
but not yet calibrated cameras)

Table 8.2: Menu Camera Settings

8.3.1.1 Flash intensity

The flash intensity may be changed within an interval from

• 0 .. 6 for ARTTRACK1 (discontinued),

• 0 .. 8 for ARTTRACK2 / ARTTRACK3 (discontinued),

• 0 .. 100 for ARTTRACK6/M , ARTTRACK5 , ARTTRACK5/C , TRACKPACK/E and
SMARTTRACK3 & SMARTTRACK3/M

• 0 .. 7 for TRACKPACK (discontinued).

• 0 only for ARTTRACK6/M for Active Markers

i
The flash setting strongly depends on the working area and range. In-
crease the flash intensity until all markers become yellow or green us-
ing the Monitor 2DOF display . Additionally pay attention to the inten-
sity bar on the top right corner of each camera monitor. Please refer to
chapter 6.3.1 on page 50 for instructions.

i
As a rule of thumb: For measurement applications with high accuracy
requirements the markers should be displayed in green with intensities
of min. 4 bars; for VR applications yellow markers with intensities
down to 2 bars are still sufficient.

i
When using SMARTTRACK3 & SMARTTRACK3/M the flash intensity,
the modulated flash and the sync group is changed simultaneously for
both cameras.
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Z
A warning message will appear if AT7-80 are not connected to PoE+
rated switches or power supplying injectors indicating that the maxi-
mum available flash intensity is limited.

Z The ARTTRACK6/M for Active Markers cameras do not offer an infrared
flash. Thus it is not possible to adjust the flash intensity.

Z
When using ARTTRACK2/C cameras it is not possible to adjust
the flash intensity of the corresponding external flashes with the
DTRACK3 frontend software!
Please contact ART in case you need to adjust the flash intensity of
the external flashes.
Keep a distance of min. 20 cm when operating the cameras ! All cam-
eras are assigned to the Exempt Group according to IEC62471-1 and
therefore pose no risk or hazard to the human eye or skin at this dis-
tance.

Modulated flash ART tracking systems can be used with active markers, i.e. markers
consisting of infrared LEDs instead of retro reflective material (please refer to the ART
Hardware Installation Guide→ Markers & Targets). Tick the checkbox modulated flash
in the table to activate the synchronisation signal (i.e. coded IR flash) that triggers active
targets for individual cameras.

i
The effective flash intensity is reduced significantly when the modula-
tion is used in combination with low flash intensities. The influence is
negligible at higher flash intensity settings. Simply increase the flash
intensity, if necessary.

i The range of the modulated flash is significantly higher than the effec-
tive tracking distance of the cameras.

Z

All cameras with activated modulated flash have to be assigned to
syncgroup #1 (default for SMARTTRACK3 & SMARTTRACK3/M ) ! ART-
TRACK6/M , ARTTRACK5 , ARTTRACK5/C , TRACKPACK/E , & TRACK-
PACK systems may be configured via software. ARTTRACK2 & ART-
TRACK3 have to be connected to ’OUT1’ on the ART Controller and
’OUT ’ on the ART Controller/M respectively.

8.3.1.2 Static reflex suppr.

Tick the corresponding checkbox to activate the support of static reflex suppression.
Please refer to the 6.3.2 on page 54 for further information.

8.3.1.3 Sync group

In case of mutual blinding of cameras (see ART Hardware Installation Guide→ Setting
up the cameras) one can assign different syncgroups for opposing or adjacent cameras.
You may change the assignment either on the All Cameras tab or on the Individual tab of
the respective camera. Click on the appropriate field in the column ’Sync group’ to open
a drop-down menu. Possible values are ’Channel 1’, ’Channel 2’ or ’Channel 3’.
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8.3 Camera Settings

These channels correspond to the three syncgroup outputs (time delays #1: 0 µs, #2: 480
µs, #3: 960 µs on the ART Controller or ART Controller/M ). To change the predefined
time delays please refer to 8.4 on page 85.

Please refer to the ART Hardware Installation Guide→ Installation of the Controller for
syncgroup assignment of ARTTRACK cameras in backward compatible systems.

Z The ART Controller/M offers synchronization output for ARTTRACK1 –
ARTTRACK3 cameras on syncgroup #1 only !

8.3.1.4 Camera mode

Depending on the model and on your application you can change the camera mode (i.e.
the field of view) in order to achieve:

• higher max. frame-rates (refer to ART Hardware Installation Guide → Technical
Specifications for each camera model)

• lower latencies (i.e. time delays for measurement data).

To switch the camera mode, click on the field in the column ’Camera mode’ to open a
drop-down menu (e.g. 1.1 Mpix, max. 60 Hz).

i

The max. frame-rate is limited by the camera with the largest field of
view selected respectively the max. frame-rate of that individual cam-
era. In mixed systems the max. frame-rate is always limited to 60
Hz (ARTTRACK2 or ARTTRACK3 with ARTTRACK6/M , ARTTRACK5 or
TRACKPACK/E ) or 120 Hz (TRACKPACK/E with ARTTRACK6/M or ART-
TRACK5 ) respectively.

Z Note: Higher frame-rates come at the cost of the cameras’ reduced
field of view.

8.3.1.5 Room cal

This indicator shows whether the corresponding camera was present and running dur-
ing the last valid room calibration. Hence, yes shows that the camera will be used for
measurements and will contribute to the tracking. On the contrary no indicates that addi-
tional cameras have been added to an existing configuration without performing a room
(re-)calibration. Thus a (re-)calibration is necessary for the corresponding camera to con-
tribute to the tracking. Please refer to chapter 8.1 on page 73 on how to add new cameras
dynamically.

i

The ART Controller or ART Controller/M will detect all cameras that
have been removed from an already calibrated tracking system (e.g.
due to a disconnected cable) and mark those as missing until a room
(re-)calibration has been performed. The corresponding entries are
greyed out to show that the cameras have been disabled. The only
data shown is model and serial number.
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Z
DTRACK3 is able to operate when cameras have been added or re-
moved; for best performance it is highly recommended to perform a
re-calibration.

8.3.1.6 Global settings

Tick the checkboxes to adjust the corresponding settings for all cameras at once.

global flash intensity Move the adjacent slider to adjust the flash intensities of all cam-
eras globally.

static reflex suppression Tick the corresponding checkbox to activate the support of
static reflex suppression for all cameras at once.

global camera mode Set the field of view for all cameras globally by using the adjacent
dropdown-menu (e.g. 1.1 Mpix, max. 60 Hz) on the right.

global display intensity Move the slider to adjust the brightness of the status LEDs on
all camera models and the LED matrix display on the ARTTRACK5 and AT7-80 . The
brightness can be dimmed from 0...100% if necessary (e.g. in light-sensitive environ-
ments).

global display mode (ARTTRACK5 only) Select default to activate the status LEDs
and the LED matrix display to show the currently assigned camera ID. Alternatively select
number of markers / camera ID to display the number of detected markers in the camera’s
field of view instead (only during measurements). The LED matrix display can also be
deactivated by selecting only status LEDs.

global ring display intensity (AT7-80 only) Move the slider to adjust the brightness of
the ring indicator LED on AT7-80 models. The brightness can be dimmed from 0...100%
if necessary (e.g. in light-sensitive environments).

modulated flash Tick the checkbox here to activate the modulated flash for all cameras
at once.

8.3.1.7 Show Details

Here you can change the settings regarding low-level marker detection globally (see figure
8.2 on page 76):

marker mode The marker detection algorithm may be changed to achieve better per-
formance in speed ’fast ’ or accuracy ’accurate’ for cameras ARTTRACK2 and ART-
TRACK3 .
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8.3 Camera Settings

Option Description

global marker mode configure the marker detection algorithm
global maximum number of markers set maximum number of markers that a camera is al-

lowed to detect simultaneously
global maximum diameter of markers set maximum size of a marker that a camera is allowed

to detect (in percentage of the camera’s sensor size)
global minimum diameter of markers set minimum size of a marker that a camera is allowed

to detect (in pixel)

Table 8.3: Camera Settings - Show Details All Cameras Tab

maximum number of markers The maximum frame-rate for each camera type at any
given FOV or camera mode respectively is limited by the amount of simultaneously de-
tected markers. The frame-rate is equivalent to the frequency set on the Synccard (see
8.4 on page 85). In scenarios with very high amounts of visible markers (e.g. 150 and
beyond) the frame-rate may only be achieved by allowing a limited maximum number of
markers.

maximum diameter of markers This parameter allows to exclude unreasonably sized
markers from marker detection (e.g. reflections). The default values are derived from use
of standard ART target dimensions and marker sizes in scenarios of typical measurement
distances. Units are measured in percentage of observed marker sizes on the camera’s
sensor in relation to the sensor area. Should scenarios demand a deviation from the
default values one may adjust this parameter (e.g. markers with high diameter in close
proximity to the cameras requires an increase, while a strong decrease would exclude
even the detection of standard sized markers at typical distances).

minimum diameter of markers Similar to the maximum observed marker size one can
also exclude detections below a certain threshold. The minimum diameter is set to 1 pixel,
by default. Should scenarios demand a deviation from this typical value one may adjust
this parameter by increasing.

i Depending on the camera type there may be only one marker detection
algorithm available, which is automatically used as default.

Z The maximum tracking distance is limited when increasing the mini-
mum diameter of markers.

8.3.2 Individual camera tabs

Each camera can also be accessed by its individual tab within this dialog (see figure 8.3
on page 82).
In the upper left corner of the tab you will find a depiction of the corresponding camera.
To the right the following information is listed:
Below you can change the following options (please refer to the former paragraphs for
equivalent options):
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Figure 8.3: Camera Settings - Individual Tab

Info Description

Model Shows the type of camera
Serial Shows ART internal serial number of the camera
Version Shows ART internal firmware version of the camera
Focal length Shows the focal length of the camera lens
Connected at Shows the controller the camera is connected to (Cascaded

Systems only)

Table 8.4: Camera Settings - Individual Tab Infos

8.3.2.1 Show Details

Here you can change the settings regarding low-level marker detection for individual cam-
eras (see figure 8.3 on page 82):

82



C
ha

pt
er

8

8.3 Camera Settings

Option Description

flash intensity Change the currently set flash intensity
static reflex suppr. (De-)activates the static reflex suppression for this camera
camera mode Select the camera mode (available modes depend on model)
display upside down Rotate the orientation of the camera monitor in the Monitor

2DOF display by 180◦. ’UD’ is displayed in corresponding
camera monitor.

display intensity Adjust the brightness of the status LEDs (all camera models)
and the LED matrix display (ARTTRACK5 and AT7-80 only)

display mode (De-)activates the LED matrix display (ARTTRACK5 and AT7-
80 only)

ring display intensity Adjust the brightness of the ring indicator LED on AT7-
80 models.

sync group Select the syncgroup (’Channel 1’ - ’Channel 3’ for ART-
TRACK6/M , ARTTRACK5 , ARTTRACK5/C & TRACK-
PACK/E )

modulated flash (De-)activates the synchronisation signal and trigger for active
targets

Table 8.5: Camera Settings - Individual Tab Options

Option Description

marker mode configure the marker detection algorithm
maximum number of markers set maximum number of markers that a camera is al-

lowed to detect simultaneously
maximum diameter of markers set maximum size of a marker that a camera is allowed

to detect (in percentage of the camera’s sensor size)
minimum diameter of markers set minimum size of a marker that a camera is allowed

to detect (in pixel)
marker threshold set the sensitivity of the marker detection algorithm (in

percent) 1

sensor gain set the gain level of the camera’s sensor (as a factor) 1

exposure time set the exposure time of the camera manually (in mi-
croseconds) 1

automatic exposure control set the exposure time of the camera based on the se-
lected flash intensity 1

Default return to default values 1

1 hidden by default for all cameras except AT7-80 . An optional license code is necessary to
unlock these features. Please refer to section 7.2 on page 64 for more information.

Table 8.6: Camera Settings - Show Details Individual Camera Tab

marker threshold The marker threshold adjusts the minimum amount of brightness
necessary for marker detection. In certain environments and scenarios (e.g. outdoors,
sunlight, other factors that cause high intensities coming from stray light) you may im-
prove marker detection and thus tracking quality by increasing the marker threshold and
decreasing the exposure time. Try to adjust both parameters moderately until improve-
ment is reached.
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sensor gain The sensor gain is accessible for AT7-80 only and adjusts the amplification
factor on the cameras’s sensor. Decrease the value to factor 1 to turn off amplification
in certain environments (e.g. outdoors, sunlight, other factors that cause high intensities
coming from stray light). Move the slider up to the middle (i.e. towards factor 5) to in-
crease for sensitivity in long-range measurement scenarios. Avoid very high sensor gain
values (i.e. > factor 7) unless unwanted reflections are reduced to an absolute minimum
beforehand.

exposure time The exposure time adjusts the maximum integration time of the cam-
era’s sensor in microseconds. Improve marker detection and reduce sensitivity to stray
light by reducing the exposure time.

automatic exposure control Tick the checkbox to activate the automatic exposure con-
trol . This couples the maximum integration time of the camera’s sensor to the flash in-
tensity (i.e. the duration of the IR flash of the camera). Hereby the IR flash is used most
effeciently (signal) while minimizing the time unwanted stray light (noise) is collected by
the sensor. This effect is seen best in scenarios where the flash intensitites are below
90%.

i Try to adjust marker threshold , sensor gain and exposure time moder-
ately until improvement is reached.

i
When using passive markers only it is unnecessary to adjust the expo-
sure time manually. Tick the checkbox automatic exposure control and
decrease the flash until markers can still be tracked in good quality in
the Monitor 2DOF . Please refer to chapter 6.3.1 on page 50.

Z
Active markers by ART need a minimum exposure time of at least 30
µs. Do not use automatic exposure control in combination with very
low flash intensities (i.e. < 25).

Z
In general do not adjust the marker threshold , the sensor gain or the
exposure time to extreme values far from default. The tracking quality
may become unreliable and the system may malfunction.

8.3.3 SMARTTRACK2 Camera Settings

This dialog (see figure 8.4 on page 84) offers the possibility to adjust the ’flash intensity ’,
to activate the ’Static reflex suppression’ and the ’modulated flash’.

Figure 8.4: Camera Settings - SMARTTRACK2
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8.4 Synccard Settings

Flash intensity The flash intensity may be changed within an interval from 0 .. 7 by
moving the slider to left and right respectively or using the adjacent field.

i
The flash setting strongly depends on the working area and range. In-
crease the flash intensity until all markers become yellow or green us-
ing the Monitor 2DOF display . Additionally pay attention to the inten-
sity bar on the top right corner of each camera monitor. Please refer to
chapter 6.3.1 on page 50 for instructions.

i
As a rule of thumb: For measurement applications with high accuracy
requirements the markers should be displayed in green with intensities
of min. 4 bars; for VR applications yellow markers with intensities
down to 2 bars are still sufficient.

Keep a distance of min. 20 cm when operating the SMARTTRACK2 ! It
is assigned to the Exempt Group according to IEC62471-1 and there-
fore poses no risk or hazard to the human eye or skin at this distance.

Static reflex suppr. Tick the corresponding checkbox to activate the support of static
reflex suppression. Please refer to the 6.3.2 on page 54 for further information.

Modulated flash The SMARTTRACK can be used with active markers, i.e. markers
consisting of infrared LEDs instead of retro reflective material (please refer to the ART
Hardware Installation Guide→ Markers & Targets). Tick the checkbox modulated flash
to activate the synchronisation signal (i.e. coded IR flash) that triggers active targets.

i
The effective flash intensity is reduced significantly when the modula-
tion is used in combination with low flash intensities. The influence is
negligible at higher flash intensity settings. Simply increase the flash
intensity, if necessary.

i The range of the modulated flash is significantly higher than the effec-
tive tracking distance of the SMARTTRACK2

8.4 Synccard Settings

This dialog shows the model and the serial number of the ART Synccard . Furthermore
you can select the mode of synchronisation (i.e. internal or external source).

The available modes for synchronisation are shown in table 8.7 on page 86.
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Figure 8.5: Synccard Settings

supported Synccard modes field of application

internal generated signal, ... Hz run the controller without exter-
nal synchronisation (available val-
ues dependent on camera model)

external video signal active-stereo projection with an
analogue video sync signal (=VGA)external video signal, for validated shutter glasses 1

external video signal, for validated shutter glasses, divisor 2 12

external TTL signal active-stereo projection with a TTL
sync signal, triggers on rising edgeexternal TTL signal, for validated shutter glasses 1

external TTL signal, for validated shutter glasses, divisor 2 12

external TTL signal both edges 3 see above, triggers on rising AND
falling edgeexternal TTL signal both edges, for validated shutter glasses 13

direct settings advanced custom settings
1 predefined settings that should be used with the shutter glasses listed in table 8.8 on page 87
2 use this mode if the frequency of the external synchronisation signal is 2x higher than the max. frame-

rate of the camera or SMARTTRACK2 (not available for SMARTTRACK3 & SMARTTRACK3/M )
3 available only for Synccard2/3 and SMARTTRACK3 & SMARTTRACK3/M (not available for SMART-

TRACK2 )

Table 8.7: Overview of the supported synccard modes

i
Please refer to the ART Hardware Installation Guide→ Synchronization
→ Synchronization input for more information regarding connection of
hardware components.
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Brand Type

RealD CrystalEyes 1, 2, 3, 5
NuVision APG6000, APG6100
XPand X101, X103 (with NuVision Long-Range Emitter), X104LX
NVidia 3D Vision Pro (RF sync’ed)
Volfoni EDGE (with Volfoni or NuVision LR Emitter)
Virtalis ActiveWorks 500

Table 8.8: Overview of validated shutter glasses

i
The TTL input signal level should be 5 Volt (TTL) and 3 Volt (LVTTL)
respectively with a minimum change of 2.5 Volt and duty cycle between
10% and 70 % regardless of input frequency.

Z The TTL input signal level should show no DC-offset voltage.

8.4.1 Direct Settings

If you select direct settings you may use advanced options for configuring the Sync-
card2/3 or SMARTTRACK3 & SMARTTRACK3/M :

Option Description

source configure the type of synchronisation to be used (see details be-
low)

output 1 configure the type of output synchronisation signal ’none, video,
TTL’

frequency [Hz] enter the tracking frequency manually (max. frequency depen-
dent on camera model and selected camera mode)

divisor for external signal 2 reduce the external synchronisation frequency by a factor 1 - 10
Delay [us] 3 configure the delay between the external synchronisation signal

and exposure for each syncgroup
Active during idle 4 configure the output synchronisation signal to be active when

system is ’idle’ (measurement stopped)
1 output signal ’video’ for Synccard2/3 only (’none’ for SMARTTRACK2 )
2 not available for SMARTTRACK3 & SMARTTRACK3/M
3 Channel 1 for SMARTTRACK2/3/M only
4 available for Synccard2 and SMARTTRACK3 & SMARTTRACK3/M only

Table 8.9: Synccard mode direct settings

source The available options ’internal generated signal ’, ’external video signal ’, ’exter-
nal TTL signal ’ and ’external TTL signal both edges’ are equivalent to the aforementioned
supported synccard modes (see table 8.7 on page 86). Additionally the option ’external
inverted TTL signal ’ is available, which inverts the external synchronisation signal (i.e.
triggers on falling edge).

output The output synchronisation signal can be chosen from ’TTL’ or ’video’ for SMART-
TRACK3 & SMARTTRACK3/M . Please refer to the ART Hardware Installation Guide→
Synchronisation for more information.
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frequency [Hz] The tracking frequency can be set between 10 Hz and the max. frame-
rate of the cameras or SMARTTRACK2/3/M in steps of 1 Hz. The max. frame-rate
depends on the camera model and the selected camera mode. Please refer to the ART
Hardware Installation Guide→ Technical Specifications for more information.

divisor for external signal If the frequency of the external synchronisation source is
higher than the max. frame rate of the cameras or SMARTTRACK2 (not available for
SMARTTRACK3 & SMARTTRACK3/M ), a divisor can be set to reduce the frequency
accordingly. Set the factor from 1 - 10. The max. frame-rate depends on the camera
model and the selected camera mode. Please refer to the ART Hardware Installation
Guide→ Technical Specifications for each camera model.

Delay [us] When working with external synchronisation a time delay can be set be-
tween the external synchronisation signal and the exposure time of all camera syncgroups
(Channel 1 available only for SMARTTRACK2/3/M ). The delay for all syncgroups (Chan-
nel 1 to Channel 3) is measured relative to the time of the external trigger. If necessary
these values can be changed individually. Please also refer to ART Hardware Installa-
tion Guide → Synchronisation for detailed information regarding external synchronisa-
tion.

i
Note: The max. delay is dependent on the camera model and camera
mode. A difference of min. 300 µs between consecutive channels has
to be maintained at all times.
Example: Channel 1: 1200 µs, Channel 2: 1500 µs, Channel 3: 1800 µs

i
Please refer to the ART Hardware Installation Guide→ Synchronization
→ Synchronization input for more information regarding connection of
hardware components.

i
The TTL input signal level should be 5 Volt (TTL) and 3 Volt (LVTTL)
respectively with a minimum change of 2.5 Volt and duty cycle between
10% and 70 % regardless of input frequency.

Z The TTL input signal level should show no DC-offset voltage.

Z
The default values for the different channels (#1: 0 µs, #2 480 µs , #3:
960 µs) are preset for compatibility with active markers by ART . Do not
increase the delays between the channels beyond 480 µs when using
active markers.

Z The ART Controller/M offers synchronization output for ARTTRACK1 –
ARTTRACK3 cameras on syncgroup #1 only !

8.5 Radio Transceiver

Here you can configure the settings of the ART RadioTransceiver2/3 . Additionally you
will get information about all attached interaction devices (e.g. Flystick2/2+/3 ).
The following information is offered:

i The SMARTTRACK2 comes with an integrated radio transceiver. There
is no need to plug in an additional USB Radio Transceiver (RT3)
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Figure 8.6: ART Radio Info Settings

Info Description

Model Shows the model of the transceiver or the device respectively
Serial Shows the serial number of the transceiver or device respec-

tively
Version Shows the firmware version of the transceiver or device re-

spectively
Is present (’yes’): The transceiver is connected, the device is in range
Is free (only for Devices) (’yes’): The device is available for communication and has not

been assigned yet
(’no’): The device is already assigned to a transceiver

Table 8.10: ART RadioTransceiver2/3 info settings

Show details By clicking the button Show details the drop-down menu for selecting the
radio channel of the RadioTransceiver2/3 is shown.

Set channel number By default the RadioTransceiver2/3 is automatically selecting a
radio channel during boot-up, the drop-down menu is preset to (’auto’). You may also
select a specific channel manually. The selected setting is saved persistently.

8.6 Inertial Sensor

This dialog is the center for configuration and calibration of inertial sensors (license for
DTRACK3 necessary!). When using inertial sensors you can additionally select the pulse
generating source for the tracking frequency here. Compatible hybrid targets by ART are
communicating with the DTRACK3 system either via wireless 2.4 GHz ISM radio connec-
tion or wired USB connection.
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8.6.1 Wireless hybrid targets

Wireless hybrid targets are distributed together with an antenna and two wireless transceivers
(’Dongles’) for communication with the inertial sensors as a part of the ART Hybrid Motion
Capture suit. Please also refer to the ART Hardware Installation Guide → Markers &
Targets.

i For SMARTTRACK2 individual hybrid targets are available only.

Z Wireless hybrid targets are not supported for SMARTTRACK3 &
SMARTTRACK3/M .

8.6.1.1 Connecting the wireless transceivers

First connect the USB plugs of the transceivers (’Dongles’) to any free USB port of the
controller using the supplied extension cables. The dongles are activated after rebooting
the controller or SMARTTRACK2 or calling Hardware→ Search hardware.

Z
Note: Use the supplied active (USB 2.0) extension cables (e.g. ’ATEN
UE250’) to connect the transceivers (’Dongles’) to an ART Controller or
ART Controller/M . Otherwise proper function of the transceivers can-
not be guaranteed.

Z Use an externally powered USB-hub (USB 2.0) for connecting the
transceivers (’Dongles’) to the free USB port of the SMARTTRACK2 .

8.6.1.2 Configuring the wireless transceivers

Now within DTRACK3 go to the menu Hardware→ Inertial Sensor and open the Settings
sub-dialog (see figure 8.7 on page 90).

Figure 8.7: Inertial Sensor Settings - Connecting wireless transceivers

Double-check that all attached dongles have been found showing the following Dongle
properties:
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Info Description

Device ID dongle Shows the serial number of the transceiver
Model Shows the type of the transceiver (Dongle USB only)
Firmware Version Shows the firmware version of the transceiver
Currently used radio
channel

Shows the radio channel of the transceiver (default: 35 / 55);
use the drop-down menu to change the radio channel

Table 8.11: ART wireless transceivers (’Dongles’) settings (only available settings are
listed)

At this point only dongles should be listed, otherwise check that all previously added sen-
sors show up together with their corresponding dongle. Please refer to figure 8.10 on
page 94.
Next scan the available radio channels by pressing Scan available channels. After com-
pletion the drop-down menu in the column Channel will show a list of all available channels
for each dongle (see figure 8.8 on page 91). The currently used channel is marked in bold
digits. All channels that are not recommended are greyed out (occupied by other Wi-Fi
devices in range), while all recommended channels are marked green.

Please select an appropriate channel for each dongle now. The selected dongle will
change its channel accordingly and likewise all assigned sensors.

Figure 8.8: Dongle Configuration - Selection of a radio channel

i The default channels for all dongles and sensors are 35 and 55 (out of
80).

Z Do not set both dongles to the same channel or on occupied frequen-
cies from other devices in range..

Z
In case channels are already occupied by other devices in range (e.g.
WLAN) connection problems may occur. ART recommends to scan
for available channels and to select free channels accordingly. A mini-
mum distance of 10 channels is mandatory between dongles and rec-
ommended from occupied channels for optimum connectivity.
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8.6.1.3 Connecting the wireless inertial sensors

This needs to be done initially - in case the sensors are already connected please skip
this step.

All ART pre-calibrated targets are delivered with their corresponding optical target geome-
tries stored inside the inertial sensor. Thus when adding the recognized inertial sensors,
all corresponding target geometries are automatically added to the tab ’standard bodies’
in the menu Body Administration (Shortcut:F8) and the sub-dialog Hybrid Bodies of the
menu Inertial Sensor Settings respectively.

i

ART delivers pre-calibrated wireless targets (not available for SMART-
TRACK3 & SMARTTRACK3/M ) as well as a pre-calibrated hybrid mo-
tion capture suit (not available for SMARTTRACK2/3/M ), i.e. both
the optical target geometry as well as the hybrid body calibration are
stored directly on the sensor. Unless the hybrid targets are disassem-
bled or become damaged, it is sufficient to identify and add all sensors
using the menu Hardware → Inertial Sensor → Add Sensors. There is
no need to (re-)assign the inertial sensors on pre-calibrated targets or
to calibrate the targets manually.

Z
Please ensure that all sensors have been charged or alternatively at-
tach the sensors to the supplied charging hub prior to the following
steps.

Turning on/off wireless inertial sensors Turn on all sensors by pressing their corre-
sponding buttons. The status LED will turn green.
All inertial sensors are turned to stand-by mode after a pre-defined idle time, which cor-
responds to the selected wake-up mode.

via: radio (idle time: 1 min.), i.e. the sensors are switched on as soon as they are
addressed by the SMARTTRACK2 or controller.

via: tapping (idle time: 3 min., older sensors only), i.e. the sensors are switched on by
tapping on the sensors with your fingertip or tapping the sensors on a hard surface
(e.g. table).

via: USB/button (idle time: 10 min.), i.e. the sensors are switched on by pressing the
button on the sensor for 3-4 seconds or by connecting them to the supplied charging
hub.

Z
For optimal battery life, ART recommends to switch all sensors to
wake-up mode "USB/button" when not in use for a longer period of
time.

Adding wireless inertial sensors In the menu Hardware→ Inertial Sensor , press Add
sensor to identify and connect all inertial sensors in range (see figure 8.7 on page 90).
In the upcoming dialog (see figure 8.9 on page 93) you should find the Scan mode being
’USB’. Change the mode to ’default channels’ using the adjacent selection box. In this
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Figure 8.9: Adding wireless inertial sensors

mode DTRACK3 will search for the sensors on the default channels 35 and 55 even if the
current channel of dongles / sensors has been set differently.

In case the dongles / sensor channels have been set manually, please change the scan
mode to ’single’ and select the corresponding channels in the adjacent selection box.

Press Scan and the system will identify all sensors in range running on the specified
channels. Expect 15 inertial sensors for a complete ART Hybrid Motion Capture suit (not
available for SMARTTRACK2/3/M ). Tick the checkboxes of all sensors to be added to
the configuration in the column Accept or add all sensors at once by ticking ’accept all ’.
Then press Apply and exit this dialog.

i

If you cannot remember the current radio channel of your sensors,
you can either choose ’all ’ to scan all channels (from 1 to 80, note:
this takes some time) or identify the sensors via wired connection. To
this end connect all sensors to the controller via a USB charging cable
and select the scan mode ’USB’. All attached sensors will be listed
together with their corresponding channel.

Z
Take care that all inertial sensors are assigned to a radio channel of
one of the dongles; otherwise such a sensor will not be available for
measurement. Also take care that roughly the same number of sensors
are assigned to each dongle.

8.6.1.4 Configuring the wireless inertial sensors

After adding the sensors the dialog Inertial Sensor Settings (see figure 8.10 on 94) now
shows all available dongles and their assigned sensors with the following sensor proper-
ties:

i
The temperature values between single inertial sensors may vary. The
operating temperature is reached as soon as there are no more tem-
perature changes inside the sensors indicated by a green status bar.
This is not dependent on the absolute temperature value.

93



8 Menu Hardware - Hardware configuration

Figure 8.10: Inertial Sensor Settings - Wireless transceivers and sensors added

Info Description

Device ID sensor + wire-
less icon

Shows the serial number of the sensor

Model Shows the type of the sensor (e.g. Colibri Wireless)
Name Shows the target name (pre-calibrated from Hybrid Motion

Capture suit or user-defined)
Firmware Version Shows the firmware version of the sensor
Currently used radio
channel

Shows the radio channel of the sensor (default: 35 / 55); use
the drop-down menu to change the radio channel

Wake-up mode Select the mode to start-up the sensor (radio, tapping,
USB/button); use the drop-down menu to change the wake-
up mode

Battery level Shows the remaining battery power in %
Temperature Shows the sensor temperature (◦C, only after a measurement

has been started)
Current tracking fre-
quency

Shows the currently set tracking frequency (Hz, only after a
measurement has been started)

Calibration status Shows the calibration status of the associated body (not cali-
brated , optical only , fully calibrated)

Delete Deletes the currently selected sensor from the list

Table 8.12: ART wireless inertial sensor settings

Tracking frequency Finally check the maximum tracking frequency the inertial sensors
are operating at (default for wireless sensors: 100 Hz). Use the spinbox in the upper right
corner of the window to select a different value, if necessary.

Selecting the pulse generating source Please refer to chapter 8.6.2.5 on page 102
for further details.
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Z
It is NOT recommended to select a wireless inertial sensor as pulse
generator due to the nature of the connection (i.e. high latencies and
timing jitter). Change the default settings in the sub-dialog Tracking
Frequency only when necessary.

8.6.1.5 Calibration of custom wireless hybrid targets

Custom wireless hybrid targets will show up as ’not calibrated ’ in the column Calibration
under the tab ’standard bodies’ in the menu Body Administration (Shortcut:F8) or in the
sub-dialog Hybrid Bodies of the menu Inertial Sensor Settings. Therefore a multi-step
calibration procedure for each body has to be performed analog to wired hybrid targets.
Please refer to chapter 8.6.2 on page 95.

Z
Reassignment or disassociation of inertial sensors and pre-calibrated
optical targets will render the corresponding bodies useless. There-
fore enter the sub-dialog Inertial Sensor Settings→Hybrid Bodies only
when necessary.

8.6.2 Wired hybrid targets

Within DTRACK3 go to the menu Hardware → Inertial Sensor → Hybrid Bodies (see
figure 8.14 on 98) and activate the desired amount of bodies . Next assign suitable names
by double-clicking the corresponding field Name from row ’1...n’ under selected body .
Now a multi-step calibration procedure for each body has to be performed:

1. A standard optical body calibration needs to be carried out. Alternatively load a
body calibration from a file. Start by pressing the button Calibration. Please refer to
9.5.1 on 133 for more details.

2. An inertial sensor has to be added and then assigned to an optical target. Please
refer to chapters 8.6.2.1 on page 96 and 8.6.2.2 on page 98 respectively for further
information.

3. A hybrid body calibration has to be performed to align the inertial sensor with its
corresponding optical target by pressing the button Hybrid Body Calibration. Dur-
ing this hand-eye calibration process the relative orientation of the two coordinate
systems is determined. Please refer to chapter 8.6.2.3 on page 99.

4. An inertial sensor calibration needs to be applied to compensate drift from the iner-
tial sensor. Start by pressing the button Inertial Sensor Calibration. Please refer to
chapter 8.6.2.4 on page 101.

Repeat all steps for each hybrid target and finally set the pulse generating source that
drives the tracking frequency according to your application’s requirements. Please refer
to chapter 8.6.2.5 on page 102.

i
Wired hybrid targets for use with e.g. HMDs are NOT delivered pre-
calibrated due to the fact that mechanical changes during assembly on
top of the customer’s gear would render any pre-calibration useless.
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8.6.2.1 Connecting the wired inertial sensor

This needs to be done initially - in case the sensor is already available please skip this
step.
Go to the menu Hardware→ Inertial Sensor and open the Settings sub-dialog (see figure
8.11 on page 96).

Figure 8.11: Inertial Sensor Settings - No wired inertial sensor connected

Z
Never attempt to connect 3-Space wired sensors / hybrid targets to a
personal computer or try to access the sensor using software provided
by the original manufacturer Yost Labs. This may result in irreversible
damage to the sensor.

Z
Use an externally powered USB-hub (USB 2.0) for connecting the wires
sensor / hybrid target to the free USB port of the SMARTTRACK2/3/M .
Otherwise proper function of the sensor cannot be guaranteed.

Adding wired inertial sensor Please ensure that the sensor has been connected to
the controller. Then press the button Add sensor .

In the upcoming dialog (see figure 8.12 on page 97) you should find the Scan mode being
’USB’.
Press Scan and the system will identify all attached sensors. Tick the checkbox of the
sensors to be added to the configuration in the column Accept or add all sensors by tick-
ing ’accept all ’. Then press Apply and exit this dialog.

The dialog Inertial Sensor Settings (see figure 8.13 on page 97) now shows all available
sensors with the following properties:

Tracking frequency Finally check the tracking frequency the inertial sensors are oper-
ating at (default for wired sensors: 700 Hz). Use the spinbox in the upper right corner of
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Figure 8.12: Adding wired inertial sensor

Figure 8.13: Inertial Sensor Settings - Wired inertial sensor added

Info Description

Device ID sensor Shows the serial number of the sensor
Model Shows the type of the sensor (e.g. 3-Space wired)
Name Shows the target name (empty unless user-defined)
Firmware Version Shows the firmware version of the sensor
Currently used radio
channel

Shows the currently used channel (USB only)

Wake-up mode N/A for wired sensors
Battery level N/A for wired sensors
Temperature Shows the sensor temperature (◦C, only after a measurement

has been started)
Current tracking fre-
quency

Shows the currently set tracking frequency (Hz, only after a
measurement has been started)

Calibration status Shows the calibration status of the associated body (not cali-
brated , optical only , fully calibrated)

Delete Deletes the currently selected sensor from the list

Table 8.13: ART wired inertial sensor settings
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the window to select a different value, if necessary.

8.6.2.2 Assigning the wired inertial sensor

After adding the inertial sensor it needs to be assigned to an optical target, which has
been calibrated beforehand. Change to the sub-dialog Hybrid bodies inside the dialog
Inertial Sensor Settings (see figure 8.14 on 98).

Figure 8.14: Inertial Sensor Settings - Hybrid Bodies sub-dialog

In order to assign an inertial sensor to a optical target follow these steps:

1. mark the respective Body ID under selected bodies by left-clicking

2. mark the appropriate entry ’Device ID’ under available inertial sensors by left-clicking
and

3. press Select .

You can always delete the assignment by pressing the button Deselect . The inertial sen-
sor will be available again for assignment.

After assignment the corresponding body is shown on the left side of the window with the
following properties (see figure 8.14 on 98):

i
In order to identify the inertial sensor and to assign it to the corre-
sponding Body ID please double-check the serial number on top of the
sensor and compare it to the entry in column Device ID.

i If the inertial sensor is already in use a green tick is shown in the col-
umn Used on the right side of the window.

i For each uncalibrated body the ’Name’ entry will be empty, while the
column Cal. will show a No Entry sign.

98



C
ha

pt
er

8

8.6 Inertial Sensor

selected bodies Description

Body ID Shows the body ID number of the hybrid target
Name Shows the target name (empty unless user-defined)
Model Shows the type of the assigned inertial sensor (e.g. 3-Space

wired)
Device ID Shows the device ID of the assigned inertial sensor
Calibration status Shows the calibration status of the associated body (not cali-

brated , optical only , fully calibrated)
Filter Status Shows the currently selected 6DoF tracking filter algorithm

(please refer to chapter 9.4.6 on page 129)

available inertial sen-
sors

Description

Device ID Shows the device ID of the connected inertial sensor
Model Shows the type of the connected inertial sensor (e.g. 3-Space

wired)
Assignment status Shows the assignment status of the connected inertial sensor

body (not used , used)

Table 8.14: Inertial Sensor Settings - Hybrid Bodies sub-dialog

i
Body IDs without corresponding hybrid body calibration are marked
with a yellow tick on the corresponding Body ID row in the column
Cal..

i A fully calibrated Body ID is marked with a green tick.

8.6.2.3 Hybrid Body Calibration

After assigning an inertial sensor , select the respective Body ID under selected bodies
and press the button Hybrid Body Calibration (see figure 8.14 on 98).

Figure 8.15: Hybrid Body Calibration

In the appearing window (see figure 8.15 on page 99) verify the target by its corresponding
’name’ and ’bodyID’ from the adjacent drop-down menu. Also double-check the ’Device
ID’ of the inertial sensor for correspondence with the selected optical target. Then press
Calibrate.
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During the following calibration process the target has to be tilted with moderate speed
around all axes of the inertial sensor (please refer to the animation in the dialog see fig-
ure 8.15 on page 99). After the countdown disappears the upcoming dialog will show the
status of the calibration via a progress bar (see figure 8.16 on page 100.)

Figure 8.16: Hybrid Body Calibration - Progress Bar

In the upcoming result window (see figure 8.17 on page 100) the residual of the calibra-
tion and the sensor delay of the inertial tracking data is displayed.

You can accept the calibration by pressing OK to return to the Hybrid Body Calibration.
Press Exit to return to the Hybrid Bodies sub-dialog. Now, the sensor should show a
green tick in the column Calibration under selected bodies on the left side of the window.

Figure 8.17: Hybrid Body Calibration Result

i
The residual specifies how well the rotational data from the inertial
sensor matches the optical tracking data. Thus it is a measure of the
accuracy of the hybrid body calibration. Values up to 1◦ are ideal, while
anything less than 3◦ is still acceptable.
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i
The sensor delay specifies the latency of the inertial data compared to
real-time. This is sensor specific and dependent on the type of con-
nection (wired / wireless). Values up to 5 ms are ideal for HMD applica-
tions.

Show details You can display the result of the hybrid body calibration as a rotation
matrix by pressing the button Show details.

8.6.2.4 Inertial Sensor Calibration

After successful calibration of all hybrid bodies , a drift correction for all inertial sensors
should be measured and applied. To this end, all sensors have to be warmed-up before-
hand. Please refer to chapter 8.6.2.4 on page 102 for more details.
To start the inertial sensor calibration, go to Inertial Sensor Settings → Hybrid bodies →
Inertial Sensor Calibration (see figure 8.14 on 98). The upcoming window shows a list
of all available hybrid targets, i.e. bodies with successful optical calibration and assigned
inertial sensor (see figure 8.18 on page 101).

Figure 8.18: Inertial Sensor Calibration

Put the respective sensor (or all at once) inside the tracking volume on a level surface, pro-
vided a successful Hybrid Body Calibration for each inertial sensor has been performed
beforehand. Tick the checkboxes in the column Calibrate of all sensors to be calibrated
and press Calibrate. Do not move or touch the sensor(s) during the following calibration!
In the upcoming result window (see figure 8.19 on page 102 the residual of the drift cor-
rection is displayed.
When the calibration is done, you can apply the drift correction either to a single sensor
by ticking the appropriate checkbox in the column Accept or by ticking ’accept all ’ for all
sensors in range. Press Apply and exit the dialog. A list of all successfully calibrated
sensors appears (see figure 8.20 on page 102. Press Exit to return to the Inertial Sensor
Calibration window. Return to the Inertial Sensor Settings → Hybrid Bodies subdialog by
pressing Exit once again.

i
The residual specifies the drift correction for the inertial sensor. Values
below 0.1 ◦ are ideal, while still being acceptable up to 0.2 ◦ . Higher
values indicate possible movement during the calibration.

i After the Inertial Sensor Calibration has been performed and applied
its result is stored directly on the sensor for future use.
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Figure 8.19: Inertial Sensor Calibration - Result Window

Figure 8.20: Inertial Sensor Calibration - Result Window Successful

Warm-up of inertial sensors To start up the procedure simply press the button Warmup
start in the dialog Inertial Sensor Settings (see figure 8.13 on page 97) or in the toolbar
of DTRACK3 frontend (refer to chapter 6.2 on page 48) and leave the process running for
about 5-10 minutes. The progress bar will stop at 100% (progress bar turns green) even
though the warming up of the sensors continues. This shall guarantee that the sensors
work continuously and do not cool down until the calibration takes place.

Z Please ensure that all sensors have been charged prior to any calibra-
tion process.

Z
Please perform inertial sensor calibrations with warmed-up sensors
at constant ambient temperature prior and during the calibration for
optimum tracking performance.

8.6.2.5 Selecting the pulse generating source

There are several independent pulse generating sources available in a hybrid tracking
setup (i.e. combined optical & inertial tracking). Therefore it is necessary to select the
appropriate one that drives the tracking frequency.
You can switch between the following sources by ticking the corresponding radio button in
the subdialog Inertial Sensor Setting → Tracking frequency :

• ’as ART cameras’: The SMARTTRACK2/3/M or the controller’s Synccard is used.
The tracking frequency is set according to the Synccard Settings menu. Please refer
to the corresponding chapters 8.4 on page 85.
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Figure 8.21: Inertial Sensors Settings - Tracking Frequency

• ’as inertial sensor ’: An inertial sensor is used (only available, if attached). When
using multiple inertial sensors use the adjacent drop-down menu to select the ap-
propriate one. The tracking frequency is set according to the Inertial Sensor Settings
menu. Please refer to the corresponding chapter 8.6.2.1 on page 96.

• ’custom frequency ’: An internal source is used providing a custom frequency. Use
the adjacent spinbox in a range from 10 to 1000 Hz (up to 400 Hz with SMART-
TRACK2/3/M ).

i
Selecting a custom frequency higher than the tracking frequency pro-
vided by the inertial sensors (e.g. 700 Hz for 3-Space wired inertial
sensors) could lead to minor tracking quality.

Z
Keep in mind that ’send data divisor ’ in menu Output Settings is also
affecting the resulting data output frequency. Please refer to chapter
9.11 on page 165 for further information.

Z
It is NOT recommended to select a wireless inertial sensor as pulse
generator due to the nature of the connection (i.e. high latencies and
timing jitter). Therefore enter the sub-dialog Tracking Frequency only
if necessary.

8.7 Network

On the Network window you may change the network specific settings and check the
CPU temperatures inside the controller.

DHCP According to your network guidelines it may be necessary to specify hostname
and the domain. Furthermore you can configure the settings for DHCP support.
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Figure 8.22: Network Settings

When the checkbox DHCP client is ticked the controller may be connected to a LAN
with DHCP support. The controller then works as a DHCP client. The corresponding
IP address, subnet mask , gateway and nameserver which have been assigned to the
controller by the DHCP server are shown for your information. The MAC address of the
controller is printed in the field ethernet-MAC LAN.

i
If the network cable is unplugged or the DHCP support is unavail-
able while booting the controller uses its default IP address (i.e.
192.168.0.1).

Static IP Address By unticking the checkbox DHCP client you may specify a static IP
address, subnet mask by entering the settings in the appropriate fields. Optionally, enter
gateway and nameserver . Accept the changes pressing OK and exit the dialog. Reboot
the controller for the changes to take effect.

Z
Please avoid IP addresses 172.28.X.X and IP addresses in the range
from 172.29.0.1 to 172.29.0.20, as they are used for internal communi-
cation!

Z
Please note that these settings are not part of your personal configura-
tion. Changes in this menu will affect all users of your controller! Your
controller may become unreachable with wrong IP settings! Refer to
chapter 5.3 on page 40.
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8.8 Time

CPU temperature At the bottom of this dialog you can read the CPU temperature inside
the controller. The upper value shows the current temperature in ◦C, while the lower value
indicates the temperature maximum since power-on, i.e. the highest temperature reached
since the controller has been started. When reaching elevated or critical levels, the values
are highlighted in orange or red color.

8.8 Time

In the Time window you can set the controller’s internal clock as well as synchronize it
with a master clock (i.e. a reference time source) using NTP (= Network Time Protocol) or
PTP (= Precision Time Protocol). The supported versions are NTP Version 3 (RFC 1305)
and PTP IEEE 1588-2008.
Both protocols are designed to synchronize system clocks among a set of distributed
time servers and clients. While NTP is widely used in essentially all general purpose
computers to synchronize computer clocks in and over the Internet, PTP addresses the
increasingly stringent clock synchronization requirements of spatially localized systems,
such as measurement and control systems. Therefore PTP is designed for accuracies
beyond those attainable using NTP with PTP devices achieving sub-microsecond accu-
racy.

Figure 8.23: Time Settings

The currently set time of the controller is displayed on top of the dialog.

Off The Off can be selected to manually set the local time using the entry fields [hh:mm:ss].
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NTP In order to activate the NTP synchronisation , select the radio button NTP and enter
a hostname or IP address of your NTP server. Please ask your system administrator for
further information. Click Apply to activate the synchronisation.
While the controller is being synchronised the message ’wait ’ is displayed next to the
’state’ at the bottom of the dialog. As soon as the connection has been established,
the ’state’ will switch to ’sync’. Additionally the quality for the connection to the NTP
server is measured by its ’reachability ’. The values can range from 0% to 100 %, with
higher values indicating good connection quality. Furthermore the quality of the time
synchronisation of the master clock and the controller’s internal clock is indicated by the
’estimitated precision’ in the unit milliseconds (m̄s).
In case the connection to the NTP server is lost the ’state’ will switch to ’wait ’ again.

PTP multicast For synchronisation with a PTP multicast master server select the radio
button PTP multicast and enter the respective domain setting. Please ask your system
administrator for further information. Click Apply to activate the synchronisation.
While the controller is being synchronised the message ’wait ’ is displayed next to the ’port
state’ at the bottom of the dialog. As soon as the connection has been established, the
’Port state’ will switch to ’sync’ and the IP address of the master server is shown next
to ’master ’. Additionally the quality for the connection to the PTP server is measured
by ’master offset ’ and ’mean path delay ’ with lower values indicating a better connection
quality.
In case the connection to the PTP server is lost the ’port state’ will switch to ’wait ’ again.

PTP unicast For synchronisation with a PTP unicast master server select the radio
button PTP unicast , enter the IP address of your PTP server and the respective domain
number setting. Please ask your system administrator for further information. Click Apply
to activate the synchronisation.
While the controller is being synchronised the message ’wait ’ is displayed next to the ’port
state’ at the bottom of the dialog. As soon as the connection has been established, the
’Port state’ will switch to ’sync’. Additionally the quality for the connection to the PTP
server is measured by ’master offset ’ and ’mean path delay ’ with lower values indicating
a better connection quality.
In case the connection to the PTP server is lost the ’port state’ will switch to ’wait ’ again.

i NTP is fully supported with Version 3 (RFC 1305), PTP is supported
according to IEEE 1588-2008.

i
Synchronisation with NTP or PTP servers does not affect active mea-
surements, but the timestamps of the tracking results are changed ac-
cordingly.

i
Synchronisation with NTP or PTP servers usually succeeds quite fast
(at least in a few seconds). Nevertheless it could be reasonable to give
the system some time for complete synchronisation.

Z
It is highly recommended to synchronize with a local NTP or PTP mas-
ter clock rather than to a remote time server on the Internet. Otherwise
due to network latency and jitter the accuracy of the controller’s clock
may be degraded too far in order to generate useful timestamps.
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9 Menu Tracking - Tracking
Configuration

Calibration Shortcut

Room calibration F5
Room adjustment Shift + F5
Single markers
Body administration F8
Body calibration F6
Body adjustment Shift + F6
Flystick
Fingertracking (not available for SMART-

TRACK2/3/M )
Measurement Tool
Measurement Tool tip calibration
Output F9

Table 9.1: Menu Tracking

9.1 Room Calibration

Use the room calibration dialog (see figure 9.1 on page 108) to start the calibration pro-
cess and set parameters therefore. After opening the dialog, the Monitor 2DOF display is
automatically started in the background. It is possible to transfer a room calibration from
one configuration to another (refer to section 9.1.7 on page 113).

Z
It is recommended to perform a room (re-)calibration on a regular basis
(e.g. after a certain operating time of the system) and especially if the
system was subject to extreme vibrations or changing environmental
conditions (.e.g. high or low temperatures).

9.1.1 Pre-defined room calibration sets

In the Room calibration dialog you can choose from a series of predefined calibrations
sets (i.e. a pair of ’calibration angle’ and ’wand ’ representing the common ART Room
Calibration Sets, see table 9.2 on page 108).
Select the calibration set that has been delivered with your tracking system using the
dropdown-menu marker distances. Verify the wand length or enter it manually in the cor-
responding field wand length, see figure 9.1 on page 108. The wand length is printed on
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Figure 9.1: Room calibration - using calibration set RCS410

Calibration Set wand length [mm] marker dia. [mm] height [mm] (see Fig. 9.2)

RCS TP (discontinued) 410.0 20 55
RCS 150 (special order) 184.0 16 15.6
RCS 150 active (special order) 204.63 N/A 15.5
RCS 410 flat 410.0 20 15.5
RCS 410 high (discontinued) 410.0 20 43
RCS 710 710.0 20 43
RCS 720 (special order) 720.0 30 48

Table 9.2: Overview of the ART Room Calibration Sets (RCS)

the ’wand ’ .
Place the ’calibration angle’ inside the tracking volume of your cameras, double-check
that all markers of the ’calibration angle’ are seen by the cameras. Start the calibration by
pressing Calibrate. The room calibration is started with a five seconds delay.

9.1.1.1 Expert settings

Marker distances of the ’calibration angle’ can also be set manually using the setting
marker distances → expert . The numbering of the markers is as seen in figure 9.2 on
page 109.

Type longer arm shorter arm

’normal ’ +X axis +Y axis
’powerwall ’ +X axis -Z axis
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9.1 Room Calibration

(a) type ’normal’ (b) type ’powerwall’

Figure 9.2: Marker distances (including numbering) on the ’calibration angle’ and defini-
tion of room coordinate system

i
The longer arm of the ’calibration angle’ defines the X axis (refer to
figure 9.2 on page 109); the shorter one defines the Y axis. The Z axis
is added in order to give a right-handed coordinate system. The center
of marker #1 defines the origin of the room coordinate system (at a
height of see table 9.2 on page 108).

Z
Incorrect input data for this dialog will lead to a poor room calibration,
to wrong system scaling, or to an abort of the whole room calibration
process.

9.1.2 Coordinate System

With the drop-down menu inside the dialog Room calibration you may define how the co-
ordinate system of the room is created relative to the ’calibration angle’ (refer to table 9.3
on page 109).
Select either ’normal ’ or ’powerwall ’, see figure 9.1 on page 108.

Normal Powerwall

Normal : The angle defines the
X/Y plane (X at the longer, Y at
the shorter arm) and Z axis is

added upwards.

Powerwall : The angle defines
the X/Z plane, the Y axis is
added upwards. The Z axis

points out of the screen. This is
the standard screen coordinate
system for many VR systems
(e.g. OpenGL, TrackD, etc.).

Table 9.3: Defining the coordinate system for the room calibration
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9.1.3 Room Calibration Progress

When the room calibration process starts a window showing the progress appears (see
figure 9.3(a) on page 110). The progress is shown individually for each camera which is
especially helpful for big systems. As soon as enough data for calculation of the camera
position has been collected for a specific camera the corresponding progress bar changes
its colour to green (see 9.3(b) on 110).

(a) shortly after start (b) towards the finish

Figure 9.3: Room calibration progress

i
Note: The progress is also displayed individually on the 2-digit LED
matrix display of each ARTTRACK5 camera. After collection of suffi-
cient data the LED matrix display changes back to its defined setting.
Please refer to chapter 8.3 on page 76 for detailed information.

Z
The point cloud should fill at least two thirds of the measurement vol-
ume. Moving the ’wand ’ in a restricted volume will results in reduced
accuracy of calibration or failure.

9.1.4 Room Calibration Results

After a successful room calibration, the Room Calibration Result window is displayed.
This window shows measures to estimate the quality of room calibration (refer to table
9.4 on page 111.

The room calibration is confirmed (i.e., the data are stored) by pressing the button OK .

i Try to achieve a low ’wand residual ’ up to 1 mm for VR installations
while having high values for ’Used Frames’.

i
The parameters ’Residual’ for each camera and the ’wand range’ de-
pend on the system geometry and give additional information about
the quality of calibration. Please call ART for further information.

110



C
ha

pt
er

9

9.1 Room Calibration

Figure 9.4: Room calibration result

indicator Description

Residual mean residual of single cameras (i.e. optical rays during
marker detection)

Used Frames represents the percentage of valid data for each camera (i.e.
used for room calibration)

wand residual mean deviation of ’wand length’
wand range max. deviation of ’wand length’

Table 9.4: Room Calibration Result - Description of quality measures

Z The number of ’Used Frames’ should be greater than 70% for each
camera. Values under 50% indicate poor room calibration quality.

Z Please note that percentages of more than 70% may not be reached in
large and complex measurement volumes.

9.1.5 Room re-calibration

All camera setups (including SMARTTRACK2/3/M ) may change after a certain operation
time ; if e.g. movement of single cameras due to mechanical instabilities cannot be ruled
out or thermal drifts occur it is necessary to perform room calibrations periodically.

DTRACK3 provides a simplified process to revise an existing room calibration without
need of an ’calibration angle’, called Room re-calibration.
The ’calibration angle’ does not have to be present in the measurement volume; only the
’wand ’ has to be moved the same way as for a standard room calibration. The main ad-
vantage of a room re-calibration is that DTRACK3 preserves the origin and orientation of
your coordinate system.
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To re-calibrate your room tick the checkbox re-calibration in the bottom left corner of the
room calibration dialog (see figure 9.5 on page 112). The settings marker distances and
coordinate system are disabled / greyed out and thus are not allowed to be changed in
comparison to the last valid standard room calibration. Settings regarding the ’wand ’ may
be modified, however.

In case camera positions have changed since the last valid room calibration you have to
mark them as ’moved ’ by unticking the corresponding checkboxes in select static cam-
eras (see figure 9.5 on page 112). Start the calibration by pressing Calibrate. The room
calibration is started with a five seconds delay.

Figure 9.5: Room re-calibration dialog

Z
Re-calibration is possible as long as camera movements are not too
large. It will fail e.g. if the mounting of cameras has been changed
completely.

Z
The checkbox re-calibration is enabled only for coordinate system
→ ’normal ’ or ’powerwall’. Select coordinate system → middle of
cameras to retain the default orientation and position of the SMART-
TRACK2/3/M automatically.
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9.1 Room Calibration

9.1.6 Show Details

i The button Show details offers information about the date of the latest
room calibration.

Duration You may adjust the ’duration’ of the room calibration (→ Show details) in a
range of 10s - 120s. Reset the value to default by pressing the Set to default button
(default = 30s).

Z
Changing the duration of the room calibration towards shorter dura-
tions may lead to bad room calibration results! Please make sure that
you are able to cover two thirds of the tracking volume within the set
time.

9.1.7 Transfer of room calibration data

In case different configurations need to share the same room calibration data, one can
transfer the parameters from the currently running configuration to selected others. Press
the button Transfer to open the Transfer room calibration dialog (see figure 9.6 on page
113). Select the configuration(s) you would like to apply the current room calibration data
and press Apply .

Figure 9.6: Transfer Room Calibration dialog

Accept the transfer by pressing OK or discard the changes by pressing Cancel (see fig-
ure 9.7(a) on page 114).

A status message will appear after the successful transfer (see figure 9.7(b) on page 114).
Leave the Transfer room calibration dialog by pressing Exit .

i Room calibration data can only be transferred to an unlocked configu-
ration.

Z
Any previously acquired room calibration stored in another configu-
ration will be overwritten during transfer. This process cannot be re-
verted !
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(a) Accept the Transfer (b) Transfer Successful

Figure 9.7: Transfer Room Calibration - sub-dialogs

9.1.8 Room Calibration - SMARTTRACK2/3/M

By default, the origin of the coordinate system lies approximately in the center between
the two cameras . The orientation of the coordinate system is as shown in the Room
calibration dialog (see figure 9.8 on page 114). If the default orientation and position of
the coordinate system is not adequate for your application please choose the appropriate
coordinate system (i.e. normal or powerwall and perform a new room calibration using
the provided room calibration set (see table 9.2 on page 108). Please refer to section 9.1
on page 107 for detailed information.

To retain the default orientation and position of the coordinate system of the SMART-
TRACK2/3/M (e.g. regular re-calibrations) select the coordinate system → middle of
cameras using the drop-down menu.
The ’calibration angle’ does not have to be present in the measurement volume; only the
’wand ’ has to be moved the same way as for a standard room calibration. Please refer to
section 9.1.5 on page 111.

Figure 9.8: Room calibration settings - SMARTTRACK2/3/M

i The SMARTTRACK2/3/M are pre-calibrated, you can start tracking with-
out performing a room calibration.

114



C
ha

pt
er

9

9.2 Room adjustment

9.2 Room adjustment

During a room calibration the marker located in the intersection of the two arms on the
’calibration angle’ defines the origin of the coordinate system (Marker #1), see figure 9.2
on page 109. Oftentimes it might be more suitable to set the origin in respect to a well-
known point in space. Use the room adjustment functionality to alter the room coordinate
system after calibration.

Possible scenarios for the application of the Room adjustment functionality are:

• adjust the origin to the center of a screen,

• align the coordinate system colinear / parallel to a screen (Note: even very small
angular deviations might lead to substantial misalignment across the full width of
the projection typically 0.1◦ on 5m length equals 8.7 mm deviation)

• shift and / or rotate the camera coordinate system to match a reference coordinate
system, e.g. from CAD models

• maintaining a specific coordinate system / orientation when using mobile installa-
tions of cameras, i.e. frequently changing the camera setup locations (suitable ref-
erence points provided)

In all these cases the coordinate system must be altered after calibration.

9.2.1 Room adjustment - Coarse

Open the Room adjustment dialog where the Coarse tab offers a simple way to manip-
ulate the orientation of the room coordinate system with just one click (see figure 9.9 on
page 116. On the left hand side of the dialog the current camera coordinates calculated
from the room calibration process are displayed. On the right hand side you can define
the orientation of two axes using the drop-down menus Assign axes to room directions -
the third one will be oriented automatically according to the right-hand rule.

Press Enter or click OK to confirm all changes (i.e. changes are sent to the controller) and
the dialog closes. Press Apply to accept the current changes but the dialog is left open.
Discard all changes by pressing Cancel . Press Reset to switch back to the unmodified
state.

9.2.2 Room adjustment - Fine

More detailed options to adjust the room coordinate system are given in the Fine tab (see
figure 9.10(a) on page 117). By default a cartesian coordinate system is displayed on the
left side of the window. On the right side of the window the room coordinate system may
be customized freely, i.e. user-specific.
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Figure 9.9: Room adjustment dialog (coarse)

9.2.2.1 Graphical display

The room coordinate system is shown as a triplet of arrows with a defined color-coding
(x-axis - red, y-axis - green, z-axis - blue), while the xy-plane is shown as a yellow grid.
The current and the transformed room coordinate systems are marked with (’O’) and (’T ’)
respectively.

The viewing position and orientation may be changed in two different ways:

1. hold down the "Ctrl" key and the left / right mouse button to change the position /
orientation inside the graphical display

2. use the six control dials View position and View orientation (below the graphical
view) to adjust position and orientation along all axes

To center the current room coordinate system, press Adjust view . To restore the default
view (shift and orientation), press Reset view . The visualisation itself can be changed by
clicking the right mouse button to open a context menu with the following options (refer to
table 9.5 on page 116). (De-)select the appropriate ones by (un-)ticking.

Option Description

’Long axes’ extends the coordinate axes of the body coordinate system by
infinite dashed lines

’Show XY plane’ shows the XY plane (yellow grid)
’Show YZ plane’ shows the YZ plane (cyan grid)
’Show XZ plane’ shows the XZ plane (magenta grid)

Table 9.5: Room Adjustment (Fine) - Graphical display context menu
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9.2 Room adjustment

(a) before Transformation

(b) after Transformation

Figure 9.10: Room adjustment dialog (fine)

9.2.2.2 Manually transforming the coordinate system

Several options for transformation of the coordinate system can be selected (refer to table
9.6 on page 118).

Example All entered transformation values are relative to the original room coordinate
system, i.e. in a standard coordinate system (xy-plane on the ground, z-axis facing up-
wards) the origin is placed 42mm above the ground (due to the height of ’calibration
angle’ + radius of spherical marker). If the new desired origin is to be placed 1 m above
the ground, then the Zero point offset for z is 958mm (1000 mm - 42 mm).
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Action Description

Zero point offset
[mm]

translate the room coordinate system along its axes in steps of
1mm

Reset vector reset the zero point offset to the unmodified state (0.00 mm)
Rotation angles
[deg]

rotate the room coordinate system around its axes (from -180 to
+180 ◦)

Reset angles reset the rotation angles to the unmodified state (0.00 ◦)
Scaling factor enlarge / shrink the room coordinate system uniformly by a factor

of +/-5 percent
Reset scaling reset the scaling factor to the unmodified state (1.0000)
Start start up a module for transforming & matching to a reference co-

ordinate system (DTRACK3 licenses required)

Table 9.6: Room Adjustment (Fine) - Transform actions

9.2.2.3 Adjust to angle tool

In some cases the room coordinate system needs to be transformed to a specific posi-
tion and orientation using the calibration angle as reference. There is no need to use the
wand in this process. Open the dialog Adjust room coordinates to angle tool (see figure
9.11 on page 119) and place the calibration angle inside your tracking volume to define
the new origin and orientation. Please refer to figure 9.2 on page 109.

Double-check that all markers of the ’calibration angle’ are seen by the cameras and start
the calibration process by pressing Calibrate.

A progress bar shows the current status (see figure 9.12(a) on page 119) after which a
result window will be opened (see figure 9.12(b) on page 119).

Press OK to return to the dialog Adjust room coordinates to angle tool . Press OK to
accept or Cancel to discard the changes.
Back in the Fine tab of the Room adjustment dialog (see figure 9.10(b) on page 117)
press Enter or click OK to confirm the resulting transformation and to close the dialog.
Pressing Apply accepts the current changes and leaves the dialog open. Discard all
changes by pressing Cancel .

Z Incorrect selection of the calibration angle will result in failure of cali-
bration.

Z The calculated transformation is applied on both zero point offset as
well as rotation angles in Fine tab.

9.2.2.4 Adjust based on reference points

The purpose of the coordinate transformation is to convert the origin and orientation of the
initial camera coordinate system (indicated with ’O’) into a reference coordinate system
(indicated with ’T ’), e.g. given by a certain object or CAD model. All measurement data
will be transformed with respect to the reference coordinate system (’T ’). Press Start
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9.2 Room adjustment

Figure 9.11: Room adjustment - Adjust room coordinates to angle tool

(a) Progress bar (b) Success Window

Figure 9.12: Adjust room coordinates to angle tool - sub-dialogs

in the Fine tab to open the room matching dialog (see figure 9.13 on page 120). This
functionality depends on licenses (refer to chapter 7.2 on page 64).

i
If the Measurement Tool is not tracked (calibration required) matching
cannot be performed. Use an authorised Measurement Tool by ART for
best results.
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Figure 9.13: Room transform & matching dialog

Z
Deselect any previously assigned Measurement Tool References prior
to matching of the coordinate systems. Otherwise matching results
will be erroneous.

Procedure A three-step process has to be performed:

1. Add measurement data from the reference coordinate system (’T ’) by manually en-
tering the coordinates into the table reference points using the button Add . A mini-
mum of three (3) data points is necessary for calculations.
The current set of reference points can be saved by pressing Save.
Delete single data points by selecting the corresponding row and press Remove.
Alternatively load the coordinates from a text file (ASCII) using the button Load . The
text file must comply to the following format:

1 1.00 20.00 300.00 <CRLF>

2 4.00 50.00 600.00 <CRLF>

3 7.00 80.00 900.00 <CRLF>

# x y z <CRLF>

The import strictly follows the sequence from the ASCII text file. Still in some cases
the data might be ambigous regarding its 3-D orientation. Toggle the tickbox pre-
serve order of points to lock the order in the table reference points.

2. Select a calibrated and tracked Measurement Tool from the drop-down menu and
measure all points (e.g. on the corresponding object) which directly relate to the
reference points (e.g. from a CAD model) defined in step 1.
Each measurement can be started by:
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9.3 Single Markers

• clicking the button Measure

• clicking the start button on the Measurement Tool (if applicable)

• using the start button simulation of the Measurement Tool (refer to 9.9 on page
161)

• clicking a button of an assigned Flystick2/2+/3

3. After having measured all corresponding points the calculation is started automati-
cally and the result of the transformation is displayed in the textbox transformation.
Double-check that all measured data points correspond to the correct reference data
points.
Delete single data points by selecting the corresponding row and press Remove or
delete all data points to start all over by pressing Clear .

The residual error (standard deviation) is a measure of the transformation quality,
i.e. how well the measured data fit the corresponding reference points. It may be
influenced by the quality of data acquisition and by differences in scale of the camera
and reference coordinate systems. Press OK to accept this transformation and to
close the dialog box.

Back in the Fine tab of the Room adjustment dialog (see figure 9.10(b) on page 117)
press Enter or click OK to confirm the resulting transformation and to close the dialog.
Pressing Apply accepts the current changes and leaves the dialog open. Discard all
changes by pressing Cancel .

Z
If automatic matching between reference and measured points fails,
acquire the data points in the exact sequence of the reference data
and tick the checkbox preserve order of points .

Z The calculated transformation is applied on both zero point offset as
well as rotation angles in Fine tab.

9.3 Single Markers

In this dialog you can enable / disable the calculation of 3DOF markers. Here you can
also define the central axis for all 5DOF targets globally.

3DOF single markers By default the calculation of single markers is disabled. By en-
abling ’calculation of 3DOF markers’ the tracking data appears on the right hand side of
the data display (refer to chapter 6.3 on page 50).

Axis 5DOF central Select the axis using the drop-down menu ’axis 5DOF central ’.
Please refer to chapter 9.5.3 on page 135 for details.
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Figure 9.14: Single Marker Settings

9.4 Body administration

This dialog (see figure 9.15 on page 122) is the center for configuration and calibration of
all bodies and interaction devices. (Fingertracking hardware is not available for SMART-
TRACK2/3/M ). The number and types of bodies to be tracked may be configured in here
.
Furthermore you can assign names, delete or reset target calibrations, activate filtering
of 6DOF tracking data or change the order in which the targets appear in the data display
(see chapter 6.3 on page 50) and tracking output (see chapter 9.11 on page 165).

Figure 9.15: Body Administration

In the left table of the dialogue all configured bodies and their corresponding calibration
status and filter are listed, while the table on the right shows the pre-calibrated bodyfiles
(i.e. factory settings) from the Target Library .
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9.4 Body administration

Table 9.7 on page 123 shows a detailed description of all functions inside the dialogue.

Info / Action Description

number of bod-
ies

Increase / Decrease the number of accessible slots (i.e. body IDs, max.
70 ).

bodies active Currently configured and activated slots (max. limit for activation de-
pends on license key)

category Filter the categories of the target library (e.g. Glasses targets, HMD
targets, etc.)

Change order Press the arrows on the left-hand side to re-arrange the target slot. The
data output will change accordingly.

ID All targets are sorted in ascending order (i.e. increasing body ID).
Active Activate / Deactivate a target by ticking. Data of deactivated targets will

not be transmitted in the data stream. The target sequence is unaf-
fected.

Reference Activate / Deactivate the assignment as reference body by ticking.
Name Assign a description or name to the target.
Device ID The device ID of an assigned inertial sensor (hybrid targets only).
Calibration Provides information about the target calibration status.
Filter Activate / Deactivate the filtering of tracking data for each target; filtering

is activated by default. A detailed description of the filtering options can
be found in chapter 9.4.6 on page 129.

Delete Delete the calibration data of a target - effective immediately after con-
firming the query. The target sequence is unaffected.

Reset Reset the calibration to predefined ’Target Library ’ values (only avail-
able after the geometry has been re-calibrated by the user).

Short Name Descriptor of authorized targets by ART stored in the target library.
Name Name or label of authorized targets by ART stored in the target library.
Used Indicator showing the status of assignment of a body calibration from

the target library.

Table 9.7: Body Administration - Detailed description

i Hybrid targets are listed as standard bodies, with additional info about
the model of the inertial sensor and its device ID.

Z
The maximum amount of Standard bodies that can be activated and
tracked simultaneously depends on your license key (e.g. license for
10 bodies = up to 70 accessible slots for configuration of calibrated
bodies, but only 10 slots may be activated at the same time). When
exceeding the limit a warning message and dialog will appear.

The most comfortable way of calibration of a Standard body is making use of the built-in
automatic recognition feature Target Library to identify the body geometry and to load the
corresponding information. The target library contains calibration data for most ART tar-
gets (e.g. HMD clip-on targets, Motion Capture, 3D glasses, etc.). Interaction devices
(e.g. Flystick2/2+/3 or Fingertracking ) are configured and calibrated using the same
procedure. Please refer to chapter 9.4.1 on page 124 for further information.

In certain cases, however, you may find the direct selection and assignment of calibration
files faster and more helpful. Please refer to chapter 9.4.2 on page 126 for this method.
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The third way of configuration and calibration of bodies is the custom body calibration
(see 9.4.3 on page 127). Perform this procedure for custom-built targets and as fall-back
solution when necessary.

9.4.1 Automatic Recognition via Target Library

First choose the corresponding tab on the top to switch between Standard bodies, Fly-
stick , Fingertracking and Measurement Tool respectively. Then select the amount of
bodies to be configured by entering the number of bodies ’1...70 ’ directly or use the nu-
meric updown button. For each body an empty slot is added. The maximum amount of
activated bodies is dependent on your license key. Please refer to chapter 7.2 on page
64 for further information.

Next perform the following the steps:

• turn on targets with active LEDs (e.g. Fingertracking devices)

• place all targets inside the tracking volume and make sure that all markers of the
targets to be identified are visible to at least 2 cameras.

• run the target library identification by pressing Start search. The current status
is shown by a progress bar while the amount of ’found new targets’ is listed (see
bottom right in figure 9.16(a) on page 125).

• the targets may be moved during the search always considering that the cameras
should see each marker of the body.

• the Short Name of the corresponding target will be marked green and a correspond-
ing info dialog will appear (see 9.16(b) on page 125)

• mark the respective body ID from row ’1...70 ’ under number of bodies by left-clicking

• mark the appropriate entry in the target library (e.g. ’Claw Target 13’) by left-clicking
and

• press Select

• repeat the selection for each identified body in your system

The identified body calibration is assigned to the respective slot and activated by default
(Active ticked) in order to transmit its data in the tracking output. The status for ’Name’,
’Calibration’ and ’Filter ’ will be updated as well. The entry in the column Calibration will
turn into a green tick followed by ’TargetLibrary ’. On the right side of the window the cor-
responding entry in column Used will turn into a green tick as well and change to ’yes’.

All targets are sorted in ascending order (i.e. with increasing body ID). You can always
delete the assignment by pressing the button Deselect or Delete in the left table. After
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(a) Progress bar and labelling of identified targets (b) Info dialog after Target Li-
brary recognition

Figure 9.16: Body Administration Target Library - automatic recognition

confirmation to delete the body calibration the geometry will be available again for assign-
ment to a different body ID. You may also re-assign a name, description or label of the
target by double-clicking the field Name or deactivate or change the filtering of tracking
data for each target by pressing Filter . A detailed description of the filtering options can
be found in chapter 9.4.6 on page 129.

In some cases the system will inform you that a re-calibration of the body might be nec-
essary, i.e. to compensate for manufacturing tolerances. Bending and twisting a clip-on
target while mounting on a HMD casing or 3D glasses may also result in the geometries
not matching perfectly to the data inside the target library (see warning figure 9.17 on
page 125).

Figure 9.17: Body Administration Target Library - Specific Re-Calibration Warning

At the bottom of the window (see figure 9.15 on page 122) press Custom Calibration to
switch to the Custom Body Calibration dialog and perform the re-calibration for the se-
lected target (see chapter 9.5.7 on page 140). Simply repeat all steps for each body in
your system where the information was displayed during identification.

i
The entire library is used for target recognition. Use the drop-down
menu category to view specific subsets of the library by changing to a
different category (e.g. Motion Capture).

i
Using the automatic recognition feature DTRACK3 compares the ge-
ometry of the physical target with the calibration data of the target
library. In some cases a re-calibration might be necessary to achieve
optimal tracking accuracy.
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Z
The integrated target library contains most body geometries of
ART hardware. In the unlikely case that a target is not identified au-
tomatically perform a custom body calibration.

9.4.1.1 Identification of Motion Capture targets without Inertial sensors

For this example it is assumed that a setup with at least eight cameras has been cali-
brated properly and that all necessary licenses are present.

First, fit the targets to the test person and make sure that the person is inside the tracking
volume. Then, start the search (Tracking → Body Administration → Start Search) and
allow the test person to move around. While this movement the targets must be visible
for the tracking system. Next all targets should be recognized one after the other and will
appear in the list of ’Found Targets’. Select all found targets one by one and assign them
to open slots. In case you need to adjust the sequence of the targets use the arrow keys
on the left side. Finally, start the measurement in order for your application to receive
tracking data.

9.4.2 Direct Selection via Target Library

In order to quickly add and configure well-known and unmodified targets to your system,
you can directly select and assign the body calibrations from the Target Library . First
choose the corresponding tab on the top to switch between Standard bodies, Flystick ,
Fingertracking and Measurement Tool respectively. Then select the amount of bodies to
be configured by entering the number of bodies ’1...70 ’ directly or use the numeric up-
down button. For each body an empty slot is added. The maximum amount of activated
bodies is dependent on your license key. Please refer to chapter 7.2 on page 64 for fur-
ther information.

Next assign the corresponding body calibration to a selected body ID. All available body
calibrations stored in the Target Library are shown in the table on the right.

Perform the following the steps for assignment:

• mark the respective body ID from row ’1...70 ’ under number of bodies by left-clicking

• select the appropriate category (e.g. Glasses Target) from the drop-down menu
category in the target library

• mark the appropriate entry in the target library (e.g. ’Glasses Target 2’) by left-
clicking and

• press Select

• repeat the selection for each body in your system
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The loaded body geometry is assigned to the respective slot and activated by default
(Active ticked) in order to transmit its data in the tracking output. The status for ’Name’,
’Calibration’ and ’Filter ’ will be updated as well. The entry in the column Calibration will
turn into a green tick followed by ’TargetLibrary ’. On the right side of the window the cor-
responding entry in column Used will turn into a green tick as well and change to ’yes’.

All targets are sorted in ascending order (i.e. with increasing body ID). You can always
delete the assignment by pressing the button Deselect or Delete in the left table. After
confirmation to delete the body calibration the geometry will be available again for assign-
ment to a different body ID. You may also re-assign a name, description or label of the
target by double-clicking the field Name or deactivate or change the filtering of tracking
data for each target by pressing Filter . A detailed description of the filtering options can
be found in chapter 9.4.6 on page 129.

With this method the system will not inform you when a re-calibration of the body might be
necessary, i.e. to compensate for manufacturing tolerances resulting in the geometries
not matching perfectly to the data inside the target library. A generic warning, however,
is shown for targets that may be compromised from bending or twisting such as clip-on
targets mounted on a HMD casing or 3D glasses (see figure 9.18 on page 127.

Figure 9.18: Body Administration Target Library - Generic Re-Calibration Warning

In order to achieve optimal tracking accuracy or in case of tracking problems please per-
form a body re-calibration. To this end press Custom Calibration at the bottom of the
window (see figure 9.15 on page 122) to switch to the Body Calibration dialog and per-
form the re-calibration for the selected target (see chapter 9.5.7 on page 140). Simply
repeat all steps for each body where a generic warning was displayed during assignment.

Z
Using the direct selection and assignment DTRACK3 DOES NOT com-
pare the geometry of the physical target with the calibration data of
the target library. Only generic warnings are shown for targets where
the geometry may be compromised from bending or twisting. Please
perform a re-calibration to achieve optimal tracking accuracy.

9.4.3 Custom Body Calibration

For custom-made or modified targets you can perform a Custom calibration. First choose
the corresponding tab on the top to switch between Standard bodies, Flystick , Finger-
tracking and Measurement Tool respectively. Then select the amount of bodies to be
configured by entering the number of bodies ’1...70 ’ directly or use the numeric updown
button. For each body an empty slot is added. The maximum amount of activated bod-
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ies is dependent on your license key. Please refer to chapter 7.2 on page 64 for further
information.
Next select an available slot in the left table and start the Custom Calibration at the bot-
tom of the window (see figure 9.15 on page 122) to switch to the Custom Body Calibration
dialog. Please refer to the corresponding chapter 9.5 on page 132 for further details.

After successful calibration and closing the Custom Body Calibration dialog the custom
body calibration is assigned to the respective slot and activated by default (Active) in or-
der to transmit its data in the tracking output. The status for ’Calibration’ and Filter will be
updated as well. The entry in the column Calibration will turn into a green tick followed by
’Custom’.

All targets are sorted in ascending order (i.e. with increasing body ID). You can always
delete the body by pressing the button Delete in the left table. You may also assign a
name, description or label of the target by double-clicking the field Name or deactivate or
change the filtering of tracking data for each target by pressing Filter . A detailed descrip-
tion of the filtering options can be found in chapter 9.4.6 on page 129.

Simply repeat all steps for each body in your system.

Z
Do not calibrate the body geometry for HMD clip-on targets manually
! Always use the built-in target library and re-calibrate afterwards to
compensate for mechanical bending or twisting due to mounting. Oth-
erwise the tracking pivot point cannot be determined resulting in poor
immersive experience.

9.4.4 Reference body

Any standard 6DOF body may be assigned as reference upon which all 6DOF and 3DOF
tracking data is calculated relative to this body coordinate system instead of the room
coordinate system. Only one reference can be assigned at a time by ticking the checkbox
in the column Reference of the respective body.

Z
When a reference body has been assigned, all 6DOF bodies and 3DOF
single markers can only be tracked when the reference body is being
tracked as well.

9.4.5 Calibration status

The column Calibration (see table 9.8 on page 129) provides information about the target
calibration status:
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Calibration
Status

Description

not calibrated a customized target has not been calibrated yet
Target Library the predefined calibration file from the system is being used
Target Library,
re-calibrated

the predefined calibration file has been used, but the geometry has
been re-calibrated

Custom a custom body calibration has been performed
Optical an inertial sensor has been disassociated from a fully calibrated hybrid

body (hybrid targets only).
Full a hybrid body calibration has been performed or that predefined calibra-

tion data stored inside the hybrid inertial sensors is being used (hybrid
targets only).

Table 9.8: Body Administration - Description of calibration status

9.4.6 Filtering options for 6DOF tracking data

DTRACK3 incorporates advanced filtering options for enhanced 6DOF tracking perfor-
mance. One can choose between recommended presets or customize filtering options
in order to optimize tracking behaviour individually for each target. For example in ap-
plications where reference targets are used to calculate the position of a seating buck it
is possible to apply a strong filter for these targets which results in practically noise-free
tracking data.
On the contrary tracking (e.g. of HMD units) oftentimes calls for a compensation of sys-
tem intrinsic latencies. Here DTRACK3 is able to deliver tracking data that incorporates
probabilistic prediction up to tens of milliseconds ahead in time.

Access the filtering options for each target either via the menu Body Administration or
directly through the main GUI docking window Data Display . Please refer to table 9.7 on
page 123 and 6.3.3 on page 56 to open the menu Filter Settings.

Z
When using third-party hybrid tracking solutions (e.g. LP Research’s
LPVR-CAD) turn off filtering for the respective HMD target altogether
in order to achieve the best performance and immersive experience.

9.4.6.1 Filter Settings

Filtering of 6DOF tracking data is activated by default. Untick the checkbox ’active’ to
deactivate filtering for the respective target or choose from several recommended presets
shown in the following table:
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Figure 9.19: Filter Settings

Presets optical tracking Description

custom Customizable preset. A detailed description of the parameters
can be found in table 9.10 on page 131.

default Standard filtering without prediction or smoothing.
Flystick Recommended setting for use with Flystick2/2+/3 (responsive

filtering, designed for fast to slow motions).
HMD-1 Recommended setting for tracking of a HMD without hybrid track-

ing (down-tuned filtering with prediction, designed for fast mo-
tions).

medium prediction Filter with prediction of tracking data (less responsive filtering,
designed for slow to medium motion).

reference target Filter with smoothing for tracking of stable reference positions
(strong non-responsive filter, designed for occasionally moving
objects).

smoothing (delayed) Filter with strong smoothing and high averaging (responsive filter-
ing with high latencies, designed for recording of tracking data).

Presets hybrid tracking Description

hybrid custom Customizable preset. A detailed description can be found in table
9.10 on page 131.

hybrid default Standard filtering for hybrid targets without prediction or smooth-
ing (designed for e.g. Hybrid Motion Capture).

hybrid HMD medium prediction Filter for hybrid targets with prediction of tracking data. (designed
for e.g. HMDs)

Table 9.9: Filtering of 6DOF tracking data - Detailed description of the presets

It is also possible to customize the tracking behaviour to the requirements of the applica-
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tion using the following tunable settings:

Settings Description Usage

Strength Sets the strength of the filter. Low
values lead to faster reaction but
higher jitter. High values result in
smoother output but slower reac-
tion. Note: Not available for hybrid
tracking.

A higher strength may be
ideal for tracking seating
bucks

Prediction Predicts output for the specified
time into the future (ms) in order to
compensate tracking and rendering
latency. Note: Too high positive val-
ues can increase jitter and reduce
precision. Negative values can be
used for smoothing the output at the
cost of higher latency.

A negative prediction may
be ideal for recording data
and offline analysis.

Mode optical
tracking

Specifies the elementary behavior
of the filter. Several options are
available:

for optical tracking only

’Adaptive fast ’ Automatically adapts to the ob-
served motion.

Moving targets that
change between fast and
slow motions, such as
Flystick2/2+/3 .

’Adaptive slow ’ Automatically adapts to the ob-
served motion, with stronger filter-
ing of fast motions.

Moving targets with slow
and medium motions

’Fast ’ Optimized for fast motions without
special filtering of slower motions.

Targets where quick reac-
tion is important, such as
HMDs.

’Slow ’ Optimized for medium motions with-
out special filtering of slow motions.

Targets where quick reac-
tion is important, but mo-
tions are slow.

’Static’ Optimized for targets that are
known not to move at all.

Reference targets at-
tached to non-moving
objects

’Reference tar-
get ’

Optimized for generally static ob-
jects, with automatic detection of
occasional motions.

Reference targets at-
tached to occasionally
moving objects.

Mode hybrid
tracking

Specifies the elementary behavior
of the filter. Several options are
available:

for hybrid tracking only

’Hybrid target ’ Optimized for non-HMD hybrid tar-
gets incorporating an inertial sensor
unit.

Hybrid Motion Capture

’Hybrid HMD’ Optimized for HMD hybrid targets
incorporating an inertial sensor unit

HMDs and similar pro-
jective units (e.g. AR
glasses).

Table 9.10: Customizable preset 6DOF filtering - Detailed description of the parameters
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9.5 Custom Body Calibration

The process of teaching a target’s geometry to the tracking system is called body calibra-
tion. For a body calibration, the target (= rigid body) to be calibrated has to be in the field
of view of the IR cameras.

The body may be moved during body calibration always considering that the cameras
should see each marker of the body.

If the body is not moved during body calibration it should be considered that each marker
of the target has to be seen by at least two cameras and generally should be seen by as
many cameras as possible.

The target orientation can be checked using DTRACK3 ’s Monitor 2DOF display , which is
opened automatically in the background after starting the body calibration. The following
figure 9.20 on page 132 shows a rigid body with five markers that are all correctly seen
by the IR camera.

Figure 9.20: Recognized target in DTRACK3 Monitor 2DOF display

Z
Do not calibrate the body geometry for a HMD clip-on targets manually
! Always use the built-in target library and re-calibrate afterwards to
compensate for mechanical bending or twisting due to mounting. Oth-
erwise the tracking pivot point cannot be determined resulting in poor
immersive experience.

Z
If two markers, seen from one camera’s point of view, are merging
to one reflection, body calibration may be affected. These "merging
marker situations" should be avoided during body calibration, i.e. the
target should be oriented in a way that reduces merging markers to a
minimum.
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Z
Ensure the absence of any additional markers in the measurement vol-
ume during body calibration. If additional markers that are not part of
the target are in the field of view of the IR cameras during body calibra-
tion these markers will be assigned to the target. Hence the target will
not be correctly calibrated and therefore tracking problems may occur.

9.5.1 Selecting the body type

Open the dialog Tracking → Body Calibration→ Custom Tab to start a body calibration .

(a) Target type "standard" (b) Target type "5DOF"

(c) Target type "5DOF (cylinder)" (d) Target type "2x 5DOF (cylinder)"

Figure 9.21: Body calibration dialog

First select the target that should be calibrated in the select list Body . By default the type
is set to ’standard ’ which allows for calibrating a 6DOF target with spherical, flat or active
markers. When you are using a 5DOF target or a target made of ring markers you would
select the ’type’ according to the geometry of the target:
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• ’5DOF ’ .. a target made of spherical markers which are aligned along one main
axis. The rotation around that axis cannot be detected by the system - you loose
one dimension of freedom. Therefore only 5 dimensions.

• ’5DOF (cylinder)’ .. a target made of ring markers which are aligned along one main
axis.

• ’2x 5DOF (cylinder)’ .. an L-shaped target made of ring markers which delivers
complete 6DOF data.

Next select the type of body calibration (refer to section 9.5.2 on page 134 then press
Calibrate to start the body calibration with a delay of five seconds.

To re-calibrate a body tick the checkbox re-calibration next to the drop-down menu. For
more information about body re-calibration please refer to chapter 9.5.7 on page 140.

i
After a new room calibration or room re-calibration it is not necessary
to perform a new body calibration. Only if the body itself has been
changed you have to calibrate the body again.

Z
The previous body calibration will be lost if you carry out a new body
calibration. If you want to save the previous body calibration please
use the ’Save file(s)’ option in the Body calibration dialog.

9.5.2 Selecting the coordinate system for 6DOF targets

During body calibration, DTRACK3 defines a local coordinate system (body coordinate
system) for each target .
The type of body calibration can be set as ’due to body ’, ’due to room’ or ’due to room
(zero in marker)’ (see figure 9.22 on page 134. The difference between these types is to
be found in the orientation of the body coordinate system relative to the body itself.

(a) Body calibration
"due to body"

(b) Body calibration
"due to room"

(c) Body calibration
"due to room (zero in
marker)"

Figure 9.22: Defining the target coordinate system

9.5.2.1 Body calibration setting due to body

The body coordinate system is fixed by the markers of the rigid body according to a set
of rules (refer to 9.22 a) on page 134):
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1. Search for the largest distance between two markers of the rigid body. These two
markers (# 1 and # 2) will define the x-axis.

2. Search for a third marker (# 3) with the shortest distance to one of the two markers
# 1 and # 2. The marker that is closest to marker # 3 becomes marker # 1. It will
define the coordinate origin. The other marker will become # 2. The positive X axis
is directed from marker # 1 to marker # 2.

3. Marker # 3 defines the x/y-plane, together with markers # 1 and # 2. Marker # 3 has
a positive Y coordinate.

4. The z-axis is added resulting in a right-handed coordinate system.

9.5.2.2 Body calibration setting due to room

The origin of the body coordinate system is set to the center (center of gravity) of all mark-
ers building the rigid body (refer to 9.22 b) on page 134). The axes of the body coordinate
system are parallel to the axes of the room coordinate system in the beginning of the body
calibration. The result of this type of body calibration will depend on the angular rotation
of the target during calibration.

Without moving the body a 6DOF measurement right after the calibration will give the
angular coordinates 0◦/ 0◦/ 0◦.
If the target was moved during calibration instead DTRACK3 will use the direction of the
target at the beginning of the calibration.

9.5.2.3 Body calibration setting due to room (zero in marker)

This is a combination of the methods ’due to body ’ and ’due to room’ (refer to 9.22 c) on
page 134). The direction of the axes of the body coordinate system will be set parallel
to the room coordinate system in the moment of body calibration - analog to the setting
’due to room’. The origin of the body coordinate system is set to a marker of the body
according to the rules for ’due to body ’.

9.5.3 Selecting the coordinate system for 5DOF targets

In contrast to 6DOF bodies all markers are aligned along one main axis (body axis).

9.5.3.1 Coordinate system setting for type ’5DOF ’ and ’5DOF (cylinder)’

The origin of the body coordinate system is in the middle of the body axis, i.e. between
the two markers with the largest distance to each other (refer to 9.21 b) and c) on page
133). The orientation is defined by the marker with the shortest distance to the origin.
Its position has a negative sign. The other two directions are undetermined due to the
missing degree of freedom. Therefore the rotation around this axis cannot be measured
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by the tracking system.

This is where the ’5DOF central axis’ comes into play. The ’5DOF central axis’ defines
the missing degree of freedom if you intend to use the tracking data for 6DOF scenarios
nonetheless. Effectively the body axis (X, Y or Z) is aligned towards the corresponding
room axis (X, Y or Z), thereby minimizing the angle in between. If a ’5DOF central axis’
is chosen with a negative sign, the body axis (X, Y or Z) is aligned to the opposite room
axis (-X, -Y or -Z) respectively.
Please refer to chapter 9.3 on page 121 to set the central axis in the menu Tracking →
Single Markers.

Setting the 5DOF central axis in a VR setup with head tracking It general it is rec-
ommended to choose the ’5DOF central axis’ by using a direction in your setup which is
perpendicular to the tracked body axis most of the time. For example when using a target
for shutter glasses do not set the ’5DOF central axis’ parallel to the floor or ceiling but
rather use the vertical axis instead.

Z
Note: For orientations of the ’5DOF central axis’ close to the body axis
(i.e. the two axes are driven into a parallel configuration) the rotation
angle for the ’5DOF central axis’ will show strange behaviour, e.g. large
odd-looking changes.

9.5.3.2 Coordinate system setting for type ’2x 5DOF (cylinder)’

The body is expected to consist of two connected 5DOF targets with a roughly perpen-
dicular and constant angle in between (refer to 9.21 d) on page 133). These are placed
on the two axes. The origin is placed at the intersection of the two 5DOF targets. The first
axis is assigned to the 5DOF target which includes the marker with the largest distance
to the origin. The other 5DOF target is placed in the plane created by the two axes.

i
A click-type torque wrench is one the most prominent members of this
class of bodies. Due to the engineering backlash and other high me-
chanical tolerances in these devices often times the resulting body
calibrations are error-prone.

i
Due to the L-shaped geometry in the case of 2x5DOF tracking the data
provided consists of complete 6DOF information. Therefore the data
is not affected by the 5DOF central axis chosen.

9.5.4 Body calibration progress

During the body calibration the current status is shown using a progress bar (see figure
9.23 on 137). Verify that all markers of the target are recognised properly.
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Figure 9.23: Body Calibration Process - Progress bar

9.5.5 Body calibration result

After successfully calibrating a body the result window is displayed (see figure 9.24 on
137).

Figure 9.24: Body Calibration Process - Result Window

All markers of the rigid body that have been recognized during calibration are listed. Con-
firm the result with OK or discard the calibration with Cancel . The information (i.e. ge-
ometry data) of the calibrated target will be stored inside the controller in your personal
configuration (see also section 7.3 on 67).

Z Please double-check the number of markers and compare to the rigid
body that all markers have been recognized properly.

9.5.5.1 Show Details

By clicking Show details additional information can be displayed (see figure 9.25 on page
138:
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(a) Distances between markers (b) Emission vector & aperture
information

(c) Cylinder Information

Figure 9.25: Body calibration Result

• ’Distances’ shows all possible combinations of distances for all markers (min. dis-
tances are important for customer-specific geometries, call ART for further informa-
tion)

• ’Emissions’ shows normalised emission vectors x, y, z and emission aperture for
bodies with restrictions of visibility (only for calibration files available on request by
ART )

• ’Cylinder ’ shows coordinates and radii for bodies with (cylindrical) ring markers

9.5.6 Calibration files

To easily create backups of calibrated bodies, calibration files can be saved and restored
from files. These files contain the dimensions of the target and the distances between all
markers. Each file is specific for just one type of target.
Just click Load file(s) and select the appropriate calibration file(s) or click on Save file(s)
respectively.

9.5.6.1 Save a body calibration file

Press ’Save file(s)’ option in the Body calibration dialog to store the calibration file(s) of
the currently used bodies.
Select the individual bodies by left-clicking or all ot once by pressing select all (see fig-
ure 9.26(a) on page 139). Press Save and in the upcoming window select a folder on
your remote PC for storage (see figure 9.26(b) on page 139). After successful saving a
confirmation window will show up (see figure 9.27 on page 139). Press OK then exit the
dialog.
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(a) Selecting the body file(s) to save (b) Select the folder on the remote PC

Figure 9.26: Saving calibration files

Figure 9.27: Saving calibration files - Confirmation Message

i The format of the file name will be according to "standard b01.txt" with
"b01" being the identifier which refers to the ID of the target.

9.5.6.2 Load a body calibration file

(a) Select the body file(s) to load (b) Confirmation window for multiple files

Figure 9.28: Loading calibration files

You can load calibration file(s) by pressing Load file(s) and choose the calibration file(s)
for your targets. Select the corresponding body body ID and load single calibration files
one after the other by pressing Load (see figure 9.28(a) on page 139).
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Alternatively you can load multiple files simultaneously when the corresponding body cal-
ibration files comply to the DTRACK3 file name convention (i.e. "standard b01.txt" with
"b01" being the identifier which refers to the ID of the target). DTRACK3 automatically
assigns the calibration file to the respective body ID by using the identifier in the file name.
Select multiple files and press Load .

A confirmation window will open, press ’Load ’ again to import of the body calibration files
(see figure 9.28(b) on page 139).

In the upcoming window the coordinates of all identified markers are listed together with
the body’s label as well as the number of markers. It is analog to the body calibration
result window (see figure 9.24 on page 137).

Z Any previous body calibrations will be overwritten when you load cali-
bration files.

i Invalid or corrupt files are not loaded by DTRACK3 . This is indicated
by an error message in the confirmation dialog.

9.5.6.3 Restricted Visibility / Emission Cones

Optionally a restricted visibility can be defined for each marker of a body. This is per-
formed setting up so called ’emission cones’; in essence, a 2DOF observation from a
camera has to be inside this cone so that tracking data can be used later for pose es-
timation. Currently the only way to equip markers with emission cones is to import an
appropriate calibration file which are available on request. These files are created at
ART on site performing a body calibration in a defined environment or measurement vol-
ume respectively.

9.5.7 Body re-calibration

DTRACK3 provides a possibility to re-calibrate a rigid body without losing the body’s co-
ordinate system. This function may be used in case the body geometry is affected due
to e.g. mechanical impact. Tick the checkbox re-calibation and perform a routine body
calibration as described in 9.5 on page 132.

Z
Only during a body re-calibration the origin and orientation of the initial
coordinate system as well as specific information (tracking pivot point,
predefined emission vectors, cylindrical marker info) are preserved.

Z
Re-calibration is possible as long as changes in the body geometry are
not too large (e.g. replacement of markers). It will fail e.g. if the body
has been modified completely.
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9.6 Body adjustment

The Body adjustment function is a tool to visualise and manipulate calibration data of rigid
bodies , i.e. the body coordinate system may be changed relative to the markers of the
body.

i Body adjustment is not available for 5DOF targets or measurement
tools.

The main features of Body adjustment are:

• adjusting the body position and orientation of each target manually,

• use predefined body coordinate systems,

• move and set the origin of the body coordinate system (e.g. into a selected marker
or the center of gravity),

• aligning the axes of body and room coordinate system without changing the origin,

• delete selected markers from the target geometry,

• "live" mode (i.e. the 3D-representation of the target in the ’Graphic view ’ is depicting
movements / rotation of the target in "real time"),

• (optionally) visualise predefined emission cones due to restrictions of visibility (di-
rectional and angular dependence) for all markers

9.6.1 Body Adjustment - Graphic View

Open the menu Tracking → Body Adjustment and select the desired body from the drop-
down list Body at the top of the window (see figure 9.29 on page 142).

By default a cartesian coordinate system is displayed on the left side of the window de-
picting the selected rigid body’s geometry (’Graphic view ’). On the right hand side the
body’s coordinate system can be manipulated.

The body coordinate system is shown as a triplet of arrows with a defined color-coding
(x-axis: red, y-axis: green, z-axis: blue), while the xy-plane is shown as a yellow grid. All
markers are visualised by sequentially colored spheres (RGB) for better identification.

In case the selected rigid body features visibility restrictions (optional), emission cones
may have been predefined. Direction of visibility (emission vector) is depicted as an ar-
row (white) for each marker, while the angular restriction (emission aperture) is shown as
a cone (grey).

The viewing position and orientation may be changed in two different ways:

1. hold down the "Ctrl" key and the left / right mouse button to change the position /
orientation inside the graphical display
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Figure 9.29: Body Adjustment

2. use the six control dials View position and View orientation (below the graphical
view) to adjust position and orientation along all axes

To restore the default view press Reset view .
Press Enter or click OK to accept all changes for all bodies (i.e after confirmation the
changes are sent to the controller) and to close the dialog. Press Apply instead to change
the currently selected body only - the body will be redrawn and the dialog will be left open.

Press Undo to switch back to the unmodified state or Redo to repeat the last action. Dis-
card all changes by pressing Cancel .

Context Menu The visualisation can be changed by clicking the right mouse button
to open a context menu with the following options. (De-)select the appropriate ones by
(un-)ticking.

Live View Tick the use tracked orientation checkbox to switch to live mode. The 3D-
representation of the target in the ’Graphic view ’ will depict movements / rotation of the
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Option Description

’Small markers’ reduces the size of the marker spheres
’Colored markers’ shows the markers in RGB colors (untick: greyish)
’Emissions’ shows emission vectors (arrows) and emission aperture (cones)

(if applicable)
’Long axes’ extends the coordinate axes of the body coordinate system by

infinite dashed lines
’Show COG’ shows the body’s center of gravity (white square)
’Show XY plane’ shows the XY plane (yellow grid)
’Show YZ plane’ shows the YZ plane (cyan grid)
’Show XZ plane’ shows the XZ plane (magenta grid)
’Show room orientation’ shows the room coordinate system (only available when check-

box ’use tracked orientation’ is ticked)
’Add line between markers’ adds a line between two selected markers (option greyed out until

two markers are selected)
’Delete line between markers’ removes a line between two selected markers (option greyed out

until line is selected)
’Data view ’ switches to the data view

Table 9.11: Body Adjustment Graphic View - Context Menu

target in the "real time"). This also enables the function Adjust axes to room (see table
9.12 on page 144 in order to align the body coordinate system collinear to the room
coordinate system.

9.6.2 Changing the body geometry

For manipulating the body geometry you have the choice between General or Special
options:

General The body coordinate system may be customized user-specific (see table 9.12
on page 144):

Special Choose from the following predefined transformations (see table 9.13 on page
144):

i Predefined visibility restrictions (emission vectors and emission aper-
tures) are retained along all body transformations.

Z
If the MultiUser function for Flystick2/2+/3 is enabled the Body Adjust-
ment module will load standard bodies only - a label ’MultiUser func-
tion should be disabled!’ will appear at the bottom of the dialog. To
adjust the body calibration data of your Flystick2/2+/3 , make sure that
the MultiUser function is disabled (Tracking → Flystick ).
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Action Description

Body position [mm] translate the body coordinate system along its axes in steps of 1mm
Body orientation [deg] rotate the body coordinate system around its axes
Set origin activate and highlight a marker in the ’Graphic view ’ by left-clicking the

mouse. the button Set origin is activated. press the button to translate
the origin of the body coordinate system into the center of the selected
marker.

Set origin to COG translate the origin of the body coordinate system into the target’s center
of gravity

Set axis activate and highlight two markers sequentially in the ’Graphic view ’
by left-clicking the mouse. the first marker is highlighted in white, the
second one in grey. the button Set axis is activated. press the button to
open a dialog to configure the transformation.

Adjust axes to room press this button to align the body coordinate system collinear to the
room coordinate system

Delete marker activate and highlight a marker in the ’Graphic view ’ by left-clicking the
mouse. the button Delete marker is activated. press the button to re-
move the selected marker from the target geometry.

Table 9.12: Body Adjustment (General) - Transform actions

Action Description

due to body the body coordinate system is defined by the target geometry (see sec-
tion 9.5.2.1 on page 134)

due to room (origin in COG) the body coordinate system is rotated and aligned collinear to the room
coordinate system with the origin set in the center of gravity (COG) (see
section 9.5.2.2 on page 135). tick the checkbox use tracked orientation
to use this function.

due to room (origin in marker) the body coordinate system is rotated and aligned collinear to the room
coordinate system with the origin set in one specific marker (see section
9.5.2.3 on page 135). tick the checkbox use tracked orientation to use
this function.

Table 9.13: Body Adjustment (Special) - Transform actions
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9.7 Flystick

Open the Tracking → Flystick dialog to manage the number of Flysticks (max. 20) and to
configure the corresponding settings to be used, see figure 9.30 on page 145.

Figure 9.30: Flystick Settings

Checkbox Description

use old output format use the legacy output format of the Flystick1 (refer
to the DTRACK3 Programmer’s Guide )

activate MultiUser function activate the use of multiple Flystick2/2+/3 (refer to
section 9.7 on page 146)

use head targets the data pair (Flystick2/2+/3 and head target) of
one user is made available as output data (MultiUser
enabled only)

active Flystick3 only Description

sync groups configure your active Flystick3 (discontinued) for
use with syncgroups (syncgroup #1, syncgroups #1
and #2, . . . ; default = syncgroup #1)

flash intensity change the flash intensity of the active target of the
Flystick3 (discontinued) by moving the slider (de-
fault = 3)

Flystick2+ only Description

activate feedback activate feedback functionality of Flystick2+
Test start feedback vibration test run

Table 9.14: Flystick settings - Description of the checkboxes and options
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MultiUser option The MultiUser option is an enhancement especially for VR/AR appli-
cations when working with more than one Flystick2/2+/3 . Tick the checkbox ’activate
MultiUser function’ to activate the function. Please refer to the DTRACK3 Programmer’s
Guide→ Output of Measurement Data via Ethernet for more details.

Use head targets In order to use a Flystick2/2+/3 and a head target as data pair tick
the checkbox ’use head targets’ as well. Up to ten users can be equipped with a Fly-
stick2/2+/3 and a head target (usually mounted on glasses). DTRACK3 is able to track
them all but only the data pair (Flystick2/2+/3 and one designated head target) of one
user is available as output data. Switching between the single users can be done by
pressing one of the Flystick2/2+/3 buttons.

9.7.1 Flystick Configuration

Enter the number of Flysticks ’0...20’ directly or use the numeric updown button. The cor-
responding entries in the list of selected Flysticks will show up. The fields Model , Serial /
Port , Sync Groups and Flash Intensity are empty by default.

Make sure that your Flystick2/2+/3 are listed under available Flysticks - compare the se-
rial number listed here to the one printed on the battery compartment of the Flystick2 or
on the back cover of the Flystick3 . Detach the upper marker compartment of the Fly-
stick2+ to gain access to the serial number.

Now assign your Flystick2/2+/3 to a Flystick ID:

Therefore,

• mark the respective Flystick ID, e.g. ’F1’, by left-clicking the corresponding entry
from the list of selected Flysticks

• mark the desired Flystick2/2+/3 from the list of available Flysticks by left-clicking

• press Select to finalize the assignment.

Repeat these steps if you want to use another Flystick2/2+/3 .

i
If the list of available Flysticks does not contain your Fly-
stick2/2+/3 press any button of the Flystick2/2+/3 to register it at the
RadioTransceiver2/3

9.7.2 Flystick2+ Feedback

This function is only available after assignment of at least one Flystick2+ device to a cor-
responding Flystick ID.
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Tick the checkbox activate feedback in the lower left corner of the dialog to activate the
feature globally on all Flystick devices providing feedback functionality. Mark the respec-
tive Flystick ID (e.g. ’F1’) under selected Flysticks by left-clicking and press the button
Test to send a series of feedback commands to test beep and vibration of the Flystick2+ .
The corresponding status LEDs will light up to indicate radio communication. Please refer
to the ART Hardware Installation Guide→ Interaction devices → Flystick2+ → Control
Elements.

9.7.3 Flystick Calibration

After assigning the Flystick2/2+/3 to the ART RadioTransceiver2/3 , close the Flystick
Settings dialog and open Tracking → Body calibration. There select the body Flystick
body 01 for calibration. Define the orientation of the body coordinate system relative to
the body (default: due to body ). Make sure that all markers of the Flystick2/2+/3 are
seen by the cameras using the Monitor 2DOF display which appears in the background.
Press Calibrate and the calibration will start within 5 seconds. Please refer to chapter
9.5.1 on page 133 for more information concerning the body calibration procedure.

9.7.4 Flystick Output settings

The last step is to define where the Flystick2/2+/3 data has to be sent to. Open Track-
ing → Output . There either select this computer (= remote PC) or enter an IP address
of another client you want to send data to. Tick the checkbox ’6df2’ to transmit the Fly-
stick2/2+/3 data.
Please refer to chapter 9.11 on page 165 for more details.

9.7.5 Flystick Display

Press Start to start the measurement. In order to view the tracking data enable the
Flystick display by clicking View → Flystick . Please refer to chapter 6.3 on page 50 for
details.

Z
Note that output of Flystick tracking data is just possible after the
Flystick has been activated (at least once after booting the ART Con-
troller). So if no data is appearing in Flystick display , simply press an
arbitrary button on the Flystick2/2+/3 .

9.8 Fingertracking

This dialog is the center for configuration and calibration of Fingertracking hardware (op-
tional with tactile feedback). This feature is not available for SMARTTRACK2/3/M .

The following steps describe a full calibration of one hand using non-customized ART Fin-
gertracking hardware:
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1. Select the number of hands you want to use with your tracking system (up to 4).

2. Assign body calibrations for all hand targets (using the target library). When using
customized hand targets please refer to the corresponding chapter 9.8.3 on page
154 for further details.

3. Calibrate the complete hand geometry (i.e. the position and orientation of the finger
tips in respect to the hand target).

4. (optionally) Install an ART RadioTransceiver2/3 when using Fingertracking2 Tac-
tile devices (refer to the ART Hardware Installation Guide→ Other equipment →
Radio Transceiver and section 8.5 on page 88 for details).

5. (optionally) Assign tactile devices for all hand targets, if applicable

Simply repeat all steps for each tracked hand in your system.

9.8.1 Fingertracking Settings

First, open the dialog Tracking → Fingertracking and configure the number of hands you
are using. Enter the number of hands ’0...4’ directly or use the numeric updown button.

Figure 9.31: Fingertracking Administration - Settings

For each Hand ID a row from ’H1...H4’ will show up correspondingly on the left side of the
window under selected hands. The ’Name’ and ’Geometry ’ entries will be empty, while
the column Cal. will show a grey No Entry sign.
Next a body calibration for the hand target has to be assigned using the target library
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(refer to chapter 9.8.2 on page 151).

i
Hand target calibrations without corresponding hand geometries are
marked with a yellow tick on the corresponding Hand ID row under
selected hands. A fully calibrated Hand ID is marked with a green tick.

9.8.1.1 Available hand geometries

It is also possible to (re-)assign previously calibrated hand geometries (i.e. position and
orientation of the finger tips) to existing hand target calibrations . This way one set of Fin-
gertracking hand targets can be used by several different users and, most importantly,
one needs to calibrate the hand geometry only once for each person during first installa-
tion.

A hand geometry listed on the right side of the window under available hand geometries
can be assigned to a selected Hand ID the following way:

• mark the respective Hand ID from row ’H1...H4’ under selected hands by left-clicking

• mark the appropriate entry ’Available for hand ID’→ ’H1...H4’ under available hand
geometries by left-clicking and

• press Select

• (optionally) confirm to overwrite the assignment by pressing OK . This confirmation
will only show up when the assignment to a specific Hand ID is to be changed.

If the hand geometry is already in use (multiple assignment) a warning message will be
shown instead. You can always delete a previously assigned hand geometry by pressing
the button Deselect . The geometry will be available again for assignment.

i
In order to identify different hand geometries under available hand ge-
ometries and to assign it to the corresponding hand target please use
meaningful names for the ’geometry ’ and double-check the column
’Available for hand ID’.

Z
In case of multiple assignments (i.e. one hand geometry is to be as-
signed to more than one hand target calibration) a warning message
will pop up. Delete the current assignment prior to re-assigning.

9.8.1.2 Managing hand geometries

Exporting hand geometries In order to export hand geometries just press ’Save’ and
select the hand geometries you would like to export in the upcoming window (see figure
9.32(a) on page 150). Press ’Save’ again, select the location of the respective folder and
choose an appropriate file name (see figure 9.32(b) on page 150).

A confirmation window will show the successful import (see figure 9.33 on page 150).
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(a) Select the hand geometry file(s) to
save

(b) Select the folder on the remote PC

Figure 9.32: Fingertracking Administration - Saving hand geometry files

Figure 9.33: Fingertracking Administration - Saving hand geometry files - Confirmation
window

Importing hand geometries You can also import previously saved hand geometries by
pressing the button ’Load ’. A window will open to select the respective folder (see figure
9.34(a) on page 150). Choose the appropriate file and press ’OK ’. Then select the in-
dividual geometries to import by left-clicking or select all geometries at once by clicking
select all (see figure 9.34(b) on page 150). Press Load to import.

A confirmation window will show the successful import (see figure 9.35 on page 151).

(a) Select the folder on the remote PC (b) Select the hand geometry file(s) to load

Figure 9.34: Fingertracking Administration - Loading hand geometry files
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Figure 9.35: Fingertracking Administration - Loading hand geometry files - Confirmation
window

Deleting hand geometries You can also remove entries from available hand geome-
tries by left-clicking and pressing ’Delete’. Select the hand geometries you would like to
delete in the upcoming window (see figure 9.36(a) on page 151). Press ’Delete’ again to
remove the corresponding entry.

A confirmation window will show up to confirm the removal (see figure 9.36(b) on page
151).

(a) Select the hand geometry file(s) to delete (b) Confirm the removal

Figure 9.36: Fingertracking Administration - Deleting hand geometry files

9.8.2 Fingertracking Body calibration via Target Library

Open the sub-dialog Fingertracking → Body Calibration via Target Library to either make
use of the automatic recognition feature or directly assign the corresponding body calibra-
tion of each hand target to a selected Hand ID. All hand target body calibrations stored in
the target library are shown on the right side of the window.

i
The integrated target library contains most hand target calibrations of
ART Fingertracking hardware. Perform a custom body calibration only
when the hand target cannot be identified automatically.
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Figure 9.37: Fingertracking Administration - Body Calibration Target library

Automatic recognition via Target Library For automatic identification follow these
steps:

• turn on all Fingertracking devices

• place them inside the tracking volume and make sure that all hand targets to be
identified are visible to at least 2 cameras.

• run the target library identification by pressing Calibrate. The current status is shown
by a progress bar while the amount of ’found new targets’ is listed (see bottom right
in figure 9.37 on page 152).

• the Short Name of the corresponding hand target will be marked green

• mark the respective Hand ID from row ’H1...H4’ under selected hands by left-clicking

• mark the appropriate entry in the target library (e.g. ’FINGERTRACKING2 left Hand
Target 1’) by left-clicking and

• press Select

• repeat the selection for each identified hand target in your system

In some cases the system will inform you that a re-calibration of the hand target might be
necessary, i.e. to compensate for manufacturing tolerances resulting in the geometries
not matching perfectly to the data inside the target library (see warning figure 9.17 on
page 125). Please refer to the section for Custom Fingertracking Body Calibration (see
9.8.3 on page 154.
After selection and assignment the ’Name’ and ’Geometry ’ entries will be updated. The
entry in the column Cal. will turn into a yellow tick. On the right side of the window the
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corresponding entry in column Used will turn into a green tick and will change to ’yes’.

All hand targets are sorted in ascending order (i.e. with increasing Hand ID). You can al-
ways delete the assignment by pressing the button Deselect . After confirmation to delete
the body calibration the bodyfile will be available again for assignment to a different Hand
ID.

You may also rename a description or label of the hand by double-clicking the field Name.

Direct selection via Target Library You can also directly select the body calibration
and assign it to a Hand ID the following way:

• mark the respective Hand ID from row ’H1...H4’ under selected hands by left-clicking

• mark the appropriate entry in the target library (e.g. ’FINGERTRACKING2 left Hand
Target 1’) by left-clicking and

• press Select

• repeat the selection for each hand target in your system

With this method the system will not inform you that a re-calibration of the body might be
necessary, i.e. to compensate for manufacturing tolerances resulting in the geometries
not matching perfectly to the data inside the target library. In order to achieve optimal
tracking accuracy or in case of tracking problems please perform a re-calibration. Please
refer to the section for Custom Fingertracking Body Calibration (see 9.8.3 on page 154.
After selection and assignment the ’Name’ and ’Geometry ’ entries will be updated. The
entry in the column Cal. will turn into a yellow tick. On the right side of the window the
corresponding entry in column Used will turn into a green tick and will change to ’yes’.

All hand targets are sorted in ascending order (i.e. with increasing Hand ID). You can al-
ways delete the assignment by pressing the button Deselect . After confirmation to delete
the body calibration the bodyfile will be available again for assignment to a different Hand
ID.

You may also rename a description or label of the hand by double-clicking the field Name.

i
Using the automatic recognition feature DTRACK3 compares the ge-
ometry of the physical target with the calibration data of the target
library. In some cases a re-calibration might be necessary to achieve
optimal tracking accuracy.

Z
Using the direct selection and assignment DTRACK3 DOES NOT com-
pare the geometry of the physical target with the calibration data of
the target library. Please perform a re-calibration to achieve optimal
tracking accuracy.
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Z
The integrated target library contains most body calibrations of
ART hardware. In the unlikely event that a target is not identified auto-
matically perform a custom body calibration.

The next step is to calibrate the handedness as well as the position and orientation of the
finger tips (refer to chapter 9.8.4 on page 155).

Z
The Fingertracking (discontinued) is delivered with different hand tar-
get geometries when using two pair of sets, whereas Fingertrack-
ing2 devices have to be set up properly. Refer to the ART Hardware
Installation Guide → Interaction devices → Fingertracking2 and Fin-
gertracking2 Tactile Hand Targets how to switch the configuration.

Z
Select the Set 1 or 2 configuration of the Fingertracking2 handtargets
during first-time installation only. Do not change the setting during
routine operation or tracking will fail !

9.8.3 Fingertracking Body calibration Custom

Figure 9.38: Fingertracking Administration - Body Calibration Custom

When using hand targets not found inside the target library (e.g. customized) a standard
body calibration has to be carried out. The process of calibrating a 6DOF body is de-
scribed in chapter 9.5.1 on page 133.

Mark the respective Hand ID from row ’H1...H4’ under selected hands by left-clicking and
start the calibration by pressing the button Calibrate.

You can also load a calibration from a calibration file instead by pressing ’Load ’ after
marking the corresponding Hand ID. Please refer to chapter 9.5.6 on page 138 for details.
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9.8.4 Fingertracking Hand geometry calibration

Open the sub-dialog Fingertracking → Hand Geometry calibration to calibrate the hand-
edness as well as the position and orientation of the finger tips . The respective Hand ID
is selected automatically during the calibration process.

Figure 9.39: Fingertracking Administration - Hand Geometry Calibration

The hand geometry calibration is performed the following way:

• enter a meaningful name for the geometry (e.g. username-left) in the field new hand
geometry name

• select the handedness by ticking the corresponding radio button for left or right hand

• select the appropriate thimble set from the dropdown-menu fingerset

• (optionally) activate the 5 finger simulation (only available for 3-finger thimble sets)
by ticking the checkbox 3 -> 5

• press Calibrate to start the two-step calibration process

i For easy identification and assignment of the correct hand geometry
for different users please use meaningful names for the ’geometry ’.

i Click on the button Help to open a window where the calibration pro-
cess is additionally explained and visualized.

Z Calibrate one hand geometry after the other. Make sure to switch off
all hand targets but the one that is currently used for calibration.
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9.8.4.1 Hand geometry calibration process

After pressing Calibrate a countdown for the first step of the calibration process begins.

In the first phase (calibration step 1)

• all fingers have to be stretched out (see left picture in dialog, refer to figure 9.39 on
page 155)

• the thumb has to be spread away from the hand

• do not spread the other fingers, keep them together. Take care, that there is no
space between them

• do not move any finger nor the thumb during the first calibration phase

• you may move the entire hand slightly

Figure 9.40: Fingertracking Administration - Hand Geometry Calibration progress bar

A progress bar shows the status of the calibration (see figure 9.40 on page 156).

Z
If calibration step 1 fails, please check if modulated flash is activated
for at least one camera and if the correct handedness and thimble set
are selected.

Z
It is important that the hand is held inside the tracking volume and all
markers are visible to at least two cameras when starting the calibra-
tion process.

After the first step has been completed a new countdown for step 2 is started.

During the second phase (calibration step 2)

• keep the fingers stretched out (see right picture in dialog, refer to figure 9.39 on
page 155)
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• keep the thumb spread away from the hand

• keep the other fingers close together

• gently move all of your fingers up and down at the same time until the calibration
process is finished. The thumb is still spread away from the hand and should not be
moved during this phase.

• do not bend or cross your fingers

i Try to achieve an angle of approximately 60◦between up and down po-
sition of the fingers.

i If the calibration terminates with an error message, double-check the
calibration procedure by clicking the button Help.

Z If calibration step 2 fails, please take care not to bend your fingers, and
not to move the thumb too much

After data collection a process is started which calculates the finger sizes from the move-
ment of the finger tips (see figure 9.41 on page 157. The length of the thumb is derived
by the finger lengths.

Figure 9.41: Fingertracking Administration - Hand Geometry Calibration result window

After successful calibration the ’geometry ’ entry under selected hands will be updated.
The entry in the column Cal. will turn into a green tick.

When using Fingertracking without tactile support, the next step is to activate the data
output. Please refer to chapter 9.8.7 on page 160. When using Fingertracking2 Tac-
tile you need to assign the tactile devices, see to chapter 9.8.5 on page 158 for details.
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9.8.4.2 5 Finger Simulation

If you are using a three finger thimble set but would like to get data for five fingers, tick
the checkbox simulate 3 -> 5. DTRACK3 will simulate the data of the two missing fingers
by putting them parallel to the middle finger. By default, the checkbox simulate 3 -> 5 is
unticked until you have carried out a hand geometry calibration.

9.8.4.3 Resetting finger tip sequence

When the Fingertracking device has been removed from the hand and afterwards is put
on again by the same user, the system needs to reset the correct order of the finger tips.
To regain the correct sequence, the hand must be kept still with all fingers stretched out
and the thumb spread to the side (see first phase of calibration process). When using two
hands, both hands have to be separated by at least 50 cm during this procedure.

i Fingertracking devices will compensate short synchronization losses
internally.

Z
In the rare case when the Fingertracking devices have lost synchro-
nization use the reset procedure to regain synchronisation. Refer to
the ART Hardware Installation Guide → Interaction devices → Finger-
tracking → Description of the hand targets.

9.8.5 Fingertracking Tactile Assignment

Open the sub-dialog Fingertracking→ Tactile Assignment to assign a tactile device to the
corresponding Hand ID. All available tactile devices will show up on the right side of the
window. This function is only available with Fingertracking2 Tactile devices.

Tactile devices are assigned the following way:

• activate the support for tactile devices by ticking the corresponding checkbox tactile
Fingertracking active

• mark the respective Hand ID from row ’H1...H4’ under selected hands by left-clicking

• mark the appropriate entry under available tactile devices (e.g. ’FINGERTRACK-
ING2 Tactile’ with ’serial number ’ XY) by left-clicking and

• press Select

The ’Model ’ and ’Serial Number ’ entries will be updated accordingly.

You can always delete the assignment by pressing the button Deselect . The tactile device
will be available again for assignment to a different Hand ID.

Feedback Gain The feedback strength can be adjusted using a global gain setting, i.e.
the feedback used inside the application is multiplied by this value. By default, this feed-
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Figure 9.42: Fingertracking Administration - Tactile Device Assignment

back gain is set to average. Activate the slider Feedback Gain by double-clicking, then
move it to the right to increase the gain setting, move the slider to left to decrease it re-
spectively.

Please refer to the DTRACK3 Programmer’s Guide→ Input of Control Data via Ethernet
for more information about setting the feedback strength.

You can also test the feedback strength (refer to the next chapter 9.8.6 on page 159).

i
The serial number of the tactile device can be found on the bottom
of the hand target, e.g. 8L means tactile device #8. Refer to the ART
Hardware Installation Guide → Interaction devices → Fingertracking
→ Description of the hand targets

Z
Please install an ART RadioTransceiver2/3 when using Fingertracking2
Tactile devices (refer to the ART Hardware Installation Guide → Other
equipment → Radio Transceiver and section 8.5 on page 88 for de-
tails).

9.8.6 Fingertracking Tactile Test

Open the sub-dialog Fingertracking → Tactile Test to test the feedback on the thimbles.
This function is only available after assignment of a Fingertracking2 Tactile device to a
corresponding Hand ID.

Mark the respective Hand ID from row ’H1...H4’ under selected hands by left-clicking.
Then press the button Test hand . The tactile thimbles will be activated sequentially from
thumb over index finger to middle finger.
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Figure 9.43: Fingertracking Administration - Tactile Device Test

You can also test one finger after the other by pressing the corresponding buttons Test
thumb, Test index or Test middle. The corresponding status LED will light up to indicate
radio communication. Refer to the ART Hardware Installation Guide → Interaction de-
vices → Fingertracking → Description of the hand targets.

9.8.7 Fingertracking Output settings

The last step is to define where the Fingertracking data has to be sent to. Open Track-
ing → Output . There either select this computer (= remote PC) or enter an IP address
of another client you want to send data to. Tick the checkboxes ’gl ’ and ’glcal ’ to transmit
the Fingertracking data.
Please refer to chapter 9.11 on page 165 for more details.

9.8.8 Fingertracking Display

Press Start to start the measurement. In order to view the tracking data enable the Fin-
gertracking display by clicking View → Fingertracking. Please refer to chapter 6.3 on
page 50 for details.
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9.9 Measurement Tool

9.8.9 External Add-On - Fingertracking Viewer

The Fingertracking Viewer is a tool for visualisation of the hand and finger positions. It is
available free of charge for demonstration and testing purposes to be installed on the PC
that receives DTRACK3 data.

After starting the viewer, proceed the following way:

• specify the ART Controller or ART Controller/M to connect to by defining the host
name or IP address

• specify the UDP data port the viewer has to listen to

• press the Go Online button

• press OK to connect the viewer to DTRACK3

• choose the Hand ID you want to display

The indicator adjacent to the Hand ID setting shows whether this hand is tracked or not
(green=tracked, red=not tracked). Finally click on one of the buttons featuring a hand to
see your tracked hand and fingers.

You can also start a small demo showing the handling of a virtual object by opening the
Demos menu. There is a limited number of demos available, e.g. you can handle a virtual
sphere or cube. To insert the virtual object into the tracking volume, place the tracked
hand at a convenient position and press the Grab object button.

9.9 Measurement Tool

Within this dialog you can manage the number of Measurement Tools and the number of
references (max. 4 each) and configure the corresponding settings to be used (see figure
9.44 on page 162).

Additionally several other parameters can be changed to suit your application:
Enter the number of Measurement Tools ’0...4’ directly or use the numeric updown button.
The corresponding entries in the list of Measurement Tools will show up. The fields Model ,
Serial are empty by default. Double-click the corresponding entry Tip diameter [mm] and
enter a value (in mm) when using ball-shaped tips. The diameter will be included in the
data output (refer to the DTRACK3 Programmer’s Guide → Output of Measurement
Data via Ethernet).

Measurement Duration It is possible to define the duration of a point measurement. A
compromise has to be found between the amount of data collected and the convenience
of holding the Measurement Tool . Enter the value in seconds in the field measurement
duration [s] .
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Figure 9.44: Measurement Tool

Control Description

number of Measurement Tools configure the number of devices to be used
number of references configure the number of reference bodies to be used
Tip diameter [mm] define the diameter of the tip (ball-shaped)
use old output format use the legacy output format (refer to the DTRACK3

Programmer’s Guide )
measurement duration [s] configure how long a measurement with the Mea-

surement Tool (valid range: 0.2 - 10.0 sec) should
take

tool tip tolerance [mm] specify the range within the tip is assumed to be
static (valid range: 0.1 - 5.0 mm)

activate measurement start simulation activate the gesture detection and enable the re-
spective controls

minimal angular variation [deg] specify the minimum angle that the Measurement
Tool has to be tilted over to start a measurement
(valid range: 10◦- 120◦)

maximum lead time for this angular
variation [s]

waiting time before the measurement start after ges-
ture detection

Table 9.15: Measurement Tool settings

Tool Tip Tolerance The tracking system will take measurements up to a defined jitter
in millimeter around the tool tip. Configure this tolerance to suit your needs for accuracy.
Enter the value in millimeters in tool tip tolerance [mm] .
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9.9 Measurement Tool

Start Simulation In certain applications and use cases it might be more convenient to
start the measurement by a gesture rather than pressing a button on your PC. Tick the
checkbox activate measurement start simulation to enable the gesture detection.

The gesture is simply tilting the Measurement Tool along the tip axis similar to waving.
You can configure the minimum angle of tilt that is necessary to detect the gesture. Enter
the value in ◦[deg] in the field minimal angular variation [deg] . Additionally you can specify
a waiting time until the measurement starts after detection of the gesture. Specify the time
in seconds in the field maximum lead time for this angular variation [s] .

9.9.0.1 Reference bodies

If you are working with a reference body you may assign it to a specific Measurement
Tool :

• mark the respective Measurement Tool ID by left-clicking,

• mark the reference body Reference ID and

• press Select .

The ’Reference ID’ entry will be updated accordingly. Repeat these steps if you want to
assign references to other Measurement Tools .

If you are working with reference bodies you will need to calibrate them as well. This
is done using a standard body calibration of e.g. Measurement Tool reference body 01.
Please refer to chapter 9.5.1 on page 133 for more information concerning the body cali-
bration procedure.

Z A Measurement Tool with an assigned reference body can only be
tracked when the reference body is tracked as well.

9.9.1 Measurement Tool Calibration

The calibration of the Measurement Tool is separated into two steps:

1. body calibration of the Measurement Tool and

2. calibration of the tip (refer to section 9.10 on page 164.

9.9.1.1 Measurement Tool Body Calibration

First, calibrate the Measurement Tool using a standard body calibration. Close the Mea-
surement Tool Settings dialog and open Tracking → Body calibration. There select the
body Measurement Tool body 01 for calibration. Define the orientation of the body coor-
dinate system relative to the body (default: due to body ). Make sure that all markers of
the Measurement Tool are seen by the cameras using the Monitor 2DOF display which
appears in the background. Press Calibrate and the calibration will start within 5 sec-
onds. Please refer to chapter 9.5.1 on page 133 for more information concerning the
body calibration procedure.
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9.9.2 Measurement Tool Output settings

The last step is to define where the Measurement Tool data has to be sent to. Open
Tracking → Output . There either select this computer (= remote PC) or enter an IP
address of another client you want to send data to. Tick the checkboxes ’6dmt2’ and
’6dmtr ’ to transmit the Measurement Tool data.
Please refer to chapter 9.11 on pag 165 for more details.

9.9.3 Measurement Tool Display

Press Start to start the measurement. In order to view the tracking data enable the
Measurement Tool display by clicking View →Measurement Tool . Please refer to chapter
6.3 on page 50 for details.

9.10 Measurement Tool Tip Calibration

After a successful body calibration, you have to calibrate the tip of the Measurement
Tool by opening Tracking → Measurement Tool Tip calibration (see figure 9.45 on page
164) .

Figure 9.45: Measurement Tool Tip Calibration

Place the Measurement Tool in front of the cameras with the tip fixed at exactly one position
(e.g. on a hard surface). Press Calibrate to start the calibration process.

Gently move the Measurement Tool while tilting it around its tip in all axes. A progress bar
will show the current status (see figure 9.46(a) on page 165. DTRACK3 will calculate the
position of the tip relative to the markers of the Measurement Tool , i.e. the origin of the
body coordinate system is transformed into the Measurement Tool ’s tip.

After successful tip calibration the result is presented in the dialog Measurement Tool Tip
Calibration Result (see figure 9.46(b) on page 165. Please check the information and
either ’Accept ’ or ’Cancel ’ the tip calibration.
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9.11 Output Settings

(a) Progress bar (b) Calibration Result

Figure 9.46: Measurement Tool Tip Calibration Process

i A tool tip calibration result below 0.2 mm is recommended for mea-
surements with high accuracy.

Z Keep the Measurement Tool positioned at exactly one point, i.e. do not
lift it from the surface.

Z The progress bar will stop if the Measurement Tool is not moved suffi-
ciently.

9.11 Output Settings

In this dialog you can manage the settings for data output via ethernet (see figure 9.47 on
page 166). You can send data to any computer within your local network with a total of up
to 10 individual channels for UDP data.

First tick the checkbox active on the corresponding tab to enable data output for each
channel. Next enter the IP address of the receiving client in the box send to and choose
a UDP port number in UDP Port .
Alternatively tick the checkbox this computer instead to send the data to the remote PC
from where you started the DTRACK3 frontend.

You can also send the data to a multicast IP address (in the range of 224.0.1.0 to 239.255.255.255)
by ticking the checkbox multicast .

By clicking on the tab + you can add one channel at a time up to 10 channels. Set-up each
channel on the corresponding tab as described above. Scroll horizontally using the left /
right arrow button or simply resize the dialog window using the mouse. Click the button
Close tab to remove the selected output channel configuration. A warning message will
appear to confirm the action. Press Exit to close the Output Settings dialog.

send data divisor In order to reduce the amount of data from the data stream you can
define a divisor starting with 1. The divisor works the following way:

• 1 .. every frame is transmitted,

• 2 .. every second frame is transmitted,
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Figure 9.47: Output settings

• 10 .. every tenth frame is transmitted.

• ...

Selection of UDP output data
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9.11 Output Settings

Identifier Description

fr frame counter
ts timestamp
ts2 timestamp (extended format)
6dcal number of calibrated bodies
6d 6DOF standard body
3d 3DOF marker
6df Flystick (old format) 1

6df2 Flystick
6dmtr Measurement Tool reference
gl Fingertracking hand
glcal number of calibrated Fingertracking hands
st system status
6di 6DOF inertial body (extended format)
6dmt Measurement Tool (old format) 2

6dmt2 Measurement Tool (also for ball probes)
6dcov 6DOF standard body covariance 3

3dcov 3DOF marker covariance 3

1 only available if activated in Tracking → Flystick → checkbox ’use
old output format ’

2 only available if activated in Tracking → Measurement Tool →
checkbox ’use old output format ’

3 hidden, by default. An optional license code is necessary to unlock
these features. Please refer to section 7.2 on page 64 for more
information.

Table 9.16: Description of UDP output data

Please refer to the DTRACK3 Programmer’s Guide→ Output of Measurement Data via
Ethernet for the format of the data output.

Z
Double-check the currently used pulse generating source in the menu
Inertial Sensor Settings → Tracking. Please refer to chapter 8.6.2.5 on
page 102 for further information.

Z
When using the identifier ’timestamp’ please refer to the DTRACK3
Programmer’s Guide → Output of Measurement Data via Ethernet re-
garding the accuracy of timestamps.

Z
Please double-check that output channels are activated only for con-
nected clients ready to receive data. De-activate all output channels
when clients have been disconnected or IP addresses have become
invalid.

9.11.1 Act as router for tracking output

This functionality may be used when it is not allowed to connect the controller to your
local network due to IP security reasons. The UDP output data can then be routed to
your local network via DTRACK3 . The mandatory requirement for this function is that
the PC running the DTRACK3 frontend is equipped with two ethernet LAN ports. One is
necessary for connecting the controller and the other for connection to your local network
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(see figure 9.48 on page 168).

Tick the checkbox act as router for tracking output to activate the function.

(a) act as router disabled (default) (b) act as router enabled

Figure 9.48: Depiction ’act as router’ functionality

i
Using DTRACK3 to forward the UDP data output will add a short delay
/ latency (approx. 0.1 ... 0.5 ms, dependent on the calculation power of
the Host PC)

Z Do not use this function if the application PC and the controller are in
the same network!
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10 Menu View - Frontend configuration

Display Shortcut

Set to default
Monitor 2DOF
Data F10
Flystick
Fingertracking
Measurement Tool
Events

Table 10.1: Menu View

Set to default This function resets the appearance of the DTRACK3 frontend, i.e. all
views and the size of the windows are reverted to default values. Only the Monitor 2DOF
and the displays Data and Events are shown.

Monitor 2DOF The Monitor 2DOF display is a graphical display of the field of view of the
cameras to visualise all markers that are seen by the cameras. It is activated by default.
A more detailed description can be found in chapter 6.3.1 on page 50.

Data On the left hand side the Data Display shows the 6DOF measurement results (i.e.
position and orientation of the body relative to the room coordinate system). Additional
information for inertial sensors are also shown, if applicable. On the right hand side
the results for 3DOF calculation of single markers (e.g. from not-calibrated targets) are
shown, if activated.

Measurement Tool The Measurement Tool display shows the measurement results of
the position and orientation of the Measurement Tool .

Events The Event Display shows the status of the tracking system. All messages and
entries shown here are also stored in event logs on the remote PC. These files are nec-
essary for tech support by ART (please refer to chapter 7.3 on page 67).

Fingertracking (not available for SMARTTRACK2/3/M ) The Fingertracking display
shows the measurement results for the hands - i.e. of back of the hand + each finger
(thumb, index, middle, ...).
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Flystick The Flystick display shows the measurement results of the position and orien-
tation of the Flystick.
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11 Menu Tools

Tools Shortcut

Measure points

Table 11.1: Menu Tools

11.1 Measure Points

This tool (see figure 11.1 on page 171) provides a simple acquisition method for mea-
surements with the Measurement Tool .

Figure 11.1: Measure Points

The dialog shows the following informations:

The measurement of a point is started either by pressing the button Measure point , by
performing a gesture with the Measurement Tool or by pressing a button of an assigned
Flystick . Tilt over the Measurement Tool as defined in 9.9 on page 161. The distances
between adjacent points are computed automatically. You may insert or delete points
from the list and you may save the list to a file.
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Control Description

Measure point Place the Measurement Tool at the position you
want to measure and press this button.

Insert point Add an additional measurement to the list (above
the selected point).

Delete point Remove the selected measurement from the list.
Save list Export the list of measurements to a file (e.g. for

import in a spreadsheet program).
Clear list Delete all entries of the list.

Table 11.2: Measure Points - Description

i If the Measurement Tool is not tracked a measurement cannot be per-
formed!
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12 Menu Help

About Shortcut

What’s this? Shift + F1
What’s new?
Controller and Camera Update
Service and Guides
DTRACK3 F1
About Qt

Table 12.1: Menu Help

12.1 What’s this?

By clicking What’s this, you may use the context-sensitive help function within the DTRACK3 fron-
tend software. Just point the mouse cursor over any feature of the DTRACK3 GUI, then
left-click to receive additional information.

12.2 What’s new?

The upcoming window provides information about the new features that have been re-
leased with the current version. By clicking on ’Show more’ you can access the history of
introduced features in previous versions (see figure 12.1 on page 174).
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Figure 12.1: What’s new Information

12.3 Controller and Camera Update

After updating the DTRACK3 frontend software an automatic update of the controller and
cameras is started, if necessary. In case you have aborted this process during first run
you can re-open the update dialog here (see figures 12.2(a) and 12.2(b) on page 174).

(a) Dialog for controller update (b) Dialog for camera update

Figure 12.2: Update Dialogs

Click Update to start the update process. Confirm by clicking Yes in the upcoming dialog
(see figure 12.3(a) on page 175). After a final warning the update is started (see figure
12.3(b) on page 175). Do not stop the process afterwards.

The update dialog will then show the current status using a progress bar (refer to figure
12.4(a) page 175). Depending on the update this may take several minutes.
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12.3 Controller and Camera Update

(a) Confirmation window (b) Confirmation warning

Figure 12.3: Confirming the update

(a) Progress bar for controller update (b) Progress bar for camera update

Figure 12.4: Running the update

After the update has been completed the controller and / or cameras have to be restarted
to finalize the update process.

For controller updates only: In order to restart directly click Yes in the upcoming dia-
log (refer to figure 12.5(a) page 175).

For camera updates: Please restart all cameras manually (not necessary for ART-
TRACK6/M and AT7-80 ). Therefore power off all updated cameras by disconnecting
them from the controller. When using PoE+ switches turn off the switch to restart.

(a) Restart warning for controller update (b) Restart warning for camera update

Figure 12.5: Restart after updating

175



12 Menu Help

You may also continue with your measurement by clicking No. The update dialog will
show no further update option when your controller is up-to-date (refer to figure 12.6 on
page 176). Click Exit to close the update dialog. Please remember to restart the con-
troller later on.

Figure 12.6: Update completed

i Personal settings and configurations (e.g. room and body calibration,
output settings, etc.) will be preserved during update!

i Updates of camera firmware are installed in a separate run after the
controller has been updated completely.

i
In case you have not updated your system on regular basis several
steps of incremental updates of the controller might be necessary (e.g.
v2.10.0 → v2.14.1 → v3.1.0 →...). Each step requires restarting the
controller. The whole process may take several minutes.

Z Don’t stop the update process e.g. by turning off controller or cameras.

Z
The controller may be restarted automatically to finish the update pro-
cess. In case of updating the camera firmware the cameras need to be
powered off separately (except ARTTRACK6/M and AT7-80 ).

Z Please remember to manually restart the controller if you cancelled the
automatic restart.

Z All patch releases and updates (e.g. v3.2.0→ v3.2.1→ v3.2.2→...) may
be installed without restrictions.

Z
DTRACK3 may only be upgraded to the next minor version (e.g. v3.2.X
→ v3.3.0) having a valid ’DTRACK3 Upgrade’ license. Please double-
check your license status first (see chapter 7.2 on page 64 for more
information).

12.3.1 Upgrading from earlier versions

When upgrading versions earlier than DTRACK3 (e.g. DTrack2 2.14.1) you will be prompted
with an additional warning message (see figure 12.7 on page 177) before running the up-
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12.3 Controller and Camera Update

date. Please double-check that your system meets the specified requirements.

Figure 12.7: Upgrade Warning

As an additional measure against invalid upgrades a dialog will appear next in order to
check for a valid DTRACK3 license code (see figure 12.8 on page 177).

Figure 12.8: Upgrade Valid License Code Entry

i Any DTRACK3 license may be used for upgrade check from DTrack2
2.X.Y (e.g. max. C cameras).

After entering the code press OK and the upgrade will be started. Please refer to the
previous section and figure 12.4(a) on page 175.

Due to changes in licensing you will need to enter all license codes for DTRACK3 when
re-connecting to the ART controller for the first time after the update. Please refer to 7.2
on page 64.

Denied Upgrade In case the technical requirements are not met the upgrade will be
denied (see figure 12.9 on page 178) and you have to revert to frontend DTrack2 2.X.Y .
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Figure 12.9: Upgrade Denied

12.4 Service and Guides

The service dialog shows important information when contacting ART technical support
(see figure 12.10 on page 178).

The Service-ID is a unique identifier of your controller. Next the current software version
on your controller (i.e. backend) is shown next to DTRACK . You can select both entries
to copy & paste.

The following entries show the Service Level and Warranty Level . These levels cor-
respond to the status of your contract for service and maintenance, if applicable. The
minimum level without contract is ’Standard ’. Depending on your Service Level contact
details of ART are provided here. For further information please consult your service
agreement.

You can also access the ART website directly using the link below. The Service-ID is
attached automatically at the end of the link.

At the bottom of the dialog the export system information window can be opened (please
refer to section 12.4.1 on page 179).

Figure 12.10: Service Information

i Please have your Service-ID and current software version ready when
you contact the ART technical support.
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12.5 DTRACK3

12.4.1 Export system information

Figure 12.11: Export System Information

This dialog is intended for saving a current system information file as well as recent event
logs in case you need to contact tech support at ART (see figure 12.11 on page 179). In-
formation is included such as number and types of cameras, validity of room calibration,
number and types of targets, current settings, warnings and error messages etc.

Select the appropriate Event log files by left-clicking the entries or by moving the slider
below the table to the left or right respectively. You can also enter the number of last days
manually (max. 30 days). Press Export to save the selected event logs together with the
system information file in (ASCII-)TXT format on any remote PC in your local network.

12.4.2 View DTRACK3 guides and technical documentation

All DTRACK3 manuals (including this one) can be easily displayed by clicking the corre-
sponding links (if a suitable PDF viewer is installed at your PC). If this doesn’t work you
can find them also in the DTRACK3 installation directory under .\DTRACK3_v3.X.Y\doc\

12.5 DTRACK3

This dialog offers information about the software version and release date of the DTRACK3 fron-
tend and backend software running on the controller (see figure 12.12 on page 180). Ad-
ditionally hostname and serial number of the controller are shown. By clicking on the
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button Show details a list of all included software modules is shown together with their
respective software versions. Information regarding licensing of DTRACK3 can be found
under Open-Source software.

Figure 12.12: About DTRACK3 Information

12.6 About Qt

This offers information about the Qt software toolkit used within DTRACK3 .

Figure 12.13: About Qt Information
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13 Frequently asked questions (FAQ)

Within this FAQ chapter we are offering solutions for easy-to-solve questions that our sup-
port encounters from time to time. The questions are grouped into specific topics to make
it more convenient for you to find a solution.

In case you do not find a proper solution for your specific problem, please do not hesitate
to contact us.
Our goal is to offer the best support possible. Therefore, we ask you to have the system
running and that you have internet access when you call us. Additionally we will need
details about your system. Please refer to the DTRACK3 User’s Guide→ Menu Help →
Service → Export System Information File for details how to export a system information
file. Please include it in your mail when you contact tech support.

13.1 Backup

	 How do I create a backup of important configurations?

It is possible to export and import configurations. Please refer to chapter 7.3.2 on page 69
for details how to export and backup your configurations. In case of an accidental delet-
ing of a configuration it will be possible to restore it presuming that an export had been
carried out before. In the unfortunate event of repairs this data could also be restored to
a replacement controller.

Please note that a room (re-)calibration might be necessary especially in case the amount
of cameras or the camera models have changed.

13.2 Cameras

	 How many cameras may be connected to the tracking system?

Starting with DTRACK3 a new license model has been established.

You may use 2, 4, 8, 16, 32, 50 or up to 80 cameras in any combination with 4, 10, 30, 50
or up to 70 simultaneously activated targets depending on the license purchased.

Please refer to table 7.2 on page 65 for a complete license overview.
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13.3 Controller

	 What are the possibilities to start the controller?

The controller is equipped with a switch that you have to press for the initial start-up. If
you want to power up your controller remotely, you may use Wake On LAN (WOL).

Please refer to chapter 5.2 on page 39 for more information.
The SMARTTRACK3 & SMARTTRACK3/M are PoE powered device, so they do not
have a power switch. They do not feature Wake On LAN either. Simply connect the
SMARTTRACK3 & SMARTTRACK3/M to the provided PoE-injector and plug the PoE-
injector into a mains socket.

	 I cannot find my controller. What can I do?

• Please make sure that the controller is connected properly to the Ethernet network.

• Switch on the controller.

• It is possible that your controller has become unreachable due to wrong IP settings
(wrong IP address or IP address area, etc.). Please refer to chapter 5.3 on page 40.

• In case you are using a firewall, please do not block DTRACK3 communication.
Please refer to chapter A.1 on page 199.

For more information, please also refer to the ART Hardware Installation Guide → In-
stallation of the Controller or → Installation of the SMARTTRACK3 or → Connection to
local network LAN.

	 What is the IP address of my controller?

You may use a standard USB pen drive and plug it in to the controller at any time. If not
running yet, please switch on the controller. Its settings (IP address, etc.) will be saved to
a information file on the USB drive. This file may be opened and modified in any editor.

Please refer to chapter 5.3.2 on page 43 for more information.

	 How can I assign a specific IP address to my controller?

You may configure a static IP address the following ways:

• using DTRACK3 (refer to chapter 5.1.3 on page 39)

• without the DTRACK3 frontend (refer to chapter 5.3 on page 40)
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13.4 DTRACK3 and shutter glasses

13.4 DTRACK3 and shutter glasses

	 What types of shutter glasses can be used with the ART tracking system

Please to refer to table 8.8 on page 87.

	 When I start tracking, the shutter glasses don’t work correctly.

Most shutter glasses use infrared signals to synchronize the glasses with the image. The
tracking cameras produce a strong infrared flash, which interferes with this communica-
tion. By synchronizing both systems, the cameras emit their flash in a way that does not
interfere.

Please refer to the ART Hardware Installation Guide→ Synchronisation.

	 When I connect the "ExtIn", the shutter emitters stop working.

Some projectors create only a weak sync signal (TTL), which is not strong enough to
drive the Synccard2 . Please contact ART to get a special high-impedance version or
synchronize against the video signal (if available).

	 Tracking stops when no stereo image is displayed

Some graphics adapters only create the shutter image when a stereo image is displayed.
If available, use video synchronization. This is a known behavior for NVidia adapters.

13.5 DTRACK3 and interfaces

	 I’m using VRPN. Which output identifiers have to be activated?

It is absolutely mandatory that you activate at least the ’6d ’ and ’6dcal ’ output identifiers
(refer to table 9.16 on page 167). Activate other output identifiers depending on your
application (e.g. if you’re using Flystick2/2+/3 you have to activate ’6df2’).

	 I’m using VRPN and TrackD but I only succeed in receiving data via just one of
them.

Please make sure that you are using two separate output channels with different port
numbers. Please refer to chapter 9.11 on page 165.

	 I’m having problems with the Flystick2/2+/3 data transmission via TrackD.

Please make sure that you are using the latest version of the TrackD module - ART will
provide information upon request. Versions of trackd 5.5 which are older than February
2007 do not support data transmission for Flystick2/2+/3 .
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If you don’t want to change the module you may also use the ’old output format ’ for legacy
Flystick1. Please refer to chapter 9.7 on page 145 for more details.

13.6 Software DTRACK3

	 Where do I get the software DTRACK3 from?

The software DTRACK3 is delivered on a USB pen drive with the tracking system. Fur-
thermore, you may register for the ART Download Center
(http://www.ar-tracking.com/support/) in order to always have access to the latest
patch release of DTRACK3 .
Please refer to chapter 7.2 on page 64 for more information about DTRACK3 release
policy.

	 Why is my frontend not starting up?

• Please refer to chapter A.1 on page 199 for a list of supported operating systems.

• Windows XP is not supported. Please update to Windows 7 or newer.

• Windows 32-bit is not supported. Please upgrade to a compatible 64-bit Windows
distribution.

• Linux 32-bit is not supported. Please upgrade to a compatible 64-bit Linux distribu-
tion.

• If using Linux: some Linux distributions do not install all necessary libraries by de-
fault, although they are part of the distribution; check if the following libraries are
available:

libQt5Core.so.5

libQt5Gui.so.5

libQt5Widgets.so.5

libQt5OpenGL.so.5

libQt5Network.so.5

libQt5Xml.so.5

libQt5XmlPatterns.so.5

Please install them using an appropriate package installer.
To find out if and which Linux libraries are missing, you can also use the tool ldd
that is part of all Linux distributions; e.g. type:

ldd <DTRACK3>/bin/plugins/libadjustbodycoordinatesystem.so
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13.6 Software DTRACK3

	 Some of my menu items are missing. What can I do?

• Please check if the latest updates for your operating system are installed.

• Please refer to chapter A.1 on page 199 for a list of supported operating systems.

• If using Linux: some Linux distributions do not install all necessary libraries by de-
fault, although they are part of the distribution (see question above); install them
using an appropriate package installer.

	 Some of my menu items are greyed out / disabled. What can I do?

• Please check if your configuration is locked. In case unlock your configuration.

• Please refer to chapter 7.3 on page 67 how to manage your configurations.

	 Where is the Monitor 2DOF display?

• Please check if the latest updates for your operating system are installed.

• Please make sure that your firewall is not blocking DTRACK3 , even partly.

• Please refer to chapter A.1 on page 199 for a list of supported operating systems
and communication ports.

	 Why is the Monitor 2DOF display crossed out for some cameras?

• Please check if all the cameras used during room calibration are connected.

• Please refer to the ART Hardware Installation Guide→ FAQ for the common rea-
sons of disconnected cameras.

• Please refer to section 6.3.1 on page 50 for more information about Adding / remov-
ing cameras.

	 Why does the “(re-)calibration required” message appear in Monitor 2DOF?

• Please make sure you have performed a correct room calibration using all con-
nected cameras.

• Please refer to section 6.3.1 on page 50 for more information about Adding / remov-
ing cameras.

	 My target is not visualized within the Monitor 2DOF display.

• Please make sure that the target is inside the tracking volume and within tracking
range of the cameras.

• Double-check the settings for the flash intensities of the cameras (refer to chapter
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8.3 on page 76).

• In case you are using active targets, please make sure that you have activated the
modulated flash. Please refer to chapter 8.3 on page 76 for further details.

	 There are greyish areas in my Monitor 2DOF display. What do they indicate?

The static reflex suppression is currently active. This is indicated with these greyish ar-
eas. Markers in these areas will not contribute to tracking.

Please refer to chapter 6.3.2 on page 54 for more information.

	 What do the abbreviations "SR", "DR" and "UD" mean?

SR . . . static reflex suppression active
UD . . . display orientation is upside down

Please refer to chapter 6.3.1 on page 50 for more information on the additional Monitor
2DOF display settings.

	 The display bar in the Monitor 2DOF display is indicating very high intensities
although no markers are illustrated. Where’s the light coming from?

Please check that the cameras are not in the field of view of each other to avoid mutual
blinding. Furthermore, remove other strong IR radiation sources from the tracking volume
or, at least, prevent them from interfering with the tracking system. Please refer to the
ART Hardware Installation Guide→ Setting up the cameras for more information.

	 Monitor 2DOF and/or Data Display are ‘freezing’ after some time, although
tracking didn’t stop.

This can be caused by a firewall that is running on the DTRACK3 PC and blocking (UDP)
output data.
Check your firewall settings and ensure that it is not blocking DTRACK3 application, even
partly. Please refer to chapter A.1 on page 199.

	 How do I define the number of targets to be tracked?

Go to Tracking → Body Administration and change the number of activated target slots
by ticking ’Active’ next to the corresponding body ID. Please refer to chapter 9.4 on page
122.

	 What is the maximum number of targets?

The maximum number of targets (not including Flystick2/2+/3 , Fingertracking and Mea-
surement Tool devices) is depending on the license type.
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13.6 Software DTRACK3

Starting with DTRACK3 version v3.2.0 a new license model has been established.
You may simultaneously activate and track 4, 10, 30, 50 or up to 70 standard targets
depending on the license purchased.
Interaction devices do not count towards this limit.
Please refer to table 7.2 on page 65 for a complete license overview.

	 Where do I get a license code from?

You may purchase additional licenses for your system. Please contact your ART repre-
sentative in case you need consultation.

Please refer to chapter 7.2 on page 64 for further details.

	 Where do I enter a new license code?

Go to DTRACK3 → Licenses and enter the code in line ’new license code’.

Please refer to chapter 7.2 on page 64 for further details.

	 Where do I get a software update from?

The latest patch release of DTRACK3 is always available at the ART Download Center
(http://www.ar-tracking.com/support/).
Please refer to chapter 7.2 on page 64 for more information about DTRACK3 release
policy.

	 I want to run a software update. How do I preserve my data and my
configurations?

Your data and your configurations are automatically preserved when running a software
update. But it is recommended to regularly create backups of your configuration(s).
Please refer to chapter 7.3.2 on page 69 for further details.

	 How do I run a software update?

Please contact ART to receive the latest patch release and follow the instructions in chap-
ter 4.3 on page 32 and chapter 12.3 on page 174.

	 Do I have to update the DTRACK3 frontend software and the software of the
controller at the same time?

Yes, this is mandatory.

187

http://www.ar-tracking.com/support/


13 Frequently asked questions (FAQ)

	 My specific settings have been lost.

Please check if the correct configuration is selected:
go to DTRACK3 → Configurations and select the correct configuration.
Please refer to chapter 7.3 on page 67 for further details.

	 Is it possible to automatically start the measurement after booting the
controller?

No, this feature is not available as customer surveys have provided negative feedback.

	 May I close the DTRACK3 frontend software window after starting the
measurement?

Yes, the measurement continues even if the DTRACK3 frontend software is not active.

	 What’s the version of my DTRACK3 software?

Go to Help → DTRACK3 to find out the version of your DTRACK3 frontend software and
the backend software on the controller. Please refer to chapter 12 on page 173 for further
details.

13.7 Calibration

	 How can I find out when the room has been calibrated last time?

Please go to Tracking → Room calibration and click Show details. The date of the last
room calibration is shown.

	 How do I define position and orientation of the room coordinate system?

The calibration angle defines position and orientation of the room coordinate system de-
pending on how you place it within the tracking volume. Please refer to table 9.3 on page
109.

DTRACK3 offers the possibility to adjust the room coordinate system after the room cali-
bration. Please refer to chapter 9.2 on page 115 for more information.

	 How do I have to move the wand?

Move the wand gently within the measurement volume, in order to generate a virtual point
cloud. This point cloud should fill at least about two thirds of the measurement volume.
Please refer to the ART Hardware Installation Guide→ Setting up the cameras→Room
Calibration - Overview for more information.
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13.7 Calibration

	 I do not succeed in performing a room calibration.

• Please make sure that the calibration angle is placed within the measurement vol-
ume such that it is seen completely by at least two cameras (→ verify with Monitor
2DOF display). If not all cameras see the angle be sure that a sufficient volume
connects each camera to the others. No other marker except for the ones belonging
to the calibration angle should be visible.

• Please make sure that the correct calibration set is selected in the settings for room
calibration. Please refer to chapter 9.1 on page 107 for details.

• Please make sure that no reflections are seen by the cameras. If it is not possible
to eliminate the reflections you may use static suppression of reflections to remove
them. Please refer to the ART Hardware Installation Guide → Setting up the
cameras for more information.

• Please make sure that the markers positioned on the calibration angle are not dam-
aged or misarranged.

• Increase the flash intensities of the cameras until all markers are of good quality (i.e.
at least yellow). Please refer to chapter 8.3 on page 76.

• Restart the room calibration. Move the wand gently within the measurement volume,
in order to generate a virtual point cloud. This point cloud should fill at least about
two thirds of the measurement volume.

Please refer to the ART Hardware Installation Guide→ Setting up the cameras→Room
Calibration - Overview for more information.

	 I cannot cover two thirds of the measurement volume within the set time for the
room calibration. How do I extend the time for the calibration process?

Please open the dialogue Tracking→ Room calibration and click Show details. There you
can extend the duration for the calibration process. Please refer to chapter 9.1 on page
107 for more information.

	 How shall I evaluate the room calibration results?

Please refer to chapter 9.1.4 on page 110 for a detailed explanation.

	 DTRACK3 reports the error message "no angle tool detected". What went
wrong?

First of all, please double-check if all markers are visible and that there are no disturbing
reflections. Sometimes, it might help to move the calibration angle a little bit.
Please always verify the settings for the room calibration before repeating:

• wand length is printed on a label on the wand;

• select the correct calibration set.
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	 The progress bar of the room calibration stopped.

Please double-check in the Monitor 2DOF display whether the calibration wand is recog-
nized by the cameras during its movement.

	 What is a "re-calibration" and when do I have to perform one?

DTRACK3 provides simplified room and body calibrations, called room and body re-
calibration. The main advantage of a re-calibration is that DTRACK3 preserves the origin
and the orientation of your coordinate system as well as specific information (predefined
emission vectors, cylindrical marker).

You may perform a room re-calibration from time to time or if a camera moved slightly
(e.g. due to mechanical instabilities).Please refer to chapter 9.1.5 on page 111.

If your body fell down or if the structure is bent you should carry out a body re-calibration.
Please refer to chapter 9.5.7 on page 140 for more information.

	 What does ’scaling factor ’ mean?

Performing a room calibration results in a certain scaling error. This might be a problem
when applications do have very high accuracy requirements (e.g. when performing mea-
surements with the Measurement Tool ).
The scaling error can be determined, for instance, by measuring points on a defined
scale (e.g. tape measure). The determined scaling error can thus be adjusted with the
DTRACK3 ’scaling factor ’ (refer to chapter 9.2 on page 115).

Please contact ART if you require further information.

	 I cannot calibrate my target.

• Please check if the markers of the target are seen by the cameras in good quality
(i.e. at least yellow) - a slight change of the target position might help. If neces-
sary increase the flash intensities of the cameras. Therefore, go to Hardware →
Cameras.

• Make sure that when starting the body calibration every marker of the target is visible
to the cameras.

• A body calibration can be carried out only if a valid room calibration has been carried
out before. Check in the Event Display if there is a warning saying ’no valid room
calibration’, additionally the button Calibrate is greyed out and cannot be clicked.
In that case, please carry out a new room calibration.

• Please make sure using the Monitor 2DOF display that no marker is overlapped
(i.e. merged) by another one. If necessary rearrange the target and restart the body
calibration.
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• Try to carry out the body calibration with a moving target. Therefore, shift the starting
position of the target for calibration (often a shift of 10 or 20cm is enough to enable
calibration again).

• Make sure that no other markers or targets are inside the tracking volume other than
the one you want to calibrate.

• Please carry out a new room calibration.

	 I’d like to save all my body files for backup reasons but I receive less files than
configured bodies.

DTRACK3 only creates body files for calibrated bodies. For example: if you have con-
figured 15 targets for tracking but only 4 of them are calibrated, you will only receive 4
calibration files.

	 I’d like to calibrate a body but the body calibration dialogue is greyed out.

Please ensure that you have performed and accepted a valid room calibration prior to
body calibration. Check in the Event Display if there is a warning saying ’no valid room
calibration’.

	 What is the difference between ’due to body ’ and ’due to room’?

When selecting ’due to body ’, the body coordinate system is determined by the arrange-
ment of the rigid body itself. When ’due to room’ is used the origin of the body coordinate
system is set to the center of gravity of all markers building the rigid body.

Please refer to chapter 9.5.2 on page 134 for more information.

	 Do I have to move the target while performing a body calibration?

If possible we recommend to perform moderate movements because accuracy can be
improved doing so. However, the body has to be visible to the cameras all the time.

	 May I change the position and the orientation of the body coordinate system
later on?

Yes, you may use the dialogue Body adjustment to alter position and orientation of the
body coordinate system. Please refer to chapter 9.6 on page 141 for more information.

	 How do I define a name for a target?

Go to Tracking → Body Administration (F8). Double-click into the name field and en-
ter a name for the respective body. Please refer to chapter 9.4 on page 122 for more
information.
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	 I cannot increase the number of targets anymore.

The maximum number of target slot to be configured and calibrated is 70 (not includ-
ing Flystick2/2+/3 , Fingertracking and Measurement Tool devices). The maximum
amount of simultaneously activated targets depends on the license that is installed. Go
to DTRACK3 → Licenses to see which license you have.

Starting with DTRACK3 version v3.2.0 a new license model has been established. You
may activate 4, 10, 30, 50 or up to 70 targets depending on the license purchased.
Please refer to table 7.2 on page 65 for more information.

	 How shall I evaluate the body calibration results?

Verify that all markers of the target have been recognized during the DTRACK3 body cal-
ibration. Further, you may check if the single distances between the markers are correct
(refer to chapter 9.5.5 on page 137).

As a special service you may send us the calibration file and we are going to check it.

13.8 Tracking

	 My target (active or passive) is not recognized sporadically or only partly or
even not at all.

• Go to Hardware → Cameras and tick the checkbox ’modulated flash’. Alternatively
select the ones that have unobstructed view of the whole tracking area. Furthermore
all cameras with activated modulated flash have to be assigned to syncgroup #1
! AT7-80 , ARTTRACK6/M , ARTTRACK5 , ARTTRACK5/C , TRACKPACK/E ,
& TRACKPACK systems may be configured via software, while ARTTRACK2 &
ARTTRACK3 have to be connected to ’OUT1’ on the controller’s Synccard2/3 .

• Also, take into account that the distance between active target and cameras should
not the tracking range of the camera model.

• Active targets cannot be used near or in front of plasma screens. The IR emission
of the plasma screen overdrives the IR receiver in the active target. See also the
FAQ section: Operation near plasma screen.

• Please perform a new room calibration.

• Double-check if the marker surface is not dirty or dusty and that it doesn’t appear to
be worn out.

	 Tracking does not work.

• Please make sure that the measurement has been started and that the target is
within tracking range of the cameras.
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• If marker recognition is poor then increase the flash intensity.

• Check the number of markers that are used for calculation. If all markers of the
target are seen by the cameras, but some are not used for calculation, then execute
a new room and body calibration.

• Go to Tracking → Output . Define a receiver for the tracking data and configure the
type of data to be transmitted.

• Activate the tracking functionality within your graphics application.

	 I’m having too many heavy reflections.

• Please double-check that the flash intensities of the cameras are not too high. In
general, a flash intensity of approx. 50 % might be sufficient.

• Make sure that no other strong infrared radiation sources (e.g. sunrays or halogen
lamps) are present in the tracking volume. If they cannot be removed you may use
the reflex suppression feature of DTRACK3 .

• If mutual blinding is possible please either try to adjust the cameras differently or try
to arrange them in different syncgroups.

	 Does DTRACK3 send data if no target is being tracked?

No tracking data is sent except for the frame number (’fr ’).

	 The application PC does not receive tracking data.

• Go to Tracking → Output . Define a receiver for the tracking data and configure the
type of data to be transmitted.

• Check the network connection physically and try to address the controller with a
’Ping’.

• Double-check whether a firewall is blocking communication.

• Activate the tracking functionality within your graphics application.

	 May I use passive and active targets at the same time?

Yes, of course, there are no restrictions on using passive and active targets simultane-
ously. But you will need an external modulated flash if you are using ARTTRACK1 (dis-
continued) or ARTTRACK2 (SN < 320, (discontinued). Please contact ART in that case.
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	 I am moving my target upwards but within the Monitor 2DOF display it moves
downwards.

The camera is set to display data upside down. In the Monitor 2DOF display, right-click
on the respective camera window and disable Display upside down.

13.9 Flystick

	 The ART radio transceiver cannot be found.

Please make sure that the ART radio transceiver is plugged in. Then, simply press ’F2’
in order to perform a search for new hardware. The radio transceiver should be detected
now.

	 My Flystick2/2+/3 is not listed under the available Flysticks list.

• Make sure that the battery is charged. Press any button of the Flystick2/2+/3 and
the orange status LED should be switched on.

• Go to Hardware → ART Radio Info to see if the ART radio transceiver has been
recognized.

• Go to Hardware → ART Radio Info → Show details and set the channel number
manually.

	 Why is the pressing of the Flystick2/2+/3 buttons not recognized (within
DTRACK3 )?

• Make sure that the battery is charged. Press any button of the Flystick2/2+/3 and
the orange status LED should be switched on.

• Double-check whether the button pressed events are recognized by DTRACK3 .
Therefore:

– enable the Flystick Display (View → Flystick )

– blue rectangles should light up on each button pressed event in the Flystick
Display.

• Go to Hardware → ART Radio Info to see if the ART radio transceiver has been
recognized.

• Go to Hardware → ART Radio Info → Show details and set the channel number
manually.

• Go to Tracking → Flystick and assign your Flystick (to be found in the available
Flysticks list) to any ’Flystick ID’.
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13.10 Fingertracking

	 Why is the pressing of the Flystick2/2+/3 buttons not recognized (within the
graphics application)?

• Make sure that the battery is charged. Press any button of the Flystick2/2+/3 and
the orange status LED should be switched on.

• Go to Tracking → Flystick and assign your Flystick (to be found in the available
Flysticks list) to any ’Flystick ID’.

• Go to Tracking → Output and check if the data output is configured correctly:

– data receiver defined (’send to’),

– identifier ’6df2’ selected,

– if you are using the legacy old output format : identifier ’6df ’ selected.

	 What is the maximum number of Flystick2/2+/3 to be used simultaneously?

type max. number

Flystick2 5
Flystick3 2

Please double-check that the targets of the Flystick2/2+/3 , that are used simultaneously,
are not identical. If in doubt please contact ART .

	 What is the MultiUser option for Flystick2/2+/3 ?

The MultiUser option is an enhancement especially for VR/AR applications when working
with more than one Flystick2/2+/3 .

Please refer to chapter 9.7 on page 146 for more information.

	 The Flystick output data is not transmitted.

• Make sure that the Flystick is activated by pressing an arbitrary button.

• Go to Tracking → Output and check if the data output is configured correctly:

– data receiver defined (’send to’),

– identifier ’6df2’ selected,

– if you are using the legacy old output format : identifier ’6df ’ selected.

13.10 Fingertracking

	 The Fingertracking hand target is not recognized sporadically or even not at all.

• Make sure that the battery is charged and the hand target is switched on.

195



13 Frequently asked questions (FAQ)

• Go to Hardware → Cameras and tick the checkbox ’modulated flash’. Alternatively
select the ones that have unobstructed view of the whole tracking area. Furthermore
all cameras with activated modulated flash have to be assigned to syncgroup #1
! AT7-80 , ARTTRACK6/M , ARTTRACK5 , ARTTRACK5/C , TRACKPACK/E ,
& TRACKPACK systems may be configured via software, while ARTTRACK2 &
ARTTRACK3 have to be connected to ’OUT1’ on the controller’s Synccard2/3 .

• The configuration dial has to be turned to the proper position. Please refer to the
ART Hardware Installation Guide→ System setup → Interaction devices.

• Increase the brightness of the LEDs on Fingertracking2 devices. Please refer to
the ART Hardware Installation Guide→ System setup → Interaction devices..

	 When using Fingertracking, there are always some markers that are flashing
alternately in the Monitor 2DOF display.

This is not bug, but rather it is due to the sequential activation of the finger thimble markers
in order to achieve a separation of the fingers.

	 What’s the meaning of the status LEDs on the Fingertracking hand target?

Please refer to the ART Hardware Installation Guide → System setup → Interaction
devices for more information.

	 What is being configured when turning the configuration dial?

Please refer to the ART Hardware Installation Guide → System setup → Interaction
devices for more information.

	 What’s the maximum number of hands to be used?

You may use two Fingertracking sets (i.e. four hands) in your tracking system at the
same time. However, the targets of the hand devices must be different.

	 How do I assign a hand geometry to a hand ID?

Go to Tracking → Fingertracking. Please refer to chapter 9.8 on page 147 for further
details.

	 The finger calibration fails. What do I do wrong?

• The configuration dial has to be turned to the proper position. Please refer to the
ART Hardware Installation Guide→ System setup→ Interaction devices for more
information.

• Go to Hardware → Cameras and tick the checkbox ’modulated flash’. Alternatively
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select the ones that have unobstructed view of the whole tracking area. Furthermore
all cameras with activated modulated flash have to be assigned to syncgroup #1
! AT7-80 , ARTTRACK6/M , ARTTRACK5 , ARTTRACK5/C , TRACKPACK/E ,
& TRACKPACK systems may be configured via software, while ARTTRACK2 &
ARTTRACK3 have to be connected to ’OUT1’ on the controller’s Synccard2/3 .

• Please observe the calibration procedure defined in chapter 9.8.4 on page 155.

• Make sure that you selected the correct handedness and type of fingerset in Track-
ing → Fingertracking → Hand geometry calibration.

• Double-check that the diffusor spheres (not applicable for Fingertracking2 ) are not
broken or missing.

	 The Fingertracking output data is not transmitted.

Go to Tracking → Output and check if the data output is configured correctly:

• data receiver defined (’send to’),

• identifiers ’gl ’ and ’glcal ’ selected.

	 Is it possible to upgrade to the 3-finger or the 5-finger version?

Yes, if you are currently using the non-tactile 3-finger version you may also use 5-finger
thimble sets and vice versa. Tactile thimbles are available for 3 fingers only. Please
contact ART to receive more information.

13.11 Measurement Tool

	 I’m using the Measure Points tool but I cannot measure any points.

Please check whether both, the Measurement Tool and the Measurement Tool reference
body (if assigned), are tracked.

	 It is not possible to perform a tip calibration.

Please check whether both, the Measurement Tool and the Measurement Tool reference
body (if assigned), are tracked.
Then, try to keep the tip in the same position while doing the tip calibration. Therefore, tilt
the Measurement Tool in both room directions, not only in one direction (i.e. left and right,
as well as back and forth). When rotating around one axis only, a tip position cannot be
defined.
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13.12 Active Targets

	 Operation near plasma screen

A plasma screen is a very strong IR source which overdrives the IR receiver in the active
target (e.g. active Flystick3 (discontinued), Fingertracking ). Thus, active targets may
not work properly near plasma screens. If possible use passive targets as alternative.

13.13 ART tracking and 3D TVs

	 Synchronization

3D TVs are primarily consumer products which have not been designed to fulfill the re-
quirements of professional users. In fact, this especially applies when it comes to synchro-
nizing the 3D TV and the tracking system. Typically, there’s no defined synchronization
output which could be used easily. In some rare cases, ART might be able to assist.

	 Shutter glasses

IR synchronized shutter glasses might not work with ART tracking systems. Due to the
increasing variety, ART only validated a few of these shutter glasses. However, we may
support customers who are performing tests with shutter glasses that have not been vali-
dated yet.
Please contact ART to receive information on this issue.

13.14 Radio transceivers used in ART products

	 Can ART radio transceivers pose any security issue ?

Radio transceivers for Flystick2/2+/3 , Measurement Tool or Fingertracking2 Tactile use
a protocol based on IEEE 802.15.4 which was developed in-house at ART specifically
for these devices. The protocol is proprietary, no other devices should work with this
protocol. The design of all controllers by ART ensures that use of this protocol is limited
to transfering measurement data (like button-pressed events) and configuring devices.
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A Technical specifications

Z The specifications are subject to change without notice.

A.1 Overall system

System parameters

number of cameras 2 - 80 (max. 16 for TRACKPACK/E and TRACKPACK systems)
max. number of targets 70
max. number of hands 4
max. number of Flysticks

- Flystick2 5
- Flystick2+ 5
- Flystick3 2

Scalability ARTTRACK system: fully scalable (2 - 80 cameras)
TRACKPACK/E system: cascadable up to 16 cameras (addi-
tional controller necessary)
TRACKPACK systems (discontinued): cascadable as slave(s)
only

Accuracy
- of the timestamp with a Synccard2/3: ∆terr ∼ ±0.01ms

with a SynccardTP: ∆terr ∼ ±0.5ms
with a SMARTTRACK3 & SMARTTRACK3/M : ∆terr ∼
±0.01ms
with a SMARTTRACK2 : ∆terr ∼ ±0.5ms
with a 3-Space wired inertial sensor: ∆terr ∼ ±0.1ms

Compatible shutter glasses

NuVision APG6000 ×
NuVision APG6100 ×
NVidia 3D Vision Pro ×, radio synchronization
RealD CE1 ×
RealD CE2 ×
RealD CE3 ×
RealD CE4 -
RealD CE5 ×
Volfoni EDGE ×, with Volfoni or NuVision Long-Range Emitter
XPand X103 ×, with NuVision Long-Range Emitter
XPand X101 ×
XPand X104LX ×
Virtalis ActiveWorks 500 ×

DTRACK3 frontend software

System requirements
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- Free disk space ≥ 200MB
- Processor Intel: ≥ P4 2GHz

AMD: ≥ K6 1.6Ghz
- RAM ≥ 1GB

Operating systems Windows 7 64 Bit with Service Pack 1
Windows 8/8.1 64 Bit
Windows 10 64 Bit
Windows 11 64 Bit
Linux 64 Bit with at least Qt5 5.9.2 available, e.g.:
Linux openSUSE Leap ≥ 15.0 64 Bit
Linux Ubuntu ≥ 18.04 64 Bit
Linux CentOS ≥ 7.5 64 Bit
Linux Debian ≥ 10.0 64 Bit

Used IP ports in Controller

Controller DTRACK3 fron-
tend

purpose

TCP 50105 ↔ TCP dynamic general communication
UDP 50105 ↔ UDP dynamic general communication
UDP 50107 → UDP dynamic measurement data (6DOF, timestamps, etc.)

Controller user’s application
(e.g. DTrackSDK)

purpose

TCP 50105 ↔ TCP variable remote commands (optional)
UDP 50107 → UDP user-defined

(default: 5000)
measurement data (6DOF, timestamps, etc.)

UDP 50110 ← UDP variable control commands (optional; for Fingertracking2 Tac-
tile or Flystick feedback devices)

‘dynamic’ port defined by the OS; can be among all local ports within the accessible range
of the OS (i.e. from the pool of ‘registered ports’ in Microsoft WINDOWS)

‘variable’ port arbitrary, by design of the user’s application
‘user-defined’ port defined from within the frontend (Menu Tracking → Output)
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